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Chapter 1: Introduction

The Fleet Operations Workspace Core (FLOW Core) is OMRON's solution for setting up, integ-
rating and managing an autonomous mobile robot (AMR) fleet within a factory environment.
FLOW Core provides the software tools to connect the autonomous mobile robot (AMR) fleet,
the factory's manufacturing control solution, establish maps, define operational rules, and
ensure safe, consistent operation on the factory floor.

This user's guide covers the basic procedures for installing and using the FLOW Core software
to set up and manage your AMR fleet. Some advanced operating procedures are discussed in
later chapters of the guide.

The following topics provide an introduction to the Fleet Operations Workspace Core.

1.1 Fleet Operations Workspace Core Overview
The Fleet Operations Workspace (FLOW) Core is a suite of mobile-robotics software applic-
ations for programming and operating a fleet of AMRs within a factory environment.

The FLOW Core software fully integrates OMRON’s AMRs and fleet management appliances
(EM2100) to provide complete AMR fleet solutions. It incorporates specific tools to simplify
integration with factory equipment and material-movement solutions (MES and ERP Solutions
- refer to Related Manuals on page 19).

NOTE: While this manual focuses primarily on fleet applications, the tools, cap-
abilities, and techniques explained here can be used by customers deploying
single AMRs as well.

FLOW Core software releases are coordinated to update both the AMR platforms and the fleet
management systems for optimal performance with every new release.

FLOW Core software is installed at the OMRON factory on every AMR that OMRON pro-
duces. These AMRs can operate on their own, but are most effectively used in fleets. To sup-
port fleet operations, an additional Fleet Manager appliance is necessary.

OMRON provides two Fleet Manager configurations based on its standard EM2100 appliance,
providing customers the option to purchase a Secondary unit as a backup, if desired. See Con-
figure Paired Appliances on page 30 for setting up paired Fleet Managers.

NOTE: The EM2100 is also the platform on which the Fleet Simulator runs.
Refer to the Fleet Simulator User's Manual (Cat. No. I649) for information on the
Fleet Simulator.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 12
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1.2  How the Fleet Operations Workspace Components Work Together

Table 1-1. OMRON Fleet Managers

Appearance Product Type Product Name Model

EM2100
Platform

Primary
Fleet Manager

20271-900

EM2100
Platform

Secondary
Fleet Manager

20271-901

EM2100
Platform

Fleet Simulator 20271-903

1.2 How the Fleet Operations Workspace Components Work Together
The figure below is a basic system architecture (for a fleet of AMRs) and illustrates the inter-
relationship between Fleet Operations Workspace Core’s various applications.

ARAMCentral

SetNetGo OS

SetNetGo OS

ARAM

MARC

MobilePlanner

EM2100

Core

Figure 1-1. Components Working Together (LD-60 AMR Shown)

EM2100

The EM2100 is a network appliance, with built-in processor. It can be used to run the
FLOW Core fleet management software or the Fleet Simulator software. As a Fleet Manager, the
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EM2100 coordinates the movement of up to 100 AMRs. It manages maps, AMR con-
figurations, traffic control, and job queuing. FLOW Core licenses are activated on the Fleet Man-
ager.

Version Information: Fleet Simulator support was added in FLOW Core version
1.1.

MobilePlanner
MobilePlanner is the graphical user interface (GUI) for communicating with and configuring
the AMR, and displaying and editing AMR map files. It is the "control center" of the Fleet Oper-
ations Workspace Core. Its user interface has the tools for all major AMR activities, such as
observing a fleet of AMRs, commanding individual AMRs to drive, creating and editing map
files, goals, and tasks, modifying AMR configurations, and more.

The AMRs use map files to determine where they are, plan navigable paths to goals, execute
tasks at programmed goals, and to control other AMR tasks.

Figure 1-2. MobilePlanner Interface

From the MobilePlanner interface, you can:

l Connect to and drive the AMR.

l Create maps of the environment by importing and analyzing an AMR’s scan data.

l Edit maps by adding goals (and adding tasks to those goals), docks, forbidden areas,
and more. You can also erase stray or unwanted artifacts, combine pieces of maps, and
make other changes.

l Download and upload files, including maps and scan data, to and from an AMR.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 14
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1.2  How the Fleet Operations Workspace Components Work Together

l With the Fleet Manager, monitor the location and status of all AMRs in a fleet.

l View and interact with the job queuing manager.

l Manage the configuration parameters for the Fleet Manager, AMR groups, and indi-
vidual AMRs.

For details, see MobilePlanner Interface on page 53.

MobilePlanner Accounts

User accounts with limited privileges provide the user with access to a limited set of tools for
monitoring AMR and AMR job status, and allow for simple interventions in job execution
sequences. For more information, refer to MobilePlanner Operator Account Overview on page
57.

SetNetGo
SetNetGo is the operating system that resides on AMRs and the EM2100 appliance. You can
use the SetNetGo software to establish and configure your AMR's communication parameters,
access diagnostic information (for example, download debug info file for service provider use,
manage restore points, etc.), and perform software maintenance (upgrades). You most com-
monly access the SetNetGo interface through a tab in the MobilePlanner software, and then
use that interface to enable the parameters needed.

Figure 1-3. SetNetGo Interface

For details, refer to Overview of the SetNetGo OS on page 126.

NOTE: Optionally, you can connect to SetNetGo through a web browser. Refer
to Connecting to SetNetGo via web browser on page 127.
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ARAMCentral

As the fleet management software running on the EM2100 appliance, Advanced Robotics Auto-
mation Management (ARAMCentral) provides:

l Centralized configuration and map management.

l Job queuing and dispatch.

l Traffic management.

l Single-point of integration and communication for software clients and other auto-
mation equipment.

ARAM
The Advanced Robotics Automation Management (ARAM) software runs on the AMR's core,
and does the following:

l Performs all the high-level, autonomous robotics functions, including obstacle avoid-
ance, path planning, localization, and navigation, culminating in the AMR’s motion.

l Manages wired and wireless Ethernet communications with off-board software, for
external monitoring, development, and systems coordination, including coordination of
a fleet of AMRs through the Fleet Manager.

l Enables external monitoring and control with the MobilePlanner application.

MARC/Polo

Mobile Autonomous Robot Controller (MARC), which resides on the LD-series AMR core, man-
ages the AMR’s speed and heading, sensor readings, emergency stop systems, bumpers, and
pendant. It also computes and reports the AMR’s odometry readings (X, Y, and heading) and
other low-level operations which it reports to ARAM.

Polo performs the same functions for the HD-1500 AMRs.

1.3 Fleet Operations Workspace Licensing
There are licensing options for both FLOW Core and advanced features. These licenses help
customers manage the costs of their AMR fleets through lower, annual subscription payments
for FLOW Core and activation of advanced features only if they provide benefits to your spe-
cific applications. The licenses currently available are listed in the following table.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 16
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1.3  Fleet Operations Workspace Licensing

Table 1-2. Available Fleet Operations Workspace Licenses

Product Product Description Model

Primary Fleet
Operations
Workspace
(FLOW) Core
License

Entitlement for a 1 year renewable Primary FLOW
Core license, runtime and development, per AMR
connection.

20271-800

Entitlement for a 5 year renewable Primary FLOW
Core license, runtime and development, per AMR
connection.

20271-806

Secondary Fleet
Operations
Workspace
(FLOW) Core
License

Entitlement for a 1 year renewable Secondary
FLOW Core license per fleet, redundant runtime.

20271-802

Entitlement for a 5 year renewable Secondary
FLOW Core license per fleet, redundant runtime.

20271-807

Primary Fleet
Manager (Tem-
porary)

EM2100 appliance with Temporary 120 Day Fleet
Operations Workspace license.

20271-900

Secondary Fleet
Manager (Tem-
porary)

EM2100 appliance with Temporary 120 Day Fleet
Operations Workspace license.

20271-901

Bundle, Fleet
Simulator

EM2100 appliance with entitlement for perpetual
Fleet Simulator license.

20271-903

License, Fleet
Simulator

Entitlement for perpetual Fleet Simulator license
for use with existing EM2100 appliance, sim-
ulation runtime and development.

20271-804

Fleet Oper-
ations Work-
space iQ, 1 Year
License

Entitlement for a 1 year renewable FLOW iQ
license.

20271-701

Fleet Oper-
ations Work-
space iQ, 5 Year
License

Entitlement for a 5 year renewable FLOW iQ
license.

20271-705

To obtain the latest version of the Fleet Operations Workspace (FLOW) Core software, contact
your local OMRON representative. An active subscription is required for access to software
upgrades.

Additional Information:
l After four consecutive 1 year renewals (for a total of 5 years) or after pur-
chase of a 5 year license, all fleet management functions will continue to
operate without requiring subsequent subscription renewals. An active
subscription will still be required to have access to subsequent software
releases, including bug fixes, feature upgrades and performance improve-
ments.

l Expiration of a 1 year subscription license without renewal will result in
cessation of the fleet management functions of the OMRON AMR solution
until the license is renewed.
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1.4 How Can I Get Help?
For details on getting assistance with your OMRON software or hardware, you can access the
corporate website:

http://www.ia.omron.com.

If you need help beyond what is covered in the manual, contact your local
OMRON representative.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 18
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1.4  How Can I Get Help?

Related Manuals

Manual Description

Mobile Robot LD Safety Guide (Cat. No.
I616)

Describes safety information for OMRON LD-
series AMRs.

Mobile Robot HD Safety Guide (Cat. No.
I647)

Describes safety information for OMRON HD-
1500 AMRs.

LD Platform OEM User's Guide (Cat. No.
I611)

Describes the installation, start-up, operation,
andmaintenance of the LD-60 and LD-90
AMRs.

LD-250 Platform User's Guide (Cat. No.
I642)

Describes the installation, start-up, operation,
andmaintenance of the LD-250 AMR.

HD-1500 Platform User's Manual (Cat.
No. I645)

Describes the installation, start-up, operation,
andmaintenance of the HD-1500 AMR

LD Platform Peripherals Guide (Cat. No.
I613)

Covers peripherals for LD AMRs, such as the
Touchscreen, Call/Door box, and Acuity Local-
ization options.

EM2100 Installation Guide (Cat. No.
I634)

Describes the installation and initial con-
figuration of an EM2100 appliance.

Fleet Operations Workspace Migration
Guide (Cat. No. I636)

Describes the procedures for migrating your
AMR from legacy to FLOW Core software, and
from an EM1100 to an EM2100.

Fleet Operations Workspace Core Integ-
ration Toolkit User's Guide (Cat. No.
I637)

Describes specific tools to simplify integration
with factory equipment andmaterial-move-
ment solutions such as manufacturing exe-
cution systems (MES) and equipment
resource planning (ERP) solutions.

Fleet Simulator User's Manual (Cat. No.
I649)

Describes the operation of the Fleet Sim-
ulator.

Advanced Robotics Command Language
Enterprise Manager Integration Guide
(Cat. No. I618)

Describes the Advanced Robotics Command
Language (ARCL) version for use with the
EM2100 software. ARCL is a simple text-based
command and response server used for integ-
rating the Fleet Operations Workspace Core
platform with an external automation system.

Fleet Operation Workspace Core Integ-
ration Toolkit User's Guide (Cat. No.
I637)

Contains information that is necessary to use
the Integration Toolkit facilitating integration
between the Fleet Manager and the end user's
client application.
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2.1 Safety and Regulatory
OMRON LD AMRs adhere to the following domestic and international safety regulations:

l EN 1525 “Safety of Industrial Trucks. Driverless Trucks and their Systems”

l ANSI 56.5:2012 “Safety Standard for Driverless, Automatic Guided Industrial Vehicles
and Automated Functions of Manned Industrial Vehicles”

l JIS D 6802:1997 “Automated Guided Vehicle Systems - General Rules on the Safety”

OMRON's HD-1500 AMRs are evaluated to the following standards:

l EN ISO 10218-1

l UL 1740

l EN 60204-1

l EN ISO 13849-1

2.2 Warnings, Cautions, and Notes
Where needed, this manual calls out critical, important, or emphasized text via special alert
notifications. Below are explanations of the special alert notifications used in this manual:

!
WARNING: This indicates a potentially hazardous situation which, if not
avoided, will result in minor or moderate injury, or serious injury or death.
Additionally, there may be significant property damage.

!
CAUTION: This indicates a situation which, if not avoided, could result in
minor or moderate injury or in property damage.

IMPORTANT: Important indicates information that the reader needs to know to
use the system correctly.

NOTE: Notes provide supplementary information, emphasize a point or pro-
cedure, or give a tip for easier operation.

Version Information: This indicates information that only applies to certain ver-
sions of software or hardware.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 20
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2.3  General Safety Precautions

2.3 General Safety Precautions
Read the installation and operation instructions, as well as the appropriate robot user's guide
and robot safety guide before using the equipment.

l Do not ride on the AMR.

l Do not exceed the AMR’s maximum weight limit.

l Limit operation to areas with no slope.

l Do not drop the AMR, run it off a ledge, or otherwise operate it in an irresponsible man-
ner.

l Do not get the AMR wet, or expose the AMR to rain or moisture. The AMR has an IP
rating of IP20.

l Do not use power extension cords with the docking station unless properly rated.

l Do not run the AMR if hair, yarn, string, or any other items are wound around the
AMR’s axles or wheels.

l Never access the AMR’s interior with the charger attached. Immediately disconnect the
battery after opening the battery compartment door.

l Never short the battery’s terminals together.

l Do not use parts (including charging docks, etc.) not authorized by OMRON

2.4 Safety Commissioning
Safety standards require testing of the AMR's safety systems by a trained and qualified person,
both before leaving the factory and again at the customer's site.

Safety commissioning is executed from the MobilePlanner main menu. Access and execute the
safety commissioning procedure from MobilePlanner by selecting Robot > Safety Com-
missioning.

The safety commissioning procedure is guided by on-screen prompts. The instructions that
you see will be based on the type of robot that you have connected. The procedures will test
each E-Stop and Safety Laser on the AMR, as well as the E-Stop on the pendant. Details for
running these procedures are given in each AMR user manual.

2.5 What to Do in an Emergency
Press the E-Stop button (a red push-button on a yellow background/field) and then follow the
internal procedures of your company or organization for an emergency situation. If a fire
occurs, use either a type ABC or BC dry chemical extinguisher.

2.6 Additional Safety Information
We provide more safety information in the following manuals:
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Mobile Robot LD Safety Guide (Cat. No. I616) and Mobile Robot
HD Safety Guide (Cat. No. I647)

TheMobile Robot LD Safety Guide (Cat. No. I616) and Mobile Robot HD Safety Guide (Cat. No.
I647) provide detailed information on safety for our AMRs. They also give resources for more
information on relevant standards. A safety guide ships with each AMR.
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Chapter 3: Fleet Manager Configuration and
Operation

The Fleet Manager capabilities within FLOW Core provide tools for programming and con-
figuring individual AMRs and fleets, and for centralized job dispatch and real-time AMR mon-
itoring within your facility.

3.1 EM2100 Configuration Overview
This section provides instructions for setting up and connecting the AMRs and Fleet Manager
to a network.

OMRON's EM2100 appliance provides the operating environment for the FLOW Core soft-
ware. It will be the primary interface device to the network and any PC(s) running MobilePlan-
ner. The EM2100 appliance comes pre-loaded with temporary, 120 day, FLOW Core and Flow
iQ licenses, which allow initial set-up, testing, and validation to begin immediately, without a
full subscription. FLOW Core and FLOW iQ licenses must be purchased after the 120 day set-
up period.

NOTE: The EM2100 can also run in the Fleet Simulator operating mode, with a
Fleet Simulator license. Refer to the Fleet Simulator User's Manual (Cat. No. I649).

Configuration Tasks Overview

NOTE: This section assumes that you have read and followed the instructions
in the EM2100 Installation Guide (Cat. No. I634).

To configure the EM2100 appliance as a Fleet Manager, you must do the following tasks,
which are described in detail later in this guide:

l Configure the network settings for the appliance Management Ethernet port.

l Configure the network settings for the FLEET ETH2 Ethernet port.

l Connect the Management and Fleet ports to the LAN.

l Define the login information.

l Configure each AMR to connect to the EM2100.

l Customize each AMR, if desired.

If you install a Secondary EM2100 appliance and configure Autosync, you must also:

l Install the same FLOW Core software version on the Secondary as is on the Primary
appliance.

l Configure a unique IP address for the Management port.

l Connect the Management port to the LAN.
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3.2  Power Interruptions

l Connect the FLEET ETH2 port to the LAN.

l Enter the Secondary Management IP address on the Primary appliance.

l Generate and download a key from the Primary appliance.

l Set the Secondary appliance Autosync role to Secondary.

l Upload the key to the Secondary appliance.

l Verify that the status of both appliances is active.

l Create a direct network connection between the Primary and Secondary appliances.

3.2 Power Interruptions
Use the front momentary power switch to turn the EM2100 on and off. The rear power switch
should remain on unless you are uninstalling the appliance.

Power Interruptions on a Standalone EM2100

If there is an interruption to the power supply for any reason or duration, a standalone
EM2100 automatically returns to its previous power state.

l A standalone appliance that was shut down and powered off when the interruption
occurred remains shut down after you restore power.

l A standalone appliance that was powered on when the interruption occurred restarts
automatically after you restore power.

After recovery from a power interruption, the EM2100 saves its job queue status and recovers
the queue automatically after it restarts following a power failure. This does not apply to an
operator-initiated emergency power off.

Power Interruptions on an Autosync Appliance

This section assumes that you configured Autosync on two EM2100 appliances and connected
each appliance to separate power circuits for redundancy. Providing that only one circuit was
affected, one appliance should remain operating normally during the power interruption. The
sequence of events and method of recovery depends on which appliance is affected:

A power interruption on the Primary appliance results in a loss of connectivity with
AMRs and MobilePlanner. You should:

l Determine whether the problem is a power outage or a loss of network connectivity.

l Manually reconfigure the Secondary appliance to become the Primary Appliance. Fleet
Management functions are restored but Autosync status is now disabled.

Autosync will need to be re-configured once the power issue with the original EM2100
appliance is resolved.

l Verify that MobilePlanner and AMRs reconnect to the Fleet IP address.

l Review the job queue status in MobilePlanner and verify the status of AMRs to make
sure that no jobs are incomplete.
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l Restore power to the former Primary appliance.

l Change the former Primary appliance to a role of Secondary appliance.

A power interruption on the Secondary appliance results in no loss of connectivity
with AMRs and MobilePlanner. You should:

l Verify that MobilePlanner and AMRs are connected to the Fleet IP address.

l Review the job queue status in MobilePlanner and verify the status of AMRs to make
sure that no jobs are incomplete.

l Restore power to the Secondary appliance. Autosync will be restarted if it was running
when the power was interrupted. Fleet operations should be unaffected.

If both Autosync appliances are affected by a power interruption, they both behave as
described in: Power Interruptions on a Standalone EM2100 on page 25:

l All fleet operations are terminated during the power interruption.

l Normal Active Autosync operation resumes automatically after you restore power to
both appliances.

l The Primary EM2100 saves its job queue status and recovers the queue automatically
after it restarts. Autosync will reconnect automatically when power is restored.

3.3 Set the IP Address on a Client PC's Network Adapter
Use the Maintenance Ethernet port to connect a client PC to the SetNetGo operating system.

IMPORTANT: You must assign a static IP address. Do not use a DHCP server.

Configure the network adapter IPv4 address on the Client PC as follows:

1. Connect an Ethernet cable from the client PC’s Ethernet port to the Maintenance Eth-
ernet port on the EM2100 appliance.

2. In the command field on the Windows taskbar, enter the following command to open
the Network Connections dialog: ncpa.cpl

3. Open the network properties of the PC ethernet network adapter used to connect to the
Maintenance Ethernet port on the EM2100 appliance.

4. Double-click TCP/IPv4 to open the Internet Protocol properties dialog.

5. Enter as the IP address: 1. 2. 3. 5, or any IP address in the range 1. 2. 3. 0 to 1. 2. 3. 255,
excluding 1. 2. 3. 4. (this is reserved for the Maintenance port).

NOTE: For HD robot series the IP address is 169.254.10.15.

6. Enter as the subnet mask: 255. 255. 255. 0.

7. Click OK to close the Internet Protocol dialog, and then click OK to close the Ethernet
Adapter dialog.
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3.4  Connect Your PC to SetNetGo on the EM2100

In future, you can use the Maintenance Ethernet port for emergency access to the Appliance at
IP address 1.2.3.4. (For example, if you lose the password or if there is a network IP address
conflict.)

3.4 Connect Your PC to SetNetGo on the EM2100
SetNetGo enables you to configure and manage EM2100 and AMR settings. This section
describes how to access SetNetGo through the Maintenance port to perform initial con-
figuration.

The user interface for SetNetGo on an EM2100 provides a different set of parameters and
options compared to SetNetGo on an AMR. The upper left of the screen shows EM2100, LD,
LD-250, or HD depending on your SetNetGo context (the device on which it runs, such as the
OMRON LD-series AMRs).

Configure Access and Security

After you connect to the Maintenance Port as described in: Set the IP Address on a Client PC's
Network Adapter on page 26 you can open the SetNetGo web interface.

Connect your browser to SetNetGo and configure SetNetGo access as follows:

1. In the SetNetGo web interface, click the Security Tab and then click SetNetGo Access
and check Enabled next to the following:

Maintenance Interface is automatically enabled.

l Wireless Ethernet/User LAN Ethernet

l (Optional) Remote Reboot.

2. Change the account password (default is no password) as required and click Apply.

NOTE: Passwords are limited to a maximum of 20 alphanumeric characters.
For increased security, specify a long (10+ characters) password string with both
uppercase and lowercase letters. Include several digits.

3.5 Configure Management Interface Network Settings
To configure the Management Network, you require:

l A dedicated static IP address. (Do not use 1.2.3.4. That address is permanently assigned
to the Maintenance Ethernet port.)

l The subnet mask for the Management network.
l The IP address of the network Gateway.
l The IP address of a Domain Name Server (DNS) (this is only required if any hostnames
will be used in the Fleet Manager configuration), so that the Fleet Manager can resolve
all IP addresses.

Configure the Management Interface network connections as follows:

1. In the SetNetGo web interface, click the Network tab.

2. ClickManagement Interface and enter the:
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a. IP address.

b. Subnet mask.

c. Network Gateway IP address (typically a router).

3. Enter the IP address of your Domain Name Server (DNS), if required for devices other
than the appliance and the fleet. Otherwise, leave it as 0.0.0.0.

4. Click Apply.

A message dialog informs you of the status of the change, and whether there is any affect on
operations such as a restart or a time delay before the change takes effect.

3.6 Configure the Operating Mode
Configure the Operating Mode as follows:

1. In the SetNetGo web interface, click the System tab.

2. ClickMode.

3. Select the operating mode in which you will be using this EM2100.

The choices will be:

l Unconfigured (this is how the EM2100 ships)

l Standalone Fleet Manager

l Paired Fleet Manager

l Fleet Simulator

If a mode is grayed out, it means that you don't have the license to support that oper-
ating mode. Refer to Licensing Tab on page 138.

4. Click Apply.

You will be shown several warning pop-ups. Respond OK to all.

The EM2100 will reboot.

At this time, Status > Home > Mode of Operation should show the operating mode
that you selected.

A message dialog informs you of the status of the change, and whether there is any effect on
operations such as a restart or a time delay before the change takes effect.

Additional Information: Licensing is activated when you initially configure the
operating mode of the EM2100.

3.7 Configure the Fleet Interface Network Settings
To configure the Fleet Interface, you require:

l A dedicated static IP address to assign to the Fleet Interface port. This IP is allowed, but
not required, to be on the same subnet as the Management IP. Do not use 1.2.3.4,
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3.7  Configure the Fleet Interface Network Settings

because that address is permanently assigned to the Maintenance Ethernet port.
l The subnet mask for the network that your Fleet will use.
l The IP address of the network Gateway.

Configure the Fleet Interface network connections as follows:

1. In the SetNetGo web interface, click the Network tab.

2. Click Fleet Interface and enter the:

a. IP address.

b. Subnet mask.

c. Network Gateway IP address (typically a router).

3. Click Apply.

A message dialog informs you of the status of the change, and whether there is any affect on
operations such as a restart or a time delay before the change takes effect.
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3.8 Configure Paired Appliances
The default (when shipped) configuration for an EM2100 is Unconfigured. The configuration
will need to be set as either a Standalone or Paired Fleet Manager.

To create an Autosync pair, refer to Configure the Primary Appliance on page 31 and Con-
figure the Secondary Appliance on page 32. The paired appliances then function as follows:

l The Primary unit is a fully-functional EM2100, running the Fleet Operations Workspace
Core and actively controlling the fleet.

l The Secondary unit is powered on, with its web interface accessible to the Primary unit.
However, the fleet management functions are inactive on the Secondary unit, and it is
inaccessible from MobilePlanner or AMRs.

The Primary Fleet Manager has two active IP addresses, while the Secondary has only one act-
ive IP address.

EM2100 Autosync — Ethernet Cabling

The following figure shows the physical connection of Ethernet cables to the appliances.

Figure 3-1. Cabling for an EM2100 Fleet Manager Pair

Callout Description

1 EM2100 configured as a Primary appliance.

2 EM2100 configured as a Secondary appliance.

3 Ethernet cables to the LAN switch:

l Primary and Secondary MGMT ETH1
l Primary and Secondary FLEET ETH2

Tasks in Autosync Setup

Before you set up Autosync, make sure that you have:
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3.8  Configure Paired Appliances

l Installed the Primary appliance and connected it to the network.

l Configured the Maintenance Ethernet interface on the Primary appliance.

l Physically installed the Secondary appliance hardware, as described in the EM2100
Installation Guide.

The tasks required to set up autosync between a Primary and Secondary appliance are:

l Configure the Primary appliance with a Fleet IP Address.

l Enter the Secondary appliance IP Address in the Primary appliance.

l Generate and Download the Primary key (to your PC).

l Set the Secondary appliance Autosync role to Secondary.

l Upload the Primary key to the Secondary appliance.

Configure the Primary Appliance

Do this only if you have two Fleet Manager appliances, and you want to configure one as a
Primary Fleet Manager. You must first configure the Management and Fleet networks and
cable the appliances.

1. In the SetNetGo web interface, click the System tab, then Mode.

2. Select Paired Fleet Manager from the drop-down menu. Click Apply.

You will get a "Confirm Appliance Mode Change" pop-up message.

Figure 3-2. Confirm Appliance Mode Change Window

3. Click OK.

You will get a second pop-up with a warning that this operation will interrupt the
fleet management.

4. Click OK.

5. Click the Pairing Button that appears in the left margin of the screen.
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6. From the drop-down menu next to the Pairing Role, select Primary, and click Apply.

7. Enter the IP Address of the Secondary appliance. Click Apply.

8. You will get a message to confirm changes, saying that ARAMCentral will restart, dis-
connecting AMRs and clients. Click OK.

9. You will get a confirmation message that the changes were successfully applied. Click
OK.

10. Click Generate New Key to create an SSL key, or Download Existing Key, if you pre-
viously created an SSL key.

Uploading the SSL key to the Secondary appliance grants permission for the Primary
to perform RPC calls required for synchronization.

11. You are prompted for a location to save the key file. Enter a location (path) where you
want to save the file on your PC, so you can later upload it to the Secondary appli-
ance.

12. A warning message indicates the pending disconnection of AMRs and clients. Click
OK.

Your Primary Fleet Manager is now configured to run as part of a pair.

Configure the Secondary Appliance

Do this only if you have two Fleet Manager appliances, and you want to configure one as a
Secondary Autosync appliance. You must first:

1. In the SetNetGo web interface, click System tab, then Mode.

2. From the drop-down menu choose Paired Fleet Manager and click Apply.

3. You will get a "Confirm Appliance Mode Change" pop-up message. Click OK.

4. You will get a second pop-up with a warning message that this operation will interrupt
the fleet management. Click OK.

5. A Pairing selection will appear in the left margin of the screen. Click on Pairing.
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3.9  Configure Each AMR to Connect to the Fleet Manager

Figure 3-3. Pairing Selection, Left Bar

6. From the drop-down menu, next to the Pairing role, choose Secondary. Click Apply.

You will get a Confirm changes message that ARAMCentral will halt, disconnecting
AMRs and clients. Click OK.

7. You will get a confirmation message that the changes were successfully applied. Click
OK.

Figure 3-4. Changes Successfully Applied Window

8. Click Choose File to select the Primary SSL key from your PC to chose the proper file.

Enter the name and path of the file to upload the key from the PC.

9. Click Upload.

Your appliance is now configured as a Secondary appliance.

NOTE: Although the Fleet Interface settings are saved for the Secondary appli-
ance, the interface is inaccessible.

When the connection is complete, the Primary and Secondary appliances show a Current
Status of active.

3.9 Configure Each AMR to Connect to the Fleet Manager
Before you can use the Fleet Manager appliance to manage AMRs, you must configure each
AMR to connect to the appliance. To do so, you must connect to each AMR.

In most cases when an AMR connects to the appliance, the Fleet Operations Workspace Core
overwrites the AMR's configuration parameters with Fleet parameters.

AMR Configuration Settings

To connect an AMR to the EM2100 appliance:
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1. Launch MobilePlanner on your client PC and connect to the AMR's IP address.

If this is a new AMR, its IP address will be the factory setting of 1.2.3.4 for LD-series
AMRs, and 169.254.10.15 for the HD-1500 AMR. The connection must be hard-wired,
because the AMR's wireless won't be configured yet.

2. Open the Configuration tab.

3. Check Show Expert Parameters to show the advanced configuration parameters.

4. From MobilePlanner, Config select Fleet and then Fleet Manager Connection.

Figure 3-5. Fleet Manager Connection Screen

5. Check the ConnectToFleetManager checkbox.

6. Enter the IP address of the EM2100 appliance in the
FleetManagerAddress field.

NOTE: This is the Fleet IP address, not the Management IP address of the
EM2100.

7. Enter an identifier in the Identifier field. You must use unique identifiers for each AMR.
Do not change this identifier after initial setup.

Repeat these steps for each AMR that you want to add to the fleet controlled by this EM2100
Fleet Manager.

Fleet-Level Settings

From MobilePlanner, Config, on the Fleet Manager:
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3.10  What to do if a Primary Fleet Manager Fails

1. Select Fleet and then Fleet Features.

2. Check the FleetManagerGatherScans box.

This enables Fleet Operations Workspace Core to gather any scan files created by the
AMRs.

3. Back up (copy) any required maps to a storage location.

4. [OPTIONAL] Check DeleteUnusedMaps to permanently delete unnecessary map files
from each AMR.

3.10 What to do if a Primary Fleet Manager Fails

This section applies only if you installed a second EM2100, autosynchronized with the
Primary Fleet Manager.

In the event of a failure:

1. Connect to SetNetGo on the Secondary EM2100.

2. Navigate to the Pairing section of the System area as shown below.

Figure 3-6. Pairing Section

3. Select the Primary option from the Pairing role selection and then click the Apply Button.

Note each warning popup and select the OK Button.
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Figure 3-7. Changing the Pairing role to Primary

4. After 30 to 60 seconds, the Current Status should change to Starting. After waiting and
confirming the status change, the procedure is complete.

IMPORTANT: The failed Primary appliance should not be returned to operation
on the deployment network while the Secondary appliance is providing Fleet
Management services

The AMRs automatically reconnect to the new Primary appliance.

The queue, configuration, and map data on the new Primary is identical to that of the old
Primary, prior to failure. Depending on exact network configuration, it takes between 1-3
minutes for AMRs to reconnect and resume operation.

The original (failed) Primary appliance can now be safely removed from the rack without caus-
ing disruption to the fleet. The following considerations apply:

l The new Primary operates on the same Fleet IP as the old Primary appliance. Do not
reconnect the old Primary to the network without first reconfiguring it. Doing so might
cause a network IP conflict.

l The failed Primary has the queue file, which is no longer current. Before putting the
failed Primary back into service, you should manually clear the queue. See Manually
Clearing (Flushing) the Entire Queue on page 225.

3.11 Remove and Replace EM2100 Appliances from Autosync
This section describes how to remove an appliance from an Autosync configuration.

Remove a Primary Fleet Manager Appliance from Autosync

You might need to remove a Primary Fleet Manager appliance from an Autosync con-
figuration while maintaining fleet operations. For example, if the Primary appliance is gen-
erating errors that indicate a potential failure or degraded performance. This procedure
assumes that you do not make any changes to the software and data stored on the removed
appliance.
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3.11  Remove and Replace EM2100 Appliances from Autosync

To safely remove an EM2100 Primary Fleet Manager appliance from an Autosync con-
figuration, you must promote the Secondary appliance to the Primary role as covered in the
previous section. You can then safely remove the Primary as follows:

1. Verify that fleet operations are normal and job processing is on schedule.

2. Reconfigure the Primary appliance as a Secondary appliance. See: Configure the Sec-
ondary Appliance on page 32.
MobilePlanner and fleet AMRs might lose their network connection to the appliance.

3. Reconfigure the Secondary appliance as the Primary appliance. See: EM2100 Con-
figuration Overview on page 24.

4. Power off the Secondary appliance.

5. The Status tab in SetNetGo will now show that Autosync for the new Primary appliance
is disabled (it is now a standalone appliance).

6. Verify that MobilePlanner can connect to the Fleet IP, that fleet AMR operations resume,
and jobs are processed as scheduled.

To restore a removed EM2100 appliance or to replace it with a new appliance, it should be put
into the role of Secondary Fleet Manager, not Master. This will cause less disruption to the
fleet.

Remove a Secondary Fleet Manager from Autosync

You might need to remove a Secondary Fleet Manager appliance from an Autosync con-
figuration while maintaining fleet operations. For example, if the Secondary Fleet Manager
appliance is generating errors that indicate a potential failure or degraded performance. This
operation is less disruptive than removing a Primary Fleet Manager.

IMPORTANT: This procedure assumes that you do not make any changes to
the Fleet Manager configuration or to the software and data stored on the appli-
ance.

To remove a Secondary Fleet Manager appliance from an Autosync configuration:

1. Verify that fleet operations are normal and job processing is on schedule.

2. Power off the Secondary Fleet Manager appliance.

If a soft shutdown doesn't work, use a hard shutdown. Refer to the EM2100 Installation
Guide for details on hard- vs. soft-shutdowns.

3. Verify that MobilePlanner can connect to the Fleet IP, that fleet AMR operations con-
tinue, and that jobs are processed as scheduled.

To restore a removed Secondary Fleet Manager appliance:

1. Verify that fleet operations are normal and job processing is on schedule.

2. If you have removed any network cables, reinstall them. Configure Paired Appliances

3. Power on the Secondary Fleet Manager appliance. (This should not affect fleet oper-
ations or Ethernet connections to MobilePlanner and AMRs.)
Both appliances now indicate that Autosync is Active.
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If no changes have been made to the configuration, the Secondary appliance will come
back up as a Secondary, but the Primary will be running as a Standalone.

4. Reconfigure the Primary appliance to be paired with the Secondary. See Configure the
Primary Appliance on page 31.
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Chapter 4: Fleet Operations Workspace Core
Software

The Fleet Operations Workspace Core (FLOW Core) software has the tools and features to help
you get your AMR up and running quickly. This chapter covers the initial steps needed to
access your AMR with the PC and to begin using the Fleet Operations Workspace Core soft-
ware.

4.1 How Do I Begin?
Before you can start using your AMR, there are a number of initial set-up and configuration
steps you need to complete.

NOTE: It is assumed that, prior to beginning fleet programming with FLOW
Core, all AMRs and EM2100 appliances being used in the fleet have been
unpacked, installed and set-up according to their respective user guides.
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4.2  End User License Agreement (EULA)

Procedure Reference

Install the MobilePlanner software on your PC. Install the MobilePlanner Software on
page 43

Connect your PC to the AMR via Ethernet cable. Connect Your PC to the AMR via Ethernet
on page 45

Configure the AMR for wireless communication. Configure Your AMR's Network and Secur-
ity Settings on page 49

Establish a wireless connection to the AMR. Connect to the AMRWirelessly on page
50

Scan the AMR's environment. Scanning the Operating Area on page 96

Convert the scan to a map. Convert the Scan into a Map on page 97

Use MobilePlanner software to edit (erase stray
and other dynamic features from) the map.

Editing a Map File on page 102

Add docks, forbidden zones, goals, and route(s)
between goals, etc. to the map.

Working with Map Files on page 99

Save the editedmap on the AMR. Saving the Map on the AMR on page 118

Localize the AMR. Set the AMR's Initial Location on page
121

Create some tasks, and have the AMR
begin performing them.

AMR Tasks on page 172

Click the EULA to complete the process.

4.2 End User License Agreement (EULA)
Users will be presented with and must agree to the End User License Agreement (EULA) in
order to access and use any of the FLOW Core software content and functionality.

Definitions

l An End User is the person, company, or organization that actually uses the software
and OMRON Mobile Robotics equipment.

l System Integrators are not End Users when they are installing OMRON Mobile Robot-
ics solutions for another business.

l System Integrators are End Users when they own and install OMRON Mobile Robotics
solutions for their own use (e.g. for test or demonstration fleets).
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The Click-to-Accept (CTA) EULA will pop up:

l When the FLOW Core software is installed.

l Whenever the FLOW Core software is updated.

l Upon first launching SetNetGo software (Out Of the Box).

l Whenever the SetNetGo software is updated.

l Whenever a V2C (license) file is uploaded (first time, updates, and renewals).

New entitlements are not required when existing dongles are transferred from a failed
EM2100 or AMR to new EM2100 or AMR hardware. Therefore, no EULA is required in
these cases.

l Whenever a new user-facing language is selected (in order to ensure delivery of the CTA
EULA in the appropriate language).

Once the CTA EULA Prompt is Triggered

1. The CTA EULA pop-up will display in the language that matches the software
installed.

2. The User must scroll through the entire End User License Agreement before the Accept
Button is enabled (this button is grayed-out until then).

3. The User must check either "End User" or "Manufacturer or System Integrator" before
the Accept Button is enabled.

Accepting as "End User" will stop the CTA from re-triggering upon launching the soft-
ware. All other triggers will still prompt the user with the CTA pop-up.

Accepting as "Manufacturer or System Integrator" will not stop the CTA from re-trig-
gering upon launching the software. This is to ensure that the End User gets prompted
when first launching the software "out of the box".

4. The User can either click Accept, or abort the process.

Aborting the CTA EULA process will cancel and close out of the process that triggered
the CTA EULA pop-up (V2C Upload, Language Change, Software Update, Software
Install, First-Time/Out Of the Box Software Start Up).

In this case, the User can re-trigger the CTA EULA prompt by initiating one of the trig-
ger processes listed above.

5. If the software license is activated at the factory, in the Fleet Simulator bundle for
example, the CTA EULA pop-up will be displayed and a selection must be made prior
to the Simulator performing its intended functions.

The intent here is that the Fleet Simulator should be able to connect to SetNetGo and
MobilePlanner but no configuration or simulations can be run until the user clicks the
Accept Button.
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4.3  Install the MobilePlanner Software

Capturing CTA Interactions

1. Every time the CTA EULA process is initiated and completed, the following data shall
be captured and logged:

l What triggered the CTA EULA prompt (e.g "Software Update", "V2C Upload",
etc.)

l Date/Time CTA EULA process was triggered

l Date/Time CTA EULA process was completed

l Whether CTA EULA was Accepted, or the process was aborted (either of these
will be considered as completed.

2. Users can access a reference log file, but will not have access to or the ability to make
changes to the source data populating these logs.

NOTE: The Click-to-Accept EULA functions only apply to the FLOW Core soft-
ware. There is no impact on the Legacy MSS 4.X software.

4.3 Install the MobilePlanner Software
Before setting up a wireless connection to your AMR, you will need to install MobilePlanner
on your PC. This software is the primary interface to the Fleet Manager and AMRs, and allows
programming of the AMR fleet.

System Requirements

Verify that your PC meets the following requirements before installing MobilePlanner:

l OS: Windows 7 (32-bit/64-bit), Windows 8 (32-bit/64-bit),or Windows 10 (32-bit/64-bit).
l CPU: 1.5 GHz Dual-core (min).
l RAM: 1.5 GB minimum, 4 GB recommended.
l GPU: 256 MB (min).
l HDD/SSD: At least 250 MB available space.
l Monitor: XGA 1024 x 768.

Installing MobilePlanner

Ensure that your PC meets the system requirements, then install (or download and install)
MobilePlanner.

NOTE: The MobilePlanner software installs into a MobilePlanner6 directory.
This different install directory allows you to use the relevant MobilePlanner ver-
sion with your fleet.

Version Information: Only MobilePlanner software version 6 is compatible with
FLOW Core 2.1 or higher. It is not compatible with OMRON fleets running on
Mobile Software Suite version 4.X or earlier.
Refer to https://automation.omron.com for release notes or contact your local
OMRON representative for more information.
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1. Use one of the following methods to locate and/or install the MobilePlanner software:

a. By USB drive: insert the software media (USB drive, includes your AMR’s soft-
ware and documentation) into your PC, and browse to the USB drive to locate
and install the software.

b.

From your EM2100: Open SetNetGo > Software > Manage Installed Software
> MobilePlanner > It can be downloaded here. (Click on the "here" link in the
EM2100 user interface, shown near the bottom of the following figure.)

Figure 4-1. Manage Software Download

c. By download: Contact your local OMRON representative for assistance with
downloading MobilePlanner software.

To download MobilePlanner from the internet, access www.robotics.omron.com
or contact your local OMRON representative.

2. Launch the installer and, when the welcome screen appears, follow the prompts in each
installation wizard window to complete the installation.

If you used SetNetGo or downloaded the software, this will usually be in your Down-
loads folder. The actual location is determined by the settings in the browser that you
use.

3. Click Finish when done.

4.4 Configure the AMR’s Wireless Communications
Before you can start working with your AMR, you have to configure it for wireless com-
munication (via WiFi) using your PC. To do this, you will first have to connect your PC to the
AMR via Ethernet cable to gain access to the AMR's wireless settings. In general, the set-up
process is as follows:

l Connect Your PC to the AMR via Ethernet
l Set the IP Address on Your PC
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4.4  Configure the AMR’s Wireless Communications

l Access SetNetGo Software
l Configure Your AMR’s Network and Security Settings
l Connect to the AMR Wirelessly

NOTE: The setup steps above assume that the AMR is fully-charged, powered
up, and ready. If this is not the case, please refer to your AMR’s user manual for
complete setup instructions.

Connect Your PC to the AMR via Ethernet

To connect your PC to the AMR:

1. Open the AMR's maintenance access panel (left side, upper right corner), by pressing
the access panel’s upper left corner (see image below) into the side of the AMR.

Figure 4-2. Maintenance Door Location

2. Using a standard (pass-through or cross-over) Ethernet cable, connect your PC directly
to the AMR's maintenance Ethernet port. Refer to the following three figures. The AMR
will auto-detect the cable type.

Figure 4-3. Maintenance Port Connection, LD-60 and LD-90
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Figure 4-4. Maintenance Port Connection, LD-250

Pendant

Figure 4-5. Maintenance Port Connection, HD-1500

Set the IP Address on Your PC

In order to configure WiFi on your AMRs, the LD-series AMRs and the HD-1500 AMRs are
accessed differently. If you have a combination of the two, we suggest that you set up all of the
LD-series AMRs and all of the HD-1500 AMRs as two separate procedures.

LD-Series AMR IP Address Setup

. The LD-series AMR's maintenance Ethernet port is always enabled and permanently set to IP
address 1.2.3.4, with a Subnet mask of 255.255.255.0, for direct, wired access to the on-board
systems. Refer to the following procedure for setting up your connection to the LD-series AMR.

1. Open the Local Area Connection settings on your PC.
2. Manually set your PC's Ethernet port IP address to 1.2.3.x, where x is any number 1 to
254, except 4 (which the AMR uses).

3. Set the Subnet mask to 255.255.255.0. No special DNS or gateway settings are needed.

4. Click the OK Button to confirm the configuration and complete this procedure. The
AMR can be accessed for configuration.
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4.4  Configure the AMR’s Wireless Communications

HD-1500 AMR IP Address Setup

The HD-series AMR's maintenance Ethernet port is always enabled and permanently set to IP
address 169.254.10.15, with a Subnet mask of 255.255.255.0, for direct, wired access to the on-
board systems. Refer to the following procedure for setting up your connection to the HD
AMR.

1. Open the Local Area Connection settings on your PC.
2. Manually set your PC's Ethernet port IP address to 169.254.10.x, where x is any number
100 to 149.

3. Set the Subnet mask to 255.255.255.0. No special DNS or gateway settings are needed.

4. Click the OK Button to confirm the configuration and complete this procedure. The
AMR can be accessed for configuration.

Access SetNetGo Software

The SetNetGo software lets you manage a variety of settings related to the AMR's connectivity.
You can access SetNetGo from MobilePlanner (most common), or a secure web browser (for
example, Chrome, Firefox, or Internet Explorer).

To Access SetNetGo from MobilePlanner

NOTE: Only start the following procedures if your computer is connected to the
AMR via Ethernet cable.

1. Open the MobilePlanner software.

2. For an LD-series AMR, enter 1.2.3.4 into the AMR address field, then click Connect.

For an HD-1500 AMR, enter 169.254.10.15 into the AMR address field, then click Con-
nect.

3. Click the SetNetGo Button.

Click the checkbox only if you want SetNetGo to open when you connect to an AMR or
Fleet Manager. Otherwise, click anywhere in the rectangle shown in the following fig-
ure.

4. Click the SetNetGo tab.

To Access SetNetGo via Web Browser

1. Start a web browser on your computer.

2. Enter the URL https://1.2.3.4 in the address bar of the web browser.

For an HD-1500 AMR, enter 169.254.10.15 in the address bar of the web browser.

This is the AMR’s maintenance Ethernet address. When accessing the software from a
wired maintenance Ethernet port, you do not need a username or password.
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Figure 4-6. Browser Address Field

NOTE: You can ignore the certificate error that appears on the SetNetGo web-
page; the error appears because the hardware is not attached to the Internet.

The SetNetGo startup screen is shown the following figure.

Figure 4-7. SetNetGo Interface
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Configure Your AMR's Network and Security Settings

To access your AMR remotely, you should set up a static IP address for each AMR. The
SetNetGo interface allows you to configure your hardware’s Ethernet settings, configure serial
and TCP forwarding, and upgrade the on-board software. If you are not familiar with setting
up a network or do not have an assigned IP address for the AMR, please see your system
administrator.

IMPORTANT: If you change any values in a SetNetGo screen, you must click
Apply before switching to another sub-screen, or those values will not be saved.
For example, when changing wireless Ethernet settings, be sure to click Apply
before navigating back to the dashboard.

To configure network settings, click the Network tab at the top of the SetNetGo screen.

Figure 4-8. SetNetGo Interface

Table 4-1. Network Options

Network
Menu Description

Wireless
Ethernet

Sets up your wireless Ethernet connection to your AMR, including
IP settings, WiFi network settings, security settings, and radio set-
tings.

User LAN
Ethernet

This screen has user-configurable settings for interface mode, IP
address, netmask, DHCP server for accessories, and DHCP IP range.

RS-232 Port
Forwarding

Controls forwarding of serial data to a TCP port on the wireless and
internal wired Ethernet networks, where the data is re-directed to a
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Network
Menu Description

TCP port on an IP address accessible via the Wired Ethernet interface
(which must be set to accessory mode). There is also port-forwarding
for the two extra on-board serial ports to a TCP port on the wireless Eth-
ernet interface.

Ethernet
Forwarding

Use the settings on this screen to control TCP port forwarding from
your User LAN Ethernet interface to the wireless Ethernet interface.

Utilities Use this screen to ping an IP address for testing and diagnostic pur-
poses.

Set the Username and Password to Secure Access to the AMR

You must add one or more users, and assign usernames and passwords. Click the Security
tab, then click the Enabled radio button and populate the username/password fields (see Set-
ting Up User Accounts on page 147).

Connect to the AMR Wirelessly

Now that you have installed the Fleet Operations Workspace Core and configured the AMR for
wireless communications, connect to your AMR.

1. (If not already running) double-click the MobilePlanner icon on your PC desktop.

Figure 4-9. MobilePlanner Desktop Icon
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Figure 4-10. MobilePlanner Interface

NOTE: If running MobilePlanner from an Operator account, the interface
will look slightly different than above.

By default, the Fleet, Config, andMap Buttons have bars that become visible to indicate
that those features will automatically load when you connect to the AMR.

2. In the Connect field, enter the IP address of the AMR, then click Connect.

3. Enter User Name and Password in the User Name and Password dialog box, then click
OK.

NOTE: If the SetNetGo Button's bar is visible, the User Name and Pass-
word dialog appears.

A login dialog appears in which you must enter a user name, password, and AMR
server IP address.

NOTE: After connecting to the AMR the first time, MobilePlanner remem-
bers your user name. When connecting to the AMR again, you can select
your user name from a combo box instead of having to re-enter, but you
must still enter your password.

MobilePlanner completes its connection to the AMR. At this point, there is no map to load, so
MobilePlanner opens with a blank map window.
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The MobilePlanner software is the "control center" of the Fleet Operations Workspace Core. Its
user interface has the tools for all major AMR activities, such as observing a fleet of AMRs,
commanding individual AMRs to drive, creating and editing map files, goals, and tasks, modi-
fying AMR configurations, and more.

The following topics provide details on understanding and using the MobilePlanner features.

5.1 Overview of MobilePlanner
MobilePlanner has features you can use to scan the AMR environment, configure the AMR,
create and edit maps, and more. The interface is designed to be user-friendly and efficient,
which reduces the learning curve and the time needed for deployment.

The MobilePlanner interface supports the following languages:

l English l Italian
l French l Korean
l German l Simplified Chinese
l Japanese l Traditional Chinese
l Spanish l Polish

Figure 5-1. MobilePlanner User Interface (with Map)

NOTE: While MobilePlanner is not necessary for each AMR, you must have at
least one copy of MobilePlanner to create a map.

From the MobilePlanner interface, you can:
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l Connect to and drive the AMR.

l Create maps of the environment by importing and analyzing an AMR’s scan data.

l Edit maps by adding goals (and adding tasks to those goals), docks, forbidden areas,
and more. You can also erase stray or unwanted artifacts, combine pieces of maps, and
make other changes.

l Download and upload files, including maps and scan data, to and from an AMR.

l With the Fleet Manager, monitor the location and status of all AMRs in a fleet.

l View and interact with the job queuing manager.

l Manage the configuration parameters for the Fleet Manager, AMR groups, and indi-
vidual AMRs.

These features allow you to create a map with goals, docks, and advanced lines and areas,
and to start the AMR working in its environment.

5.2 MobilePlanner Interface
The MobilePlanner interface consists of the Main Menu, Toolbar, and Fleet Explorer.

The Main Menu is located across the top of the application and contains tools for handling file
management, driving the AMR, and initiating scans. The full list of options and functionality
is documented in The MobilePlanner Menu .

Below the Main Menu is the Toolbar. The Toolbar contains buttons for Undo, Redo, and Save.

On the left of the application window is the Fleet Explorer. From this interface new fleets and
robots can be connected to and managed. Robots and robot types in a fleet are visualized as a
hierarchy for clarity, and can be further organized into sub-fleets for more granular con-
figuration.

Additional interfaces can be opened using the Fleet, Map, Configuration, and SetNetGo buttons
located in the Fleet Explorer menu shown in the image below. These menus are shown as
Mode Tabs underneath the toolbar and can be rearranged and closed like tabs on a web
browser. Within a given Mode Tab, there can also be Function Tabs.

Running along the bottom of the application is a bar referred to as the Tray, which displays
information based on which Function Tab is currently selected.

The following figure is an example of the MobilePlanner interface showing goals and other
map objects.
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Figure 5-2. Sample MobilePlanner Interface

Table 5-1. MobilePlanner Interface Description

Item Description

1 Main Menu

2 Toolbar

3 Mode Tabs

4 Function Tabs

5 MapWindow

6 Tray

7 Fleet Explorer

Table 5-2. Fleet Explorer Button Icons and Their Functions

Icon Description

Opens the Fleet window, which shows status and job statistics for all
AMRs in your fleet. It uses graphical icons to represent interrupted, can-
celed, in-progress, pending, and completed jobs. Click the checkbox to
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have the Fleet window open when you connect to an AMR or Fleet Man-
ager.

Displays the Configuration mode tab, which is used to set configuration para-
meters. For details, see Configuring the AMR on page 154. Click the check-
box to have the Configuration tab open when you connect to an AMR or
Fleet Manager.

Displays the Mapmode tab, which is used to edit the map. For details, see
Editing a Map File on page 102. Click the checkbox to have the map load
when you connect to an AMR or Fleet Manager.

Displays the SetNetGomode tab, which is used to access the SetNetGo inter-
face. For details, see Using the SetNetGo Software on page 126. Click the
checkbox to have SetNetGo open when you connect to an AMR or Fleet Man-
ager.

Displays the FLOW IQ tab, which is used to view and FLOW IQ interface.
FLOWIQ provides useful statistics about your AMR fleet. For more inform-
ation on FLOW IQ and its features, contact your local Omron representative.

Configuration (Config) Tab

The Configuration tab works with the Fleet Explorer pane to allow easy management of the
configuration parameters for the Fleet Manager, AMR groups and Individual AMRs. The con-
figuration tab is divided into two main panes: the Customization pane and the Expert Para-
meters Toolbox. Configuration parameters can be moved from the Toolbox to the
Customization pane to customize parameters for different robot groups in the Fleet Explorer.
The configuration parameters are covered in Configuring the AMR on page 154.

1
2

3
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Figure 5-3. Configuration Window, (1) Fleet Explorer Pane, (2) Customizations Pane, and (3) Expert
Parameter Toolbox Pane

Map Tab

l When the map tab is selected, the main window displays a map of the AMR's oper-
ating space. The map consists of points and lines representing the walls, doors and
other stationary features within the environment. For more details, see The MobilePlan-
ner Map Window on page 76.

l The Draw and Build Tabs, to the left of the map, provide map editing tools, and tools
for setting the AMR up to do tasks at goals (route building).

l Robot tools are visible below the map when Show Robot is toggled on. You can use
these tools to drive, dock, adjust speed, etc. These items are also available from the
Robot menu.

l To the right of the Robot tools is the Monitor icon. For details, see Using Monitor on
page 83.

l The Status area, located below the map, (shown with Show Robot Button toggled on)
provides information on the AMR position, temperature, odometer, and battery charge.
For details, see MobilePlanner Status and Tray Displays on page 85.

Map Features Legend

To view available map features in MobilePlanner, clickMap > Legend. If Show Robot is on,
the legend also shows map items associated with the AMR, like sensor readings, paths, etc.

SetNetGo Tab

The SetNetGo tab connects to the AMR’s SetNetGo interface, and displays the various con-
figurations associated with the AMR.

SetNetGo is the operating system residing on the AMR and EM2100. You use SetNetGo to con-
figure and establish network communication with the AMR, download debug information,
and perform software maintenance (upgrades).
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Figure 5-4. SetNetGo Interface

For details on the interface elements, see the remaining topics in this chapter.

5.3 MobilePlanner Operator Account Overview
Some sign-ins to MobilePlanner will be restricted to an Operator account (you can also select
the MobilePlanner (Operator Mode) from the Windows Start menu).

An Operator account provides a limited set of tools for interfacing with AMRs or the Fleet
Manager. Its main window, the Fleet window, shows the status of all AMRs in your fleet and
their jobs, and allows for simple interventions in job execution sequences. Operator Mode does
not support any setup operations, and the Map, Config, and SetNetGo windows are unavail-
able.

MobilePlanner Operator Account Interface

Operator Mode’s simplified user interface focuses on monitoring fleet AMRs and jobs. It uses
graphical elements to represent AMR statuses, and the status of all jobs (complete, in-progress,
canceled, etc.).

To launch of MobilePlanner in Operator Mode, click the Windows Start menu, and select Start
> All Programs > Omron > MobilePlanner6 > MobilePlanner (Operator Mode). When
MobilePlanner (Operator Mode) opens, enter the IP address of an AMR or Fleet Manager, and
click Connect.
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Figure 5-5. MobilePlanner Operator Mode UI

The MobilePlanner (Operator Mode) interface allows you to connect to and monitor multiple
AMRs.

MobilePlanner Operator Mode Jobs Tab

The Jobs tab displays all jobs assigned to the AMRs (listed by job ID). For debugging purposes,
you can also add a job to the currently monitored AMR by clicking the Add Job Button (lower
right corner of the window), which displays the Add Job window.

NOTE: The Add Job window is not the primary method for submitting jobs to
the fleet.

Figure 5-6. MobilePlanner Operator Mode Add Jobs window

Each job consists of multiple segments, and each segment has an associated goal. In this win-
dow, you can add or remove segments to or from a job, then submit the entire job to the
queuing manager.
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In this window, you can also add another job to the current job queue, assign a Job ID, set the
job goal (double-click the field below Goal to display a drop-down list of goals), and set the
job’s priority.

Statistics Tab

The Statistics tab displays relevant statistics for your AMRs. Those statistics include:

l FleetRobotInformation: the number of AMRs currently connected to the Fleet Manager;
their progress, and which are available and unavailable.

l JobCounts: the number of completed, canceled, and modified jobs and job segments.
l LastTripReset: the time (in sec), and human-readable date and time since last reset.
l QueueInformation: lists information about pending and in-progress jobs.
l StateInformation: information about the AMRs’ states (driving time/distance, parking
time, docking info, etc.).

l TripJobCounts: statistics related to the AMRs’ job completion (number of completed,
canceled, or modified jobs/segments).

l TripStateInformation: statistics about the AMRs’ trips when completing jobs (distance
driven or time spent at a particular job).

Figure 5-7. Statistics Tab

5.4 The MobilePlanner Menu
The MobilePlanner interface includes a menu bar to access the tools for editing the AMR's
map file. It also applies to other non-map windows, provides tools for driving the AMR, ini-
tiating scans, route building, and searching the Config, and importing/exporting Config files.
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Figure 5-8. Menu Bar

The following table describes the menu bar selections.

Menu
Option Description

File Allows you to open a local scan or map file, a map, scan, or configuration file
on an AMR, save the map file, insert another map into the existingmap file,
and download or upload a files to/from an AMR. For more details, see Opens
a submenu, which lets you select and open a file located on a particular
AMR or the Fleet Manager. on page 62.

Edit Allows you to undo or redo your last command. For more details, see Lets
you undo the most recent action on the map file. on page 64.

Robot Gives you control over various AMR activities (stop, drive, dock/undock),
allows you tomonitor the AMR dashboard and/or fleet details, create cus-
tom commands, create a fleet message of the day, and reload a con-
figuration or stop the AMR. For more details, see Robot Menu on page 65.

Map Allows you work with and edit the displayedmap file. For more details, see
MapMenu on page 66.

View Allows you to change the units used in the map, and turn the toolbar labels
on and off. For more details, see View Menu on page 67.

Tools Allows you to update preferences. For more details, see Tools Menu on page
68

Window Allows you to access the different files open in the workspace and change
the way the windows in MobilePlanner are displayed. You can choose to tile
them in the workspace or have them cascade. For more details, see Win-
dow Menu on page 68.

Help Provides help on the MobilePlanner interface. For more details, see Help
Menu on page 69.
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File Menu
Menu Option Description

Open... Opens a dialog, to search for and select a local map or a scan file to open.
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File Menu
Menu Option Description

Open on Robot Opens a submenu, which lets you select and open a file located on a par-
ticular AMR or the Fleet Manager.

l Robot Host Name or IP Address opens the login page for that
AMR. This submenu shows a list of the most recently used AMRs or
Fleet Managers.

l Select Robot... allows you to open the login dialog box and choose
a file located on a different AMR.

Displays the MobilePlannerRobot Login dialog box. Once you select an AMR,
you can search for and select a map or scan file (if available) to open. You
can also access the Configuration and SetNetGo software on the AMR.
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File Menu
Menu Option Description

Close Closes the active file.

Import Config... (Available when the Configuration Editor is selected.) Opens a dialog to
import an AMR configuration file into MobilePlanner.

Insert Map... (Available when the Mapmode tab is selected.) Opens a dialog to search for
and select a local map file to open and insert into the active map file.

Used for small changes to the physical environment that affect the AMR's
route, eliminates the need to rescan the entire workspace. See Inserting a
Map File into an Existing Map File on page 114 for more information on this
feature.

Save Writes changes to the active file, and saves either onto an AMR (if opened
from an AMR) or disk (if opened from a PC).

Save As... Opens the Save As dialog. Used to save the active file under a different
name and to a particular location on the local PC.

Note that you can also save to different file formats (such as JPG or SVG).
In those cases, the new file is not displayed in the editor.

Save on Robot Opens a submenu for saving changes to a particular AMR's map file.

l Robot Name or IP Address opens the login page for the AMR
associated with that IP address. This submenu lists the five most
recently used AMRs.

l Select Robot... opens the login dialog box for choosing a different
AMR on which to save the map file.

If configured for the AMR, the MobilePlanner Robot Login dialog box dis-
plays. Once connected to the AMR, you can save the map file.

This menu option is only available in Mapmode.

Download/Upload Opens a submenu to transfer a file to or from a particular AMR (most com-
monly, a sound file to use with ‘play,’ or playBackgroundSound’).

l Robot Name or IP Address opens the login page for the AMR
associated with that IP address. This submenu lists the five most
recently used AMRs.

l Select Robot... opens the login dialog box for choosing a different
AMR on which to save the map file.

The MobilePlanner Robot Login dialog box displays. Once connected to the
AMR, you can upload the map file to the AMR or download amap file from
the AMR.

Exit Closes the application.
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Edit Menu
Menu Option Description

Undo Lets you undo the most recent action on the map file.

This menu option is only available in Map and Configmodes.

NOTE: Undo is unavailable if you saved the map or con-
figuration.

Redo Lets you repeat the most recent action that you undid in the map file.

This menu option is only available in Map and Configmodes.
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Robot Menu
Menu Option Description

Stop Stops the AMRwhen it is in motion.

Drive Activates the Drive pad for driving the AMR in its environment.

!
CAUTION: Toggle the Manual Override toOFF to prevent
the AMR from running into anything while you are driving it.
If Manual Override mode isON, the map background turns
yellow, indicating “use caution” while driving.

NOTE: Even in Manual Override mode, the AMRwill avoid
any obstacle detected by the navigation laser when traveling
over 300 mm/s.

NOTE: With Show Robot turned ON, you can access AMR
drive icons from the Map view.

NOTE: Driving remotely via MobilePlanner may not work
with larger platforms such as HD robots, please reference
the User's Manual for specific robots.

Dock Sends the AMR to a dock.

Undock Releases the AMR from the dock.

Monitor (Same as the Monitor Button in the map and robot tools menu). Allows
you to view and/or configure various AMR details - battery info, digital
inputs and outputs, audio, add and execute tasks, macros, and routes.

Debug Allows you to trace underway tasks for debugging.

NOTE: This is an advanced feature, used for debugging
advanced functionality.

Custom
Commands

Allows you to create and send custom commands to the AMR. This is used
mainly for debug log file starts and stops.

Map Creation Allows you to start and/or stop the AMR's scanning process, from which
you can build a map file.

Messages Allows you to create custom Fleet Manager and/or Robot Messages of the
Day.

Robot Tools Provides access to advanced AMR tools, including localizing, reloading con-
figurations, auto-docking, and issuing shutdown commands for a single
AMR or all AMRs in the fleet.

Safety
Commissioning

Allows testing and commissioning (verification of proper function) of an
AMR's on-board safety systems. Uses a wizard to test E-Stop (tests brake
activation) and Safety Laser (tests max speed limits and obstacle detec-
tion). Per EN-1525, commissioningmust be done by specially trained
people. See Safety and Regulatory Information on page 20 for details on
Safety Commissioning.
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Map Menu
Menu Option Description

Fit in Window Adjusts the map so it all fits within the mapwindow.

Grid Displays the grid in the mapwindow. Grid line spacing is at 1 meter inter-
vals.

NOTE: The MobilePlanner grid is not the path planning grid
or localization grid. It is simply for reference.

Origin Displays the X/Y coordinates of the overall map. You must zoom the map
view out to see the origin lines.

Robot Data Allows you to control the display of various AMR-relatedmap features such
as sonar, laser, path, and localization.

Map Data Opens a submenu, which lets you toggle the features to view on the active
map file:

l Points
l Lines
l Lights (if using Acuity)

Rotate Opens a submenu, which lets you rotate the entire map in the mapwin-
dow.

l Rotate Right
l Rotate Left
l Rotate Full 180o

l Reset to None

You can also save the rotatedmap as the default orientation.

Legend Keeps track of all of the different features available in the map file. Each fea-
ture is identified on the mapwith a different color rectangle or line. For
more details, see Map Legend on page 82.
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View Menu
Menu Option Description

Units Opens a submenu in which you can change map units. You can select:

l Millimeters (default)
l Meters
l Feet/Inches
l Inches

The units apply to values displayed in the status bar, in map object edit
boxes, andwhen using ameasuring stick. See Advanced Lines and Areas
on page 113 for details.

Show Main
Toolbar Labels

Toggles toolbar labels ON or OFF. To hide the labels, uncheck this menu
option.

Configuration Submenu contains the option to toggle Show Deprecated Parameters.
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Tools Menu
Menu Option Description

Preferences... Opens a dialog box with tabs for Comm and Computer ID parameters.

l Comm Tab: Allows you to select Robot Server (from pick list), and
set connection attributes for TCP/IP only, or reuse login information
when reconnecting.

l Computer ID Tab: Includes a field that displays the name of the
computer on which the MobilePlanner installation exists (e.g., "John
Doe's Laptop"), and allows you to select the goal nearest the AMR's
current position.

ClickOK after making any configuration changes.

Click Reset... reverts to initial installation-like state and resets all previous
changes.

Click Cancel to stop without making any changes.

Window Menu
Menu Option Description

Tab Arranges the open windows in tabs, just below the main tool-
bar. This is the default display mode.

Tile Arranges the open windows as tiles, open next to each other.

Cascade Arranges the open windows in a cascade, or waterfall, form-
ation.

1:<IPaddress>:map Contains a list of the open map and/or configuration files, or
SetNetGo. Select from the list to make that the active win-
dow.2:<IPaddress>:Con-

figuration

3:<IPaddress>:SetNetGo

NOTE: Be aware that <IPaddress>: is only true for the Fleet Manager connection.
It's <Identifier>: for robots.
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Help Menu
Menu Option Description

Fleet Operations Workspace
Core User's Guide

Allows you to open aWindows type help version of this
guide while usingMobilePlanner software.

Document Library (online) Provides link to:

http://www.ia.omron.com/products/category/robotics/mobile-
robots/index.html

What's This? Selecting this menu option, or using the shortcut Shift +
F1, and then clicking on the MobilePlanner workspace dis-
plays a pop-up containing a brief description of some fea-
tures.

Open Output Log Folder Opens the folder containing savedMobilePlanner output
logs.

About MobilePlanner... Provides information on the current version of MobilePlan-
ner and underlying applications/libraries.

5.5 Connecting to a Robot
Follow these steps to connect to a robot in MobilePlanner:

1. Double click on New Connection in the Fleet Explorer.

Figure 5-9. The New Connection Button

2. Add your username, password, and robot IP Address.

3. Click on the Connect Button.

After connecting to a robot, if you wish to disconnect you may do so by right clicking on the
robot in the Fleet Explorer and selecting Disconnect.

5.6 Connecting to a Fleet Manager
The steps needed to connect to a Fleet manager (real or simulated) are the same as connecting
to a robot. Use the Fleet manager IP address.

After connecting to a Fleet manager, you will see the name of the Fleet manager appear in the
Fleet Explorer, along with the robots connected to that Fleet. See the following section for
instructions on how to add a robot to a Fleet. The Fleet will be displayed as per the below hier-
archy.
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l Robot family
l Robot type
l Robot (name or Identifier)

B

A

C

D

Figure 5-10. (A) Robot Family, (B) Robot Type, and (C) Subfleet (D) Robot Name/Identifier

The robot families, robot types and individual robots are sorted in alphabetic order. You may
collapse the robot family hierarchy as well as the robot type hierarchy. You can do so by

simply clicking on the expand/ contract widget ( ).

5.7 Connecting a Robot to a Fleet
Follow these steps to add a robot to a fleet in MobilePlanner:
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1. Find the robot in the Fleet explorer and click on its Config Button.

2. Locate the Connect to Fleet Manager parameter in the Fleet Manager connection section
under the Fleet category. Refer to the image below:

Figure 5-11. Fleet Manager Connection settings located in the Configuration pane

3. Enable the parameter by checking the box. The FleetManagerAddress parameter should
appear.

4. Enter the Fleet manager's IP address as the parameter's value.

5. Save the configuration.

If the robot is on the same network as the Fleet Manager device, the robot's name should now
appear in the Fleet Manager's hierarchy.

After connecting to a fleet, if you wish to disconnect you may do so by right clicking on the
Fleet icon and selecting Disconnect.

5.8 Creating a Subfleet
A subfleet is a category inside the robot type hierarchy level that can be used to group robots
for configuration management. For example, you may group a set of LD-250 robots based on
their function (e.g. a "Conveyors" subfleet) or location in the map (e.g. a "Production Area C"
subfleet) and then configure each subfleet separately.

Follow these steps to create a subfleet:

1. Open the configuration tab of the Fleet by clicking on the Config icon of the Fleet in the
Fleet Explorer.

2. Right click on the robot type (For example LD-60, LD-90, LD-250).

3. Select New Subfleet.
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Figure 5-12. Creating a Subfleet

To delete a subfleet, right click on the subfleet, and the select Remove.

To add a robot to a subfleet, simply drag and drop the robot into the subfleet. To remove the
robot from the subfleet right click on the robot, and then select Remove.

5.9 The MobilePlanner Toolbars
There are three toolbars possible in the MobilePlanner interface:

l The main toolbar, which is located at the top of the MobilePlanner interface.

In the Map tab only:

l The Map Controls toolbar is a floating toolbar, which you can move within the map
area.

l The AMR toolbar, below the map.

The following sections describe each set of tools.

Main Toolbar

The MobilePlanner main toolbar is located at the top of the window, under the main menu.
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Figure 5-13. Example of jMain Toolbar

To view the main tool bar icons label you can hover over each icon, and view the label. You
can also select View > Show Main Toolbar Labels to view the main toolbar top icons label.

Figure 5-14. Example of hovering over an icon to view the label

Figure 5-15. Displaying the Main Toolbar Top Icons Label

Table 5-3. Main Toolbar Icons and Their Functions

Toolbar Icon Description
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Saves changes to the active map or configuration file on the AMR.

Lets you undo the most recent action performed on the map or config file.

Lets you restore the most recent item you undid in the map or config file.

Robot and Map Toolbars

The map toolbars control the view of the map, set a goal at the AMR position, and localize the
AMR. (Localizing is telling the AMR where it is on the map of the work area.) There are two
different map toolbars available: one when the Show Robot Button is toggled ON (the AMR is
displayed on the map); the other with the Show Robot Button toggled OFF (the AMR is hidden
from the map).

Figure 5-16. Robot Toolbar (Show Robot ON)

Figure 5-17. Floating Map Toolbar

Table 5-4. Robot and Map Toolbar Icons and Their Functions

Toolbar Icon Description
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Some of the following icons are available when the Show Robot Button is toggled ON, but
are disabled if the AMR cannot service the request because of low state of charge, or if E-Stop
is pressed.

Stops the AMR any time you click this icon, even when navigating in
autonomousmode.

NOTE: You can also use your keyboard’s Esc key to stop the
AMR.

Sends the AMR to a point you select on the map.

Sends the AMR to a goal you select on the map.

OFF when the AMR is on a dock or heading to a dock. Also sends the AMR to
a dock.

When OFF, releases the AMR from the dock.

Opens the Drive pad, which is used tomove the AMR in its environment. Be
sure that you have Manual Override toggled OFF, which prevents the AMR
from running into anything while you are driving it. Even with Manual Over-
ride turned ON, the AMRwill avoid any obstacles detected by its navigation
laser when traveling over 300 mm/s.

Highlight (click on) the pop-upwindow, and use the mouse or the arrow
keys on the keyboard tomove the AMR in the direction you want it to go.

!
CAUTION: When Manual Override is ON, the background
of the map turns yellow, indicating "use caution" while driv-
ing.

Opens the Localize Robot dialog, which is used to localize the AMR to a point
selected on the map.

Allows you to create a goal and/or door with goals, or place a dock at the
AMR’s current location.
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The Monitor robot feature is available only when the Show Robot Button
is toggled ON. It provides a convenient place to monitor important AMR
details (battery info, state, job counts, sensors, and queuing stats), and the
status of digital inputs/outputs. It also provides a place for sending an AMR
on a route, adjusting audio input/output volumes, and inputtingSay com-
mands (phrases that the AMR speaks with its text-to-speech converter).

Shows the location of the AMR on the map. Several toolbar features won't
function unless this is toggled ON. Others won't function unless it is toggled
OFF. The background color of the icon turns darker when it is ON.

Centers the map on the current AMR. This is helpful when you have mul-
tiple AMRs in your workspace and you need to locate a specific AMR quickly.
It also allows you to watch the AMR as it performs tasks.

Adjusts the map view to fit in the mapwindow.

Zoomsmap out (reducedmagnification, more map visible).

Zoomsmap in (increasedmagnification, more details visible).

Allows you to pan around the map.

1. Click on the Pan icon to display the Pan Map box.

2. Click on any of the four arrows of the Pan Map box tomove that dir-
ection in the map.

The keyboard arrow keys perform the same function as clicking on
the Pan Map arrows.

NOTE:
l If Center on Robot is turned ON, you cannot
pan the map window.

l You can also pan the map by clicking and
holding the right mouse button while moving
the mouse around the workspace.

The Pan Up, Pan Down, Pan Left and Pan Right icons are available when the
Pan Button is turned ON.

5.10 The MobilePlanner Map Window
The MobilePlanner Map window displays the map file that you are editing. When you first
start MobilePlanner, no map is displayed until you connect to an AMR or Fleet Manager. You
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can also open a map saved locally on your computer or network. For details on opening maps,
see Loading an Existing Map File on page 100.

The following is an example of the MobilePlanner interface with a map file opened. Note that
the Show Robot Button is toggled ON, which disables the tools on the Draw function tab.

Figure 5-18. The MobilePlanner Interface, Map Tab, Show Robot OFF

NOTE: To create the initial map, you must first use MobilePlanner to scan the
AMR's environment and then turn the scan into a map. For details, see Scanning
the Operating Area on page 96.

Map Zoom

Maps initially open zoomed out to give you an overall view of the AMR’s environment. To
quickly find the current AMR in the map, click the Show Robot Button, then click Center on
Robot. The map zooms in, focused on the AMR.

NOTE: The Show Robot Button must be ON to display the Center on Robot
icon.
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Map Controls

You can use the mouse or the keyboard to adjust the map view. The following table describes
the map controls.

To... Do this...

Pan Mouse: press and hold the right mouse button (or use the scroll wheel),
move the mouse around the workspace.

Keyboard: use the arrow keys to move right, left, up and down.

NOTE: You can’t pan the mapwhen the Center on Robot tool-
bar icon is toggled ON.

Zoom in Mouse: press the Shift key and click the right mouse button; or you can
rotate the scroll wheel forward (without the Shift key).

Keyboard: press the Shift key and the Up arrow.

Zoom
out

Mouse: press the Shift key and click the left mouse button; or you can rotate
the scroll wheel backward (without the Shift key).

Keyboard: press the Shift key and the Down arrow.

Map Features

Map features can be as simple as the static features of the environment (walls, doors, etc.) or,
depending on the features you add to the map, they can be quite intricate. In general, more
map detail improves AMR navigation.

To create a detailed map of the environment, you need to scan the environment thoroughly
and then edit the map. This is done in the MobilePlanner software. For more information on
environment scanning and map editing, refer to Scanning the Operating Area on page 96 and
Editing a Map File on page 102.

The following table describes the different features shown on the map.
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Map Feature Definition

This represents the LD-60 and LD-90 AMRs.
The white arrowhead indicates the direction
that the AMR is currently facing.

This represents the Cart Transporter AMR. The
white arrowhead indicates the direction that
the AMR is currently facing.

This represents the LD-250 AMR. The white
arrowhead indicates the direction that the
AMR is currently facing.

This represents the HD-1500 AMR. The white
arrowhead indicates the direction that the
AMR is currently facing.

This is the Legacy representation of a robot.
The black line indicates the direction that the
AMR is currently facing. This may still appear
in some system maps.

The black dots and lines on the map are the
walls, doors, and other static fixtures in the
environment.

The blue dots and lines are the features the
AMR "sees" with its navigation laser. Some
AMRs have additional lasers which produce dif-
ferent colored dots.

The yellow squares represent the location
where the AMR should go, and the black line is
the direction it should face, when it starts to
dock. The dock object should be approximately
1 to 1.5 meters in front of the dock.

The green squares represent a goal. The line
indicates the AMR’s desired heading when it
reaches the goal. Goals are predefined loc-
ations where you can send the AMR.

The light turquoise squares represent Standby
Goals. These can be either buffering or park-
ing.

Map Object Visibility Filtering

Using the Filter Button, visibility can be toggled between showing all map objects and show-
ing only appropriate map objects for specific AMRs based on the Custom Tasks applied at the
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selected fleet hierarchy level. This is called Filter Mode. To determine which fleet hierarchy
level is being shown, simply click on different levels in the Fleet Manager.

Figure 5-19. Filter Button in the Map Window

In the image below, Filter Mode is enabled, and the map is only displaying objects of rel-
evance to the selected hierarchy group of AMRs. Any map objects with a Custom Task that is
not configured for the selected AMR group will be hidden. Objects with no Custom Tasks will
always be recognized by any AMR.

Figure 5-20. All map objects are currently visible
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Figure 5-21. Filter Mode enabled

Regardless of whether Filter Mode is ON or OFF, clicking on map objects will highlight AMRs
that can access it with a magenta line in the Fleet Manager. This is for quick reference on what
AMRs in the fleet can recognize a map object.

Figure 5-22. Magenta line indicating AMR compatibility with the selected map object

Map Modes

When Show Robot is ON, there are several map modes which provide a different AMR func-
tion, shown in the following table:
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Icon Map Mode Definition

Send Robot Allows you to send the AMR to a certain spot on the map.
When active, clicking on the map causes the AMR tomove
to that spot.

To activate this mode, click Send Robot on the Toolbar,
then click on the mapwith the left mouse button to send
the AMR to that point. You can also send the AMR by hold-
ing down the Ctrl key and clicking on the map.

To specify the AMR’s desired heading when it arrives at the
designated spot, press the mouse button and drag.

To deactivate this mode, click the Send Robot icon to
toggle it off.

After you click a point on the map, the AMR autonomously
drives to the point you selected.

Robot Control Allows you to drive or send the AMR using the keyboard. To
activate this mode, hold down the Ctrl key and press the
arrow keys.

Localize to Point Allows you to localize (mark the AMR’s location) the AMR
on the map. See AMR Localization on page 260 for details.

NOTE: When Show Robot is OFF, the cursor shape indicates what your mouse
click or movement will do (see the following table). These cursors are visible
after selecting an object.

Cursor Function Appears when
you...

Open the Edit window (double-click), or drag the object
within the map.

Double-click or click-
and-hold on an
object, other than on
a headingmarker or
endpoint.

Change the heading of a goal or dock, or resize a line. Click on the goal/-
dock headingmarker
or either end of a
line.

Resize a rectangular object (the cursor is rotated 90°
depending on which corner you pick).

Click on a corner of
an area or sector.

Rotate the object. Click on the heading
arrowhead of an
area.

Map Legend

As you edit the map file, you can create goals, lines, forbidden areas, docks and many other
features in the environment. Use the Map Legend to keep track of all of the different features
that can be added to your map file.
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SelectMap > Legend... from the main menu to open the Map Legend window.

Figure 5-23. Map Legend (Partial)

5.11 Using Monitor
The Monitor feature provides a convenient place to monitor important AMR and Fleet Man-
ager details (battery info, state, job counts, sensors, and queuing stats), and the status of digital
inputs/outputs.

It also provides a place for sending an AMR on a route, adjusting audio input/output
volumes, and inputting Say commands (phrases that the AMR speaks with its text-to-speech
converter).

Monitor can be activated either in single AMR or Fleet mode, when you are attached to a Fleet
Manager.

The displayed data and appearance will differ, depending on whether you are connected to a
Fleet Manager or an AMR, and whether or not the Show Robot Button is ON.

To Access Monitor

1. ClickMonitor on the Robot toolbar to display a sub-menu with various AMR attributes
you can monitor.
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Figure 5-24. Monitor Drop-down Menu

The following table describes the various attributes you can monitor.

Item Description

Dashboard Displays an information window listing jobs (number of interrupted,
canceled, in-progress, pending, and completed) and AMRs (that
need assistance, have E-Stop pressed, busy, available, and unavail-
able).

Fleet Details Lists information about AMRs in the fleet - availability, status of
assigned jobs, queuing and state information, system status, and
memory use.

Details Lists specific details about the currently monitored AMR - bat-
tery/charge stats, path planning and following, AMR pose inform-
ation, queuing statistics, system data, andwireless data.

Digital I/O Allows you tomonitor custom input/output states, and toggle out-
put states ON (green) or OFF (black).

Audio Controls incoming and outgoing audio volume.
Audio Incoming: MobilePlanner Out: controls the level out (for
example, 'sendSpeech').
Audio (Output): Robot Out controls the volume of speech audio files
the AMR plays.

Tasks Lists current tasks assigned tomonitored AMR, and allows you to
add them to the selected route builder list (normally a goal versus a
route).

Macros Lists and allows immediate execution of all existingmacros.
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Item Description

Routes Lists and allows immediate execution of all existing routes.

Adjusting Audio Levels

The robot monitor also allows you to adjust the incoming and outgoing audio levels. These
controls are shown in the following figure.

Figure 5-25. Audio Controls

You can adjust audio output level by moving the slide controls to the right (louder) or left
(quieter). You can amplify the effect of the incoming audio control setting by selecting the 2X
check box.

Making the Robot Talk

TheMonitor > Audio window includes a text-to-speech feature. You can use the Say field to
input a word or phrase that you want the AMR to speak.

When you click the Say icon, the text is converted to synthesized speech through the text-to-
speech converter.

5.12 MobilePlanner Status and Tray Displays
The status and tray displays allow you to monitor the status of the AMR (or AMRs) directly
from the software interface.

Status Information

The status of the selected AMR is displayed directly beneath the map, as shown in the fol-
lowing figure.

NOTE: In MobilePlanner, the Status area is only visible when the Show Robot
Button is toggled ON.
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Figure 5-26. Status Information

The following table describes some of the available status information.

NOTE: By default, the status area shows only a small sub-set of available AMR
details. To view other data, see Displaying Other AMR-Specific Details (below).

Status Detail Description

RobotX and RobotY The current X and Y position of the AMR in the map.

RobotTh Robot theta - the AMR’s heading (which way it’s facing), in °, meas-
ured counter-clockwise. 0 is the x axis.

TransVel The velocity of the AMR.

RotVel The AMR's rotational velocity (how fast it is turning).

Displaying Other AMR-Specific Details

There are many other AMR-specific parameters you can choose to display in the status area.
To view and/or add other AMR details, in the MobilePlanner main menu, select Robot > Mon-
itor > Details.
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Figure 5-27. Robot Details Window

If you want to add a detail to the status area, click on the detail, then click the Show in Map
Button (lower left corner). Or, you can right-click in the status area to Hide in Map.
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Tray Information

Below the status area, there is a tray that contains information such as connection status and
the pointer location.

NOTE: The tray information is always visible.

Figure 5-28. Tray Information

The following table describes the items available in the tray.

Table 5-5. Available Tray Icons

Tray Icons Description

Displays the temperature reading of the current AMR.

Indicates the state of charge (in %). The icon turns yellow
when the charge begins to run low. It flashes red when the
battery is low and the AMR needs to dock.

X: Shows the X position of the pointer in map coordinates.

Y: Shows the Y position of the pointer in map coordinates.

Displays the system clock.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 88





Chapter 6: AMR Driving Overview

Now that you have installed the MobilePlanner and set up a wireless connection to your
AMR, you are just about ready to drive the AMR around your workspace. You can drive the
AMR using either the pendant and walking around your environment, or operating it from the
MobilePlanner software. Using the keyboard in the MobilePlanner, you can dock and undock
the AMR the from its docking station, drive the AMR forward, backward, turn the AMR, and
control its speed. This capability is only available with the LDx systems, and can not be used
with the HD robot series.

!
CAUTION: Before attempting to drive the AMR, be sure to read the appro-
priate AMR user's guide and Mobile Robot Safety Guide so you are familiar
with the AMR's operation.

6.1 Before Driving the AMR
Both the HD, and LD robot series will automatically undock from the charging station before
responding to the motion commands.

6.2 Manual Override
Autonomous Drive mode is the AMR’s default driving mode, and ensures the AMR does not
run into anything in its environment. When driving the AMR using MobilePlanner, Autonom-
ous Drive mode prevents the AMR from entering forbidden or restricted spaces. If driving the
AMR using the pendant, you can make the AMR enter forbidden or restricted spaces, but the
AMR always obeys the lasers for obstacle avoidance.

When Manual Override is ON, the map background turns yellow (see below).
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Figure 6-1. MobilePlanner, Manual Override ON

To Drive with Autonomous Drive mode OFF:

1. In the MobilePlanner main menu, click Robot > Robot Tools > Manual Override.

2. Click Yes to acknowledge the Manual Override dialog prompt.

NOTE: If you turn Autonomous Drive mode back ON when the AMR is in a
restricted or forbidden area, it will not be able to drive itself out of the restricted
area, and will require you driving it out using the pendant (which always
ignores location-dependent areas). Also, while an AMR is in a forbidden area,
even with Autonomous Drive mode still OFF, pressing the Send Robot Button
will not cause the AMR to drive out of the forbidden area. You must drive the
AMR out of a forbidden area using the pendant or your PC’s arrow keys. See
Driving Using the Software Interface (Drive Pad or Keyboard) on page 91.

6.3 Driving Using the Pendant
Refer to your AMR’s user manual for details on the pendant and its use.

Preparation

1. If not already done, power up the AMR. The full power-up sequence can take several
minutes.

2. Wait for MobilePlanner and/or the AMR to indicate it is ready (via wheel lights, LCD or
touch screen).

3. Plug the pendant into the AMR’s pendant connection port.

4. If driving with the pendant, proceed to Scanning the Operating Area on page 96.

6.4 Driving Using the Software Interface (Drive Pad or Keyboard)

NOTE: The Drive Pad functionality is not available for the HD-1500 AMR. The
Drive Pad display will be grayed-out. Drive Pad operation is not changed for the
LD-60, LD-90, and LD-250 AMRs.

Using MobilePlanner software and your PC's mouse and keyboard, you can:

l Dock and undock the AMR from a docking station
l Drive the AMR forwards, backwards, and turn
l Control the AMR's speed

To Drive the AMR Using the Software:

1. Ensure Show Robot is active, then click Center on Robot to locate the AMR (shown as
a robot icon) in the map window (shown in the following figure).
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1

23

Figure 6-2. AMR on Map (Show Robot ON)

Table 6-1. AMR on Map Description

Item Description

1 Show Robot

2 Center on Robot

3 Robot (LD-60 AMR shown)

2. Select Robot > Undock from the main menu, or click Dock (on the AMR tool bar) to
turn docking off. In the map window, you should see the AMR move away from the
docking station.

3. If the background in MobilePlanner is yellow (the AMR is not in Autonomous Drive
mode), un-check Robot > Robot Tools > Manual Override from the MobilePlanner
main menu.

4. Click Drive to display the MobilePlanner Drive Pad with Speed slider (figure below).
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Figure 6-3. Drive Pad with Speed Slider

5. Highlight (click on) the map window, and use the mouse to click on the Drive Pad but-
tons, or use keyboard’s arrow keys to control the AMR’s direction. Use the speed slider
(at the bottom of the Drive Pad) to control the AMR’s speed.

NOTE: If the speed slider is all the way to the left (-), the speed is set to
zero and the AMR will not move.
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7.1 Map Overview
With Fleet Operations Workspace Core software, AMRs know where they are and drive from
one place to another by themselves, without a human operator. To do this, the AMR must
have a prepared map of the static features in its operating environment. MobilePlanner soft-
ware makes creating maps for one AMR, or an entire fleet of AMRs fast and easy.

Maps are one of the most important features of MobilePlanner. In MobilePlanner, a map is a
scanned representation of the floor plan in the AMR's operating space. Maps contain the static
features in the AMR's environment, such as walls, doors, permanent shelving, etc. They also
contain user-definable sectors, lines, and areas that help the AMR perform its job.

7.2 Scan Overview
The first step is to create a map of the AMR’s environment. In general, the process is as fol-
lows:

l Read the section on scanning (see Scanning Overview on page 94), and the section on
scanning tips.

l Read the section on driving the AMR (see AMR Driving Overview on page 90).

l Scan the AMR’s operating space (see Scanning the Operating Area on page 96).

l Use MobilePlanner to generate a map from the scan.

7.3 Scanning Overview
Before the AMR can perform autonomous tasks, it needs to have an accurate map of its envir-
onment. It is best to create a scan that includes as many stationary features as possible in the
workspace. After scanning, use MobilePlanner to turn the scan into a map, then begin assign-
ing tasks to your AMR.

How Does the AMR Scan its Environment?

The AMR uses its forward laser, which scans in a 240° arc for the LD-series AMRs. The HD-
1500 AMR uses only its front laser, scanning in a 270° arc. Note that the HD front (and rear)
laser is not centered on the AMR.

7.4 What Gets Scanned?
Scans are on a thin horizontal plane. The scan is taken about 200 mm for the LD-series and
175 mm for the HD-1500 from the floor. So tables appear as four legs; a pedestal appears as a
single pole, minus the feet.
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Distance From Walls

While scanning, keep walls within that range as you drive throughout the workspace. For
instance in a large warehouse, run the AMR along the outer walls as well as through the
middle of the space.

Uni-directional Versus Bi-directional Scanning

Uni-directional scanning (scanning in a single direction) works very well for hallways and
small rooms. Bi-directional scanning (scanning in two directions) will ensure complete scan-
ning of all features (such as vending machines or bookshelves).

In either case it is still necessary to end the scan in roughly the same place that you started.

Doors and Windows

When scanning environments with doors, ensure that the doors are open in places where the
AMR will drive. Some glass surfaces, particularly those with dark backgrounds, reflect the
range finder signals; others don’t or reflect weakly. Consider retrofitting particularly trouble-
some places with tape or other treatments to obtain proper scans. Additionally, you can des-
ignate these features as obstacles in the map using a forbidden zone sector.

Dynamic Features

During scanning, MobilePlanner sees people walking by, swinging doors and other things
moving throughout the workspace. If a group forms during scanning, have them follow
behind (not stand in front of) the AMR’s scanner so they do not become permanent features of
your map. For an HD-1500, have them stand behind and to the left, since the laser being used
for scanning is on the front-right of the AMR. When editing the map, erase dynamic features
(like the group) to improve the map’s quality.

Docks

When scanning, scan and press the goal button to mark the AMR's dock so it can recharge
when its battery runs low.

7.5 Scanning Tips
The following general tips will help increase the AMR’s scanning accuracy, and reduce pos-
sible map errors:

l Remove any features like chairs, rolling cabinets, etc. that might not be present during
normal operations.

l Walk behind the AMR while scanning (and ensure others walking with the AMR also
walk behind the laser’s sensing area). With an HD-1500, walk behind and to the left of
the AMR, so that the laser (on the front right) doesn't see you.

l Drive the AMR into tight corners, down small corridors, and between stationary objects
(with enough room).

l Scan in multiple directions - scan clockwise for one scan, counter-clockwise for another.
l If scanning rough terrain (like diamond plate flooring), drive slowly (to reduce the
chances of wheel slip) and in multiple directions. This will help minimize introducing
errors into the scan.
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l Open doors that might be open during normal operations, and doors the AMR will
have to drive through.

l Drive the AMR through previously scanned areas.

NOTE: Driving the AMR back through previously scanned areas, and
returning to its starting position can help minimize errors.

Scanning the Operating Area

Be sure to drive the AMR to all of the places you would expect it to go on its own. Drive all
the way around a room, not just in and out of the doorway. Turn the AMR to point into
corners and move around stationary features. In other words, be thorough!

Also, while driving the AMR, orient and stop it along the way to mark important goals (espe-
cially a dock object). Later, you can edit these and add additional goals within MobilePlanner
software.

When driving the AMR to create a map you can improve the process by returning to an area
that the AMR has already been. This creates a "loop" which the MobilePlanner software can
use to establish a more accurate map. It is important to end the mapping process with the
AMR in close to the same location, with the same heading as the place where you began. This
ensures that at least one loop is created. Including smaller loops while driving may result in a
more accurate map. For example, drive the AMR in a loop around a room or open area
instead of entering and exiting through different doors. Your map will benefit from sensor read-
ings of this area taken from different angles, as well as from the creation of a loop. See the
image below for an example of a thorough scanning path.

Figure 7-1. Example scanning path with ample looping around rooms
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1. If not already done, launch MobilePlanner and connect to the AMR.

NOTE: Before starting these steps, make sure the AMR is not charging. If
the AMR is docked, undock it by clicking Robot > Dock (in the
MobilePlanner main menu bar), or by clicking the Dock Button in the
MobilePlanner toolbar (only visible if Show Robot is active).

2. From the MobilePlanner main menu, select: Robot > Map Creation > Start Scan.

3. Enter a name for your scan file in the New Scan Name field and click OK.

This initiates the scanning process. Notice that the AMR's LCD changes to map scan-
ning mode.

NOTE: Before driving the AMR, make sure it is in Autonomous Drive
mode (a yellow background in MobilePlanner indicates the AMR is not in
Autonomous Drive mode). To enable Autonomous Drive mode, un-check
Robot > Robot Tools > Manual Override in the MobilePlanner main
menu bar.

4. Use the pendant to drive the AMR around its operating space.

NOTE: Be sure to drive the AMR around the entire operating area to cre-
ate an accurate scan of your environment.

5. If you want to create a goal at the point where the AMR is stopped, press the pendant’s
black GOAL button to mark a goal.

6. Continue driving the AMR around the operating space until you have a thorough scan
of your environment.

7. Return the AMR to its starting position.

8. After you have finished the scan, select Robot > Map Creation > Stop Scan from the
MobilePlanner menu.

The resulting scan file resides on your AMR, but not on the PC running MobilePlanner. The
file name is the name you entered for the scan with the ‘.2d’ extension. If scanning using Acu-
ity, the file name has a ‘.z2d’ extension, and includes additional data such as camera images
used to scan overhead lights.

NOTE: Acuity localization is not yet supported for the HD-1500 AMR.

Convert the Scan into a Map

After the AMR scans the operating environment, you need to turn the scan file into a map file.
To do this, open the scan file (.2d) in MobilePlanner.

NOTE: MobilePlanner can process only one scan file at a time. Opening a
second scan file disables the toolbar Start Button until the first scan is finished.
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1. Open the MobilePlanner software.

2. Select File > Open on Robot, then select the AMR, either from a list or by IP address.

The Open File on Robot dialog box appears.

Figure 7-2. Open File on Robot Dialog

3. Check the Scan File: checkbox, select the scan file you just created from the pulldown
list, and click Open.

A new map window and the Scan Tools toolbar appear, and the conversion (regis-
tration) process begins automatically. Initially, the map shows an AMR icon in the map
window. During file processing, the software adds scan points to the map window and
updates the AMR's position showing a blue trail to trace the AMR's previous positions.

NOTE: Be patient! Converting a large scan file can take considerable time
(and memory), and is based on the size and layout of the area being
scanned (for example, a small facility could take 20 seconds, a 20,000
square foot facility could take over an hour). If the small AMR icon in the
lower right corner of the map window is still moving, the conversion pro-
cess is still underway.

NOTE: PC memory (RAM) is critical when processing a very large scan
file. Processing large scan files with insufficient RAM can significantly
degrade the performance of all applications. If this occurs, it might be
necessary to create smaller scan files and use the Map Insert feature to
combine the pieces (refer to Inserting a Map File into an Existing Map File
on page 114 for details).

When processing is complete, the AMR icon and its trail disappear from the map win-
dow, and the scan icon in the status bar stops animating. If the map has too many stray
objects or otherwise does not appear as you need, you can adjust the scan settings and
re-process the scan file (for details, refer to Changing the Scan Settings on page 119).

4. Save the cleaned map file locally on your PC.

5. In the Scan Tools toolbar, click Finish to complete the conversion process.

NOTE: Unless working in batch mode, you must finish converting one
scan before opening and converting another scan.
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6. Edit the map file to erase (Draw pane > Eraser) stray, non-stationary objects (like chairs,
people, etc.). Add forbidden areas and sectors. Create goals and macros, and assign
tasks to your AMR. Refer to Editing a Map File on page 102.

7. Select File > Save on Robot to save the finished map file on the AMR, then select your
AMR from the MobilePlanner menu. Optionally, you can enter a Fleet Manager address
so it can be shared between multiple AMRs.

NOTE: Select Yes when prompted to make the new map the AMR’s cur-
rent map so the AMR can localize, and appear on the map (when you
click Show Robot).

Map Data

The finished map consists of points and lines (vectors derived from points) representing the
walls and other real features detected by the scanning laser.

Figure 7-3. Scanned Environment

7.6 Working with Map Files
This section explains map files and how to work with them in the MobilePlanner software.

Making a Map

Before MobilePlanner can create a map of the mobile AMR’s operating space, you have to
drive the robot through the operating space as it scans the area with its laser and (if installed)
Acuity. The resulting scan file contains all the raw data for features in the space. To be usable
for mobile robot navigation, you have to use MobilePlanner to convert the scan file into a map
file.
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Generally, you only need to make a map when deploying your AMR for the first time in a new
environment. Occasionally you might need to rescan if the workspace undergoes extensive
structural modifications or lighting changes, cubicles added in what was open space, a new
wing to the building, or remodel of an area. For more extensive map updates, MobilePlanner
provides the tools to integrate a new map, partially or wholly, into your original application
(refer to Inserting a Map File into an Existing Map File on page 114 for details).

The best time to create a map scan is when the environment is least busy, when you can min-
imize the amount of time spent avoiding people and other non-stationary obstacles, and when
you can move about, opening and closing doors, without disrupting normal daily activities.

What Information is Stored in a Map File?

Map files contain four kinds of data about an operating environment that the AMR uses in
planning navigation and executing tasks:

l Obstacles and features scanned by a laser, and/or overhead lights acquired by Acuity.
l Objects, such as goals, forbidden lines, and sectors that control AMR behavior.
l Macros and tasks associated with goals.
l Data that defines properties of special goal types and available tasks.

A map file name has an extension of .map. Scan file names have an extension of .2d.

Scan files for light localization have an extension of .z2d (scan file is a zip file referred to as
the Scan Package) or .zmp (map file from scan - a zip file referred to as the Map Package).

l For information on creating a map using the scanning laser, refer to Scanning the Oper-
ating Area on page 96.

l For information on creating a map using Acuity for light localization, refer to Creating
the Light Map on page 267.

Loading an Existing Map File

There is no map to display when you first start up the MobilePlanner software. You must use
MobilePlanner, with ‘Map’ checked, and connect to an AMR or Fleet Manager to open a map
file to edit. Or, you can open a map saved locally on your computer or (when the Map Button
is checked) open a map that is currently in use on a specific AMR. You can also open maps
on the AMRs that are currently not in use.

Opening a Map saved on your PC

When you use the Map Button to open and edit your map files, you can save them locally on
your computer until you are ready to upload them to the AMR. Local map information is also
written in the debug info files.

Selecting File > Open from the MobilePlanner main menu displays a dialog that lets you
search for and select a local map file to open.

Opening a Map stored on an AMR

You can also click the Map Button to edit a map file that is already in use on an AMR, which
is helpful for making quick changes to the map or the AMR's route.
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1. In the MobilePlanner main menu, select File > Open on Robot to display a submenu
that lets you select a particular AMR.

2. Either choose from the displayed AMR IP addresses, or enter a new AMR IP address to
open a map on the specified AMR.

A dialog box appears in which you can choose between Configuration, Map File, Scan
File, and SetNetGo files.

Figure 7-4. Open File on Robot dialog

3. CheckMap File to choose a map file located on the AMR.

You can use the Map File list and/or click the Advanced Button to search for and select
a map file to open, as shown in the following figure:
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Figure 7-5. Open File on Robot, Advanced dialog

4. Select the map file you want to edit.

5. Click Open to load the map file into MobilePlanner.

Editing a Map File

After you create the initial map of your environment, you can use MobilePlanner to edit the
map. First, use the Eraser tool (Draw pane) to remove map features that are temporary or
moveable fixtures, such as chairs or forklifts.

Using the Drawing Tools

When editing your map file, you use the drawing tools to select and erase objects in the map,
add goals, docks, forbidden lines and areas, as well as advanced lines and areas. The drawing
tools are shown below.

NOTE: These drawing tools are inactive (grayed-out) if Show Robot is active.
The Cut icon is inactive until you select a map object.
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Figure 7-6. MobilePlanner Draw Tab

Selecting and Erasing Objects in the Map

Use the Select Button to select and highlight objects on the map. Press and hold the left mouse
button to move the object around the map window. Click the right mouse button to display a
pop-up menu that allows you to edit, duplicate, align, copy, or cut the object.

NOTE: If there are overlapping objects on the screen, you can right-click on the
overlapping map objects. A sub-menu lists all objects under the cursor so you
can select the desired object.

Use the Eraser Button to remove data points and lines from the map. Press and hold the left
mouse button to move the eraser over the data points or lines you want to remove. You can
adjust the size of the eraser by selecting the pull-down menu from the Eraser Button. Choose
an eraser size from 5 to 10,000 mm.

Cutting a Selection

Use the Cut icon (or Delete key) to remove any objects you have selected from the map.

Snapping Objects in Place

Use the Snap Button to force rotate objects (goals, docks, lines, and areas) at multiples of 45°
angles. Deselect this button to draw or rotate at any angle.

Draw Tab

You can use the Draw tab to add and edit map items (for details on map editing, refer to Edit-
ing a Map File on page 102).
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NOTE: The Draw tab is only active when the Show Robot Button is toggled
OFF.

The following table lists the toolbar icons and their functions.

Item Description

Select a feature (point, line, area, etc.) on the current map.

The status bar on the bottom left side of the window displays
information about the feature you selected, such as:

Remove points or lines from the active map. Does not remove
custom/landmark objects.

1. Click on the Eraser icon.
2. Use the pull down menu to select the eraser size from

5 mm to 10,000 mm.
3. Click and hold the left mouse button, while moving the

mouse over the points and lines you want to erase.

ClickGoal, then click on amap location to add a goal. In the
Edit Goal dialog box you can:

l label the goal
l provide a description
l select the type of goal (if available)
l adjust the X/Y position and heading. You can adjust the
heading after placement by holding the left mouse but-
ton down, and dragging around the goal. The heading
will follow the cursor.

ClickDocks, then click in the map at the new dock’s location.
In the Edit Dock dialog box you can:

l label the dock
l provide a description
l select the type of dock
l adjust the X/Y position and heading. You can adjust the
heading after placement by holding the left mouse but-
ton down, and dragging around the dock. The heading
will follow the cursor.
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AMRs will not cross forbidden lines, or enter forbidden areas. To
add a forbidden line or area:

1. Press and hold the left mouse button.
2. Drag the mouse to create the line or area and to adjust

the size.
3. Release the mouse button (the line or area remains

selected).
4. Press and hold the left mouse button.
5. Drag the selected line/area tomove its location on the

map.
6. For an area, click and hold on the heading arrowhead,

then drag to rotate the area.

Allows you tomeasure distances, display a measuring stick,
add Preferred or Resisted Lines, or a MapData Line to your
map.

Place lines and rectangles to the x/y axis (or 45° angles).
Deselect this button to draw or rotate at any angle.

To temporarily toggle this button while drawing a line or rotat-
ing a rectangle, press and hold the Ctrl key. Release the Ctrl
key after making the edit.

Places special areas on the map that the AMRs will avoid enter-
ing or crossing (e.g., door swing sectors, need to enter sectors,
resisted sectors, etc. To add an advanced area to the map:

1. Press and hold the left mouse button.
2. Drag the mouse to create and size the line or area.
3. Release the mouse button (the line or area remains

selected).
4. Press and hold the left mouse button.
5. Drag the selected line/area tomove its location on the

map.
6. For an area, click and hold on the heading arrowhead,

then drag to rotate the area.

Opens a submenu for adding a label to any advanced feature
on the map.

1. Click on Advanced Points, then select Label from the
submenu.

2. Click on a feature in the map you want to label, then
use the Edit Label dialog box to enter a label, provide a
description, and adjust the X/Y position and heading.

NOTE: The label box is a special text box
that does not scale when zoomed.
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Using Advanced Lines and Areas

Advanced lines and areas (in Config > Robot Operation > Map Features) control the AMR's
behavior. You can alter traffic flow, restrict the AMR from entering an area, and have the AMR
use a preferred route. For more information on creating these features and more, refer to Traffic
Management on page 228.

Advanced Lines

Advanced Line Definition

Measuring Stick Places a line on the map tomeasure distances in the map. You can
change the measurement units by selectingView > Units from the
main menu.

Preferred Line Places a line on the map representing part of a path that you prefer
the AMR use.

Resisted Boundary Places a boundary line that the AMR resists crossing. If there is no
other way around an obstacle, the AMRwill cross a resisted boundary
(though at a higher cost). For more information, refer to Cost-Based
Path Planning on page 231.

You can adjust the amount of line resistance. This is preferred, by an
AMR, over a restricted boundary.

Restricted Boundary Places a boundary line that the AMRwill avoid if possible.

Switchable Forbidden
Line

Places a boundary line that you can control with tasks or through
ARCL.

Advanced Areas

Advanced Area Definition

Door Places an area on the map for a door.

DoorSwingSector Places a sector on the map that corresponds to a door’s swing
arc.

Door Virtual Places a goal on the map for the AMR to drive to before entering a
door.

IgnoreLowLaser Enables a sector in which the AMR ignores low laser readings
(e.g., for driving up and down ramps, crossing the threshold gap
in an elevator, etc.).

IgnoreSonar Places an area on the map that will disable the sonar sensors.
This can be useful for crossing known thresholds, so the sonar
doesn’t prevent the AMR from driving over the threshold.

NOTE: If you have the low front laser,
IgnoreSensor does not apply.
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IgnoreTiltedLaser Instructs the AMR to ignore inputs from side-mounted lasers.

ManagedDestination Allows use of multiple goals as a single destination to determine
AMR occupancy of the sector.

ManagedMotion Limits the number of AMRs allowed to drive in an area (sector) at
the same time.

ManagedMotionOverride Makes contained AMRs appear to be driving. Used primarily in con-
stricted areas.

Movement Parameters Places an area on the mapwhere you can change movement
parameters, such as velocity, acceleration, and deceleration, in
real time.

Need to Enter Places an area on the map that the AMR can drive to only if it is
already in the area or a goal that it needs to drive to is in the
area.

PathPlanningSettings Places a sector that changes path planning settings.

PreferredDirectionLeft,
PreferredDirectionRight

Places an area on the map that directs the AMR to travel along
the right or left side of the path, unless there is an obstacle in the
way.

The AMR chooses the preferred side regardless of which way the
AMR is traveling. In other words, it follows the preferred side
whether it is traveling up the hallway or down the hallway.

PreferredDirectionRight
Single,
PreferredDirectionLeft
Single

Enable sectors that cause the AMR to prefer driving on the left or
right, in one direction only. Generally, the bi-directional Pre-
ferredDirectionRight/Left should be used instead. If two single dir-
ection sectors are placed next to each other, they must be
alignedwith care so AMRs do not collide.

Using a preferred direction single tells the AMR to travel along the
right (or left) side of the path unless there is an obstacle in the
way.

The AMR chooses the preferred direction in one direction only. In
other words, the AMRwill prefer to travel on the right (or left)
side only when it is traveling up the hallway.

SingleRobot Places an area on the map that only a single AMR can be in at any
one time.

SwitchableForbiddenArea Places an area on the map that can be controlled with tasks or
through ARCL.

TaskSector Places an area on the map that has a task list of what the AMR
will do immediately upon entering and exiting the sector.

VolumeAdjustment Places an area on the mapwhere the AMR's audio output can be
changed.
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Adding Forbidden Lines and Areas

You can place forbidden lines and areas on the map to prevent the AMR from crossing the
line or entering a specified area.

NOTE: Forcing the AMR to cross a forbidden line or enter a forbidden area is a
special circumstance discussed in Restricting Traffic on page 247.

1. With the map active, click the Draw tab, then click Forbidden Line or Forbidden Area.

2. Click on the map where you want to place the forbidden line or area. Be sure to add for-
bidden lines or areas around the AMR’s work space so it doesn’t try to navigate outside
of its space.

3. Hold the left mouse button, then drag the mouse to the location you want the line or
area to end.

4. Click the right mouse button to display a pop-up menu that allows you to edit, copy or
cut the forbidden line or area.

Creating and Adding Goals and Docks

Goals are virtual destinations that the AMR drives to in its environment. Docks are locations
to which the AMR drives to prepare to recharge. You need to add both of these features to the
map for the AMR to successfully navigate through the workspace.

You can quickly add a goal or dock to the map using the Item at Robot Button (robot tool bar),
which allows you to add the object at the AMR’s location. Once added, you can move goals
and docks around by clicking on them with the left mouse button, holding the button, and
dragging them to the desired location. You can also click on the heading line and drag it
around, or put it in the middle to turn the heading off.

Types of Goals

You can choose from different types of goals:

l Door Goal: Doors and virtual doors are spots at which the AMR positions itself before
entering or leaving a doorway (see Using a Door Goal on page 110). They appear green
on the map, and are only available if the Doors parameter is enabled (click Config >
Robot Operation > Map Features).

l Goal: This is the default goal. The X and Y positions are automatically entered based on
the location you selected on the map. Click on the check box to enable a heading and
enter a heading in degrees (you can also do this on the map by dragging the mouse
cursor - see Creating and Adding Goals and Docks on page 108.). The goal heading spe-
cifies the orientation of the AMR when it arrives at the goal.

l Standby: Standby goals serve three purposes, each designed to help keep the AMRs out
of the way of traffic and regions of interest (goals, tools, etc.):

o Buffering: waiting at a standby goal for another AMR to clear an occupied goal
or sector. Refer to Using Standby-Buffering Goals on page 112.

o Parking: allows available AMRs to drive to a waiting area for assignment to
another goal. Other parking goals include Preferred Parking goals (also known as
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‘park at pickup/dropoff’ goals). Refer to Using Standby-Parking Goals on page
111.

o Multi-Robot Standby (MRS): (also referred to as Taxi Line) allows (and enforces)
sequenced, orderly queuing of multiple AMRs from the same start (standby) pos-
ition to the same goal. For more information, refer to Traffic Control Concepts on
page 228.

To create a goal/dock:

1. With the map active, click on Draw tab > Goal or Draw tab > Dock.

2. Click the mouse on the map where you want to locate the goal/dock. Then, while hold-
ing the left mouse button, drag the mouse around the goal/dock to set its heading.

NOTE: Place a dock object where the AMR should go to "look at" the
dock, not where the dock actually is. The dock object should be 1 to 1.5
meters in front of the dock, pointed at the dock. See the following figure.

Figure 7-7. Dock as Imaged by AMR

Figure 7-8. Edit Goal Dialog Box Figure 7-9. Edit Dock Dialog Box

3. In the appropriate dialog box (Edit Goal or Edit Dock), enter the name of the goal/dock
you want to add to the map, for example "Receiving”.

4. Enter a description of this goal or dock (optional).
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5. Select the Type of goal or dock you are adding.

6. Enter the X and Y position to adjust the location.

7. Enter a heading value in degrees (required for docks, optional for goals).

8. Click OK to place the goal or dock on the map.

Using a Door Goal

The door goals appear as a green square on the map. They allow you to mark a spot for the
AMR to position itself before entering or after leaving a doorway. The following dialog box
appears when setting up a door goal.

Figure 7-10. MobilePlanner Edit Goal dialog

NOTE: Click on a parameter to see its description near the bottom of the dialog
box.

Door Groups

You can also add a door group, which creates the door items and their dependencies. Click on
Custom Groups > DefaultDoorWithGoals to add a door group.

A door group is a Custom Group consisting of Entrance Goal, Exit Goal, and the Door itself.

When creating a door group, specify a door output in the Parameters list. This is necessary to
ensure that the Door can properly receive the signal to open.
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Figure 7-11. Configuring a new Door GroupReer to

Refer to Setting Up Special Tasks on page 197 for more information.

Goals Using High Accuracy Positioning System (HAPS)

If your AMR has one or more optional HAPS sensors installed, you can create goals that
require the AMR to approach and position itself closely.

The most simple of these types of installations have a goal on the AMR's map, a length of
magnetic tape on the floor (the track), and one marker. The AMR's objective is to approach and
proceed down the track, and stop at the marker.

You can also install tracks with multiple locations at which the AMR stops. Each stop needs
one track, one marker, one goal per marker, and an Engage task for each goal. Refer to Engage
on page 179.

Standby Goals

Standby goals allow you to set up buffering when an AMR’s destination is already occupied
by another AMR. They also allow you to send AMRs to a parking area after completing a
queuing job.

NOTE: To use standby goals, you must enable them. Click the Config Button,
then click the Robot Operation tab, then clickMap Features (in the left pane),
then click the checkbox for the Standby parameter.

Using Standby-Parking Goals

NOTE: It’s best to place standby-parking goals in areas out of the way of traffic
and common AMR destinations. 

To place a Standby-Parking goal on your map, do the following:
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1. With the map active, click on the Draw tab, then click on the Goals drop-down list.

2. Select the Standby goal type.

3. Place the goal(s) on the map, then change the PrimaryPurpose parameter to Parking.

4. Use at least as many Parking goals as the anticipated number of waiting AMRs.

Using Standby-Buffering Goals

If an AMR is waiting for another AMR to clear a goal, it will use a Standby-buffer goal closest
to its destination. Best practice, then, is to place Standby-buffer goals near tools and areas of
interest, in locations that will not block AMRs leaving the goal.

To place a Standby-Buffering goal on your map, do the following:

1. With the map active, click on the Draw tab, then click on the Goals drop-down list.

2. Select the Standby goal type.

3. Place the goal(s) on the map, then change the PrimaryPurpose parameter to Buffering.

4. Use at least as many Buffering goals as the anticipated number of waiting AMRs.

Adding a Goal at the AMR’s Current Position

You can add a goal (generic, door goal, cart goal, or docking station) at the AMR’s current pos-
ition as follows:

1. With Show Robot active, click the drop-down arrow on the Item at Robot Button (Robot
Toolbar).

2. Select the type of goal you want to add.

If you select one of the default goals (e.g., docking station), information about that goal
is pre-populated in the dialog box.

3. If you selected a generic goal, fill in the name, description, and type, then click OK. For
a default goal, click OK.

Accessing the Docking Parameters

Docking parameters define the AMR's actions during the docking process. To access the Dock-
ing parameters, click the Config Button, click the Robot Operation tab, then click Docking.
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Figure 7-12. MobilePlanner Config - Robot Operations tab, Docking Parameters

NOTE: Docking parameters show in Docking and in Fleet Docking.

Advanced Lines and Areas

MobilePlanner has tools for adding special, or advanced, features to your map that perform
the following functions:

l Advanced Areas: these are areas in which you can add doors (and their swing sector),
control speed (Fast or Slow), direct the AMR to ignore laser or sonar inputs, limit the
number of AMRs operating in the space at one time (ManagedMotion), set the AMRs’
preferred travel direction, and direct the AMRs to enter (or resist entering).

l Advanced Lines: these include lines to measure distances on the map (measuring stick),
lines representing the AMR’s preferred path (preferred line), lines the AMR will resist
crossing unless there is no other way around an obstacle (resisted boundary), lines the
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(SwitchableForbiddenLine).

Adding an Advanced Area or Line

Advanced lines, points, and areas include features like closed doors, measuring sticks, switch-
able forbidden lines or areas, one-ways, and many more. You must enable some of these fea-
tures under the Config Button, Robot Operations tab, Map features (likewise, you can also
disable those that you do not want to use). See Restricting Traffic on page 247.

1. With the map active, click the Draw tab, click the drop-down menu triangle for either
Advanced Lines or Advanced Areas, to display the available types, then select the type
you want to add.

2. Click on the map where you want to start placing the line or area and, while holding
the left mouse button down, drag the mouse to where you want the line or area to end.

3. If an Edit Advanced Line/Area dialog box appears, enter the needed information, then
click OK.

4. Click the right mouse button to display a pop-up menu that allows you to edit, copy
and cut the forbidden line or area.

Inserting a Map File into an
Existing Map File

The Insert Map feature is helpful if there have been small or medium changes to the AMR's
environment. You do not need to rescan the entire workspace and recreate the map file. To use
the Insert Map feature, you can scan the area of the environment that has changed, turn that
into a map, and insert it into an existing map.

In certain situations, you might want to insert only a subset of the region's data into the ori-
ginal map. For more information, refer to Using the Advanced Insert Option on page 117.

Select a Map File

In MobilePlanner, select a map to insert into an existing map.

l Select File > Insert Map from the main menu. A dialog box appears, which lets you
search for and select a local map file to open.

The new map appears in the active map as a blue rectangle, and the Insert Map toolbar allows
you to manipulate the inserted map.
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Figure 7-13. MobilePlanner, Insert Map Tools

Use the Insert Map Tools to position the inserted map into the existing map. After selecting a
map section to insert, the Insert Map Tools toolbar automatically displays.

Figure 7-14. Insert Map Toolbar

The following table describes the buttons on the Insert Map Tools toolbar.
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Insert Map Tool-
bar Button Description

Insert Works on intrinsic map data (points, lines, lights, etc.), and inserts
the new map into the existingmap at the blue rectangle. The
Advanced insert lets you choose a subset of the new map’s data,
andmake other adjustments like inserting user-createdmap items
(e.g., goals, docks, sectors, etc.). Refer to Using the Advanced
Insert Option on page 117 for details.

Cancel Cancels the insertion.

Region Defines the region to insert (useful if the default insert region is too
big), or to have the newly inserted area properly overlap the old
area. Refer to Define the Insert Region on page 116.

Reset Erases all rectangles and restarts the region definition.

Lock Locks the insertedmap at its current position in the map. This can
prevent accidental changes when panning and zooming the map.
Turn off the button to enable more changes.

90° Left/90° Right Rotates the insertedmap 90° left or right. Use the Degrees field to
set degrees of rotation (as measured from the x-axis in the
counter-clockwise direction).

Up/Down/Left/Right Moves the insertedmap up, down, left or right. Allows small adjust-
ments to the insertedmap's position.

Help Opens help information on the insertion process.

Position the Inserted Map

You can adjust the inserted map's location and orientation to position it correctly in the exist-
ing map as follows:

1. Hold down the left mouse button and drag the inserted map like any other object.

2. Use the Insert Map Tools’ Up, Down, Left, and Right Buttons to make small adjust-
ments to the insert's position.

Adjustment size depends on the map's zoom. To make a very small adjustment, zoom in;
zoom out for a larger adjustment.

Define the Insert Region

The shaded blue rectangle is where the inserted map will replace a portion of the existing
map. By default, all black data points on the blue background will be deleted (unless doing an
Advanced Insert with ‘retain overlapping,’ in which they will remain).

If the default insert region is too big, click the Insert Map Tools' Region Button to define a new
one. The default region clears (and becomes gray) and the insert locks at its current position.
Use the mouse to draw a set of blue rectangles over the exact area to be replaced.

You should define the insert region after moving the map insert to the correct location.

You can use Edit /Undo and Redo from the MobilePlanner main toolbar while defining the
insert region (Undo deletes the last added rectangle). To erase all rectangles and restart the
whole process, press the Insert Map Tools' Reset Button.
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Complete the Insertion

After correctly positioning the map insert and defining the insert region, click Insert to finish
the insertion. It might take a few seconds for the original map to update. The process is com-
plete when the shaded blue area disappears and the Map Insert toolbar closes.

If the resulting map is not correct, then press Edit / Undo from the MobilePlanner main toolbar
to restore the map to its original state (which might take a few seconds).

NOTE: The insertion process is not automatically resumed; you must restart it.

Using the Advanced Insert Option

Occasionally, you might want to insert only a subset of the region's data into the existing map.

To Use Advanced Options:

1. In the Insert Map toolbar, left-click on the Insert Button.

2. In the pulldown menu, select Advanced.

Figure 7-15. MobilePlanner, Advanced Insert Options Dialog

The dialog box has check boxes for each data type in the inserted map. To display non-
data types, click the Include user-created map items... checkbox (shown un-checked in
the image above).

3. Click the checkbox for each data type that you want to insert. Note that any cor-
responding map items are displayed in blue.

4. To retain the original map data as well as the inserted data, check the Retain over-
lapping items . . . checkbox.

5. Click the Insert Button to complete the insertion and close the dialog box.
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Saving the Map on the AMR

The scan file that came from your AMR is saved on your local PC until you explicitly save it
elsewhere.

To save the map on the AMR, from the MobilePlanner menu, select:

File > Save on Robot

Select the .map file that you just edited, and click Save to save the map onto your AMR.

7.7 After the Map
If you need to adjust the scan settings, see the next section. Otherwise, you need to localize the
AMR. Refer to Set the AMR's Initial Location on page 121.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 118



119 Fleet Operations Workspace Core User's Manual 20569-020 Rev. E

7.7  After the Map

Changing the Scan Settings

To adjust the processing, scan, clean, and map settings, click Settings from the Scan Pro-
cessing Tools toolbar.

Figure 7-16. Scan Processing Tools Toolbar

Button Description

Start Initiates the scan session.

Pause Temporarily pauses the scan session.

Rewind Rewinds the AMR’s path (blue trail) through the scanned area as shown on the
MobilePlanner map.

Step Allows you to step through the AMR’s path, one segment at a time.

Finish Completes the scan conversion process.

Save As Allows you to save the newly createdmapwith a specific name and location.

Clean Allows you tomanually remove unwanted scan points from the map.

Reset Undoes any cleaning work you have done on the map.

Settings Allows you to change scan tool configurations.

Auto Fit Scales the scan file image to the MobilePlanner mapwindow as you addmore
information.

Track Centers the AMR in the scan image - works similarly to ‘center on robot’ in a nor-
mal map.

Help Opens a help file to search for specific help topics.
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The Scan Settings dialog box appears as shown below.

Figure 7-17. MobilePlanner Scan Settings Dialog

The following table describes the settings available from the Scan Settings dialog box.

Processing Settings Description

Start scan when file opened Disable this option to prevent the scan conversion pro-
cess from automatically starting when you open the
scan file in MobilePlanner. Allows you to adjust the scan
settings before conversion. To start the process, click
on the Start Button from the Scan Tools toolbar.

Clean after scans registered Disable this option to leave all scan points in the map.
Any cleaningmust be done manually by pressing the
Clean Button.

Prompt to save after scan complete If this option is disabled, then the Save Map File As win-
dow is not automatically displayed.

Run in batch mode Enable this option to process multiple scan files at the
same time.

NOTE: The files must all be of the same
type. For example, they all must be basic
scan files or all must be light localization
scan files, they cannot be a combination
of the two.

<filename>.map, overwriting any
existing files

Select this option to overwrite the file name in batch
mode.
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<filename>_<cur-
rentDateTime>.map, less risk of
overwrite

Select this option to have the current date and time
added to the filename with each new scan conversion
processed in batch mode.

Scan Settings Description

Maximum Range Specifies the maximum distance, in mm, used for the
laser data.

Linear Error The forward/reverse error, expressed as the average
variation (in mm) per meter of travel.

Lateral Error The left/right error, expressed as the average variation
(in mm) per meter of travel.

Use Loop Closing Used for open areas - indicates that the AMR has
returned to a known location. Minimum Loop Prob-
ability allows you to set how closely the current position
must match a previous scan. Default is 80%.

Use Gyro Error Model Specifies allowable errors to correct for when regis-
tering laser scans collected duringmapping.

Scan MatchingMode Choose between Normal or Fast matching. If you select
Fast, the scan match is performed only when
MobilePlanner is in the registration phase.

Clean Settings Description

Grid Size Sets the size (in mm) of grid cells used to check
whether the reading represents a real map point. A
small value gives more cleaned readings; a large value
includes more points in the map.

Max Range Sets the maximum distance (in mm) from the AMR in
which readings are considered for inclusion in the map.
This value only affects the cleaning process; it does not
affect the range used during the registration phase.

Map Settings Description

Resolution This adjusts the resolution of the map created from the
scan file.

Set the AMR's Initial Location

It is important to establish the AMR’s starting location, which is also known as localizing
your AMR. When you "localize to a point" on the map, you provide the AMR with location
data. This data allows the AMR to match its current location with the same location on the
map.

As the AMR attempts to find its location on the map, it provides a localization score, or con-
fidence level. This confidence level should be 80% or better for the AMR to navigate properly.

For more detailed information on localization, refer to AMR Localization on page 260.
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To Set the AMR's Starting Location:

1. Click theMap Button, then click Show Robot.

The Map tool bar displays AMR control icons.

2. Click Localize Robot.

This puts the map into localize-to-point mode (and changes the cursor to indicate the
new mode). Refer to Robot and Map Toolbars on page 74.

3. Click and hold on a spot on the map where you want the AMR located. This is where
you want the confidence threshold, or Localization Score, to be 80% or better as shown
below.

While still holding the mouse button down, drag the localization mark's direction indic-
ator to the direction the AMR is facing. The AMR will choose the most likely pose near
the clicked location. If the initial localization does not look correct, localize the AMR
again until it appears in the correct location.

Figure 7-18. Localize to Point Dialog Box

4. Click Done when the AMR's localization score is where you want it to be.

The AMR is now localized and you have successfully set the AMR's current position.

NOTE: You must set the AMR’s current position the first time you put
the AMR in a different map.

What’s Next?

Now that your AMR is configured, you have scanned its operating space and created a
detailed map, you can do any of the following:

l To edit your map further, refer to Working with Map Files on page 99.
l To learn about and start using MobilePlanner software, refer to Using MobilePlan-
ner Software on page 52.
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l To configure your AMR, refer to Configuring the AMR on page 154.
l If you are familiar with MobilePlanner and want to set up goals and tasks for
your AMR to perform, refer to Working with Macros, Tasks, and the Route
Builder on page 172

After Driving the AMR

After you're done driving the AMR, select Robot > Dock from the software main menu, or
click Dock, to return the AMR to a dock.

Auto Dock

The Config > Robot Operation > Docking > Autodock parameter is the primary control for the
AMR's automatic docking, and is normally set to True.

If the Autodock parameter is set to False, and you don't want to manually dock the AMR each
time, using the Auto Dock menu item (Main Menu > Robot > Robot Tools > Auto Dock) will
override the configuration parameter. The AMR will return to a dock when the charge is run-
ning low.

NOTE: If the Autodock parameter is set to True, you can override that behavior
by turning off automatic docking. If you do this, remember to turn it back on
when you are done, or the AMR will not recharge and eventually stop running.

LD Docking

This section provides instruction on how to use the LD Dock Type. The LD DockType (com-
pared to the current Lynx type) uses part of PrecisionDrive on the back end. As a result of this,
many of the settings and parameters will feel the same. However, all specifications that apply
to PrecisionDrive (as noted in the Application Notes and PrecisionGuide user's guide) also
apply when using the LD Dock Type. All the existing dock pre-goals (the yellow docking
goals) can be used as is from a regular map (see note about updating the offsets under step 3).
If any problems occur, you can re-set the system to the legacy type by following these steps
and switching it back to Lynx.

Follow these steps to set up docking for LD-series AMR series:
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1. Switch the DockType to LD as shown in the following figure.

Figure 7-19. Switching to LD

2. Since the new docking parameters are not part of the defaultConfig, they must be
entered exactly as displayed in the following figure. The only exception is the Dock-
InitialX; -1500 is what OMRON has conducted all of its testing at, but making this
slightly shorter (-1200) will not have significant impacts on the performance. In either
case, the distance from the dock pregoal and the center of the dock triangle vertex needs
to be within the tolerance.
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Figure 7-20. DockInitialX
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SetNetGo runs on both the AMRs and an EM2100 operating as a Fleet Manager. It sets the con-
figurations for certain onboard systems, such as wireless communication settings.

You can access SetNetGo either from the MobilePlanner SetNetGo interface, or directly on the
AMR using a secure web-based server. If needed, your organization’s IT group can configure
your wireless Ethernet for you.

8.1 Overview of the SetNetGo OS
The SetNetGo software allows you to configure certain on-board systems, such as the Ethernet
interface settings, serial and TCP port-forwarding, and to perform systems diagnostics, such as
examining and retrieving log files.

Connecting to SetNetGo

Access SetNetGo from MobilePlanner

The recommended way to connect to the SetNetGo OS is through the SetNetGo interface in the
MobilePlanner software.

During normal operation, you access SetNetGo through the MobilePlanner software as follows:

1. Start the MobilePlanner software on your PC.

2. Enter the IP address for an AMR or your Fleet Manager, then click Connect.

3. Click anywhere in the SetNetGo selection box, to access the SetNetGo interface.
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Figure 8-1. Hover Over the SetNetGo Selection Box

Hover over the selection box to reveal its boundaries. (See the the preceding figure.)

Additional Information: You can make changes to the SetNetGo parameters
both at the robot level, and fleet level.

Figure 8-2. SetNetGo Interface—Status Tab, Home Screen

This is the SetNetGo home screen. It provides an overview of link status, IP addresses, and
installed software versions.

Connecting to SetNetGo via web browser

You can also access the SetNetGo software via a web browser (such as Chrome, Firefox or Inter-
net Explorer) if, for example, your IT department is helping with network configurations, or
you don’t have access to your laptop with MobilePlanner installed on it.

NOTE: Web browser access must be enabled in SetNetGo > Security tab >
SetNetGo Access. To do this, connect one end of an Ethernet cable to your com-
puter and the other end directly to the AMR’s Ethernet Maintenance port.

If you have an LD-series AMR, set your IP address to 1.2.3.5 with a
subnet mask of 255.255.255.0 and connect to SetNetGo Maintenance
port at the URL: https://1.2.3.4.

If you have an HD-series AMR, set the adapter to automatically
obtain an IP using DHCP and connect to SetNetGo Maintenance
port at the URL: https://169.254.10.15.
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Figure 8-3. Browser URL Address

NOTE: You can ignore the SetNetGo certificate error. Click "Continue to this
website (not recommended)." to display SetNetGo.

Figure 8-4. Browser Certificate Warning

IMPORTANT: SetNetGo versions prior to 5.x use TLS version 1.x security pro-
tocols. If using this SetNetGo version, browsers may encounter a security warn-
ing message. In this situation, either update SetNetGo or use a browser that
supports TLS version 1 security protocols.

8.2 Using the SetNetGo Interface
SetNetGo resides on the AMR and any EM2100 operating as a Fleet Manager or Fleet Sim-
ulator, and is accessible through the SetNetGo interface in MobilePlanner.

The Fleet Simulator cannot be accessed through MobilePlanner - you have to access SetNetGo
through a web interface instead.

The SetNetGo start-up screen, accessed from MobilePlanner, is shown below.

NOTE: The Download debug info Button provides a debug file that can be used
for troubleshooting and other support requests.
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Figure 8-5. SetNetGo Interface

The SetNetGo menu, shown at the top of the screen, consists of the following tabs:

Menu Option Sub-Menu Option Description

Status This menu option displays various logs and status updates. Refer to Viewing
the Status Logs on page 133 for details.

Home Returns you to the SetNetGo home screen.

ARAM (AMR) or
ARAMCentral
(Fleet Manager) Log

Gives the option to display the entire ARAMCentral
log, the last 200 lines, or continuous refresh dis-
playing the last 200 lines of the ARAM logwithin
SetNetGo. It also allows you to view the current log
file or download of the last 7 log files.

Network Displays the current status of network interface, the
wireless interfaces status and the routing table.

SetNetGo Log Displays the SetNetGo log file.

SetNetGo
Resources

Displays status of your resources, including pro-
cesses currently running on the AMR or Fleet Man-
ager, Kernel Log, Disk Usage, Memory Usage, the
Interrupts table, IOMemory usage and IO Port usage
tables, and USB Devices.

Debug Info Downloads a .zip file containing detailed information
on system status for troubleshooting.

NOTE: Download a debug file before
requesting support.
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Simulator This option gives access to the Fleet Simulator option. This is covered in
detail in the Fleet Simulator User's Manual (Cat. No. I649). This option will
not be displayed if the Fleet Simulator license is not detected on the
EM2100 or if SetNetGo was accessed from MobilePlanner. SetNetGo cannot
be accessed through MobilePlanner in Fleet Simulator mode.

Network Configurations for setting up your network. See Network Tab on page 133
for details.

AMR Only

Wireless Ethernet These parameters allow you to enter static or
dynamic IP settings (IP Assignment and Address, Net-
mask, Gateway, and DNS1); select a WiFi network;
configure security settings (i.e., encryption and
authentication); and configure Radio settings, includ-
ingWatchdog Timer.

User LAN Ethernet This screen has settings for interface mode, IP
Address, Netmask, DHCP Server for Accessories, and
DHCP IP Range. If you are using an EM2100 or a net-
work-based hardware accessory for an AMR, you
must set up a wired Ethernet port. Use Accessory
mode (default) for individual AMRs, and server mode
with an EM2100.

RS-232 Port For-
warding

Forwards a custom TCP port on the wireless Ethernet
interface to an RS-232 port on the AMR’s core. The
TCP port and serial port settings are configurable.

Ethernet For-
warding

Supports forwarding a custom TCP port on the wire-
less Ethernet interface to a custom TCP port on an
IP address of a device connected to the User LAN
interface. The TCP port numbers and IP address are
user-configurable.

Fleet Manager Only

Management Inter-
face

This page allows configuration of the Management
(MGMT) Ethernet interface with a static IP address.
The network host configured as the "Management
Interface" is the primary host for web configuration
via a browser.

Fleet Interface This page allows configuration of the Fleet Ethernet
interface with a static IP address. The network host
configured as the "Fleet Interface" is the primary
host for all Fleet Management connections, including
use of MobilePlanner to connect with a Fleet.

AMR and Fleet Manager

Utilities On an AMR, use this tab to ping a specific IP address,
initiate trace route (display packet path), and display
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the ARP table (correlate MAC address and cor-
responding IP address).

On a Fleet Manager, this page permits running sev-
eral network diagnostic tools on the AMR or appli-
ance, including well known tools `ping`, `arp`, and
`traceroute`.

Software Configurations for ARAM/ARAMCentral settings (including install new soft-
ware versions)

ARAM Settings or
ARAMCentral Set-
tings

Change advanced settings for recovery, such as
reverting the configuration back to defaults.

Manage Installed
Software

This tab displays current versions of installed soft-
ware, with options to view release notes, restart,
uninstall, or disable application(s), and view runtime
logs. Also allows you to downloadMobilePlanner, and
update the mobile software.

Licensing Configurations of existing licensing and upload/download of information for
license activation and updates.

Information This page displays license information, including
name of the license, current status and expiration
date, for any license relative to that specific device,
either Fleet Manager or AMR.

Upload This page allows upload and provisioning of new
licenses or license updates, which are provided by
your local OMRON representative.

Download This page allows download of license information files
for this device. This information must be downloaded
and supplied to your local OMRON representative
when inquiring about license updates.
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Security Manage Fleet user accounts and AMR access.

Fleet or ARAM
Accounts

This page allows you tomanage access controls that
restrict who can access the AMRs and Fleet Manager
with MobilePlanner. Allows you to specify specific
access controls for admin, operator, and viewer
access, and other users. You can also add new users
to the access list. AMR only.

This page allows configuration of Fleet Accounts,
including usernames, passwords, and permissions.
Fleet Accounts are primarily for user privilege sep-
aration andmust be providedwhen connecting to a
Fleet Manager or AMR through MobilePlanner. Fleet
Manager only.

SetNetGo Access Allows you to enable or disable Web availability via
Wireless/User LAN interface, and set access pass-
word.

Integration Toolkit This page allows generation and regeneration of the
password required for all Integration Toolkit-provided
services. This passwordmust be configured in order
to access fleet data through the Integration Toolkit-
provided services, which include SQL via postgres,
AMQP via rabbitmq, and a REST API via HTTPS.

System Manage date/time, upload new SetNetGo OS, conduct backup and restore
operations.

Date/Time Set time, zone, and NTP Server.

NOTE: The AMRs will automatically
synchronize with a Fleet Manager. Use
NTP on the Fleet Manager or for single
AMR operations.

Upload SetNetGo
OS

Upload and install a new SetNetGo version.

NOTE: The system can store two dif-
ferent OS images. You can select which
version to load into each slot, and
choose which is the bootable image.

Backup/Restore
Options (AMR only)

Allows you to configure restore settings (from the
same, or a different AMR), set a new backup restore
point, or revert to a different restore point.

Reboot Allows you to reboot the AMR's computer (core) or
EM2100 appliance. Normally not a visible option
unless enabled by checking the Remote Reboot radio
button in SetNetGo > Security > SetNetGo
Access.
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!
CAUTION: Rebooting the AMR's core
interrupts all AMR operations, and
could cause damage to the AMR.
Rebooting the appliance will disrupt all
jobs and AMRs.

Mode (EM2100
only)

This page allows configuration of the appliance oper-
atingmode. The mode determines if the appliance
will run as a Standalone Fleet Manager, a Paired Fleet
Manager, or a Fleet Simulator.

8.3 Viewing the Status Logs
SetNetGo keeps track of various AMR activities, including ARAM, networking, and resource
use. This information is stored in status logs that you can view through SetNetGo.

To view the status logs:

1. Connect to SetNetGo through the MobilePlanner SetNetGo interface.

2. Select the Status link at the top of the SetNetGo screen.

The SetNetGo Status screen appears as shown in SetNetGo Interface on page 129.

NOTE: The Download debug info Button is critical for taking a backup
of the current configuration, and providing this information when request-
ing support.

The status logs you can view depend on whether you are connected to SetNetGo through a
Fleet Manager or a single AMR. Generally you can view the following type of status logs:

l ARAM (on the AMR), ARAMCentral (on the Fleet Manager)
l Network
l SetNetGo Log
l SetNetGo Resources
l Debug Info

8.4 Network Tab
Use SetNetGo to configure the AMR's network settings. For remote access to your AMR, you
should set up a static IP address. If you are not familiar with setting up a network or do not
have an assigned IP address for the AMR, please refer to your system administrator.

NOTE: After changing a value in any SetNetGo screen, you must click Apply
before switching to another sub-screen, or those values will not be saved.

To configure your AMR's network settings:
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1. From the MobilePlanner SetNetGo interface, connect to SetNetGo.

2. Select the Network link from the top of the SetNetGo screen.

The SetNetGo Network screen appears as shown in the following figure.

Figure 8-6. SetNetGo Interface - Network Tab

Wireless Ethernet Settings

Select Network > Wireless Ethernet to set up the wireless Ethernet interface. The table below
describes the parameters that you can modify.

Wireless Ethernet Menu

Parameter Setting Definition

IP Assignment Select the Static radio button to set a known IP address. You
can also use DHCP, but a static IP address is recommended.

IP Address Enter the IP address assigned to the AMR you want to access.

Netmask Enter the Netmask.

Gateway Enter the Gateway address.

DNS1 Enter the DNS1 address or leave it as 0.0.0.0 to disable.

WiFi Network Settings

Selected Network Displays the wireless network to which you are currently con-
nected.
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NOTE: Clicking on a network name in the list
will automatically populate the encryption and
authentication fields.

Network list Displays a list of available WiFi networks.

Security Settings

NOTE: The fields listed below will change based on the security method you
select, and could include username, password, private key (download or cre-
ate new)/key length, hostname, and certificate (choose an existing or upload
new). If unsure about settings, ask your IT department for assistance.

Encryption Set this to match the encryption method that is used on your
network. Options are 64-bit or 128-bit WEP, TKIP/RC4,
CCMP/AES, and TKIP/CCMP/AES.

Authentication Set to match your authentication type. Use OPEN (default)
when using no authentication or when usingWEP. Select WPA-
PSK for WPA Pre-shared key, PEAP-MSCHAPv2, or EAP-TLS.

Pre-Shared Key (PSK) If usingWPA/WPA2-PSK, enter the shared key in this field.

Key Type Select from (click the radio button) Passphrase (8-63 ASCII
only), or Raw Hex (64 Hex only).

Radio Settings

Radio Mode Select the mode that your network uses: 802.11a, 802.11b,
802.11g, 802.11n, or 802.11ac. Select Auto to allow the AMR
to choose the most suitable channel from 802.11a/b/g (may
lead to longer roam times).

Channel Set Set to match the channels that are used at your site or leave
them all selected (default) to allow the AMR to find the most
suitable channel. Roam times will be faster if there are fewer
channels selected.

802.11b/g Channels (2.4
GHz)

Use this list to select a specific WiFi channel (1 through 13) in
the 2.4 GHz range

802.11a Channels (5 GHz) Use this list to select a specific WiFi channel (36 through 165) in
the 5 GHz range

Wireless Log Level Determines the level of WiFi scanning detail in log files and
debug info. Default is Normal. Set toVerbose for debugging
efforts. If set to Verbose, log files cover a much shorter period of
time. Recommend leaving at Normal.

RSSI Roam Threshold Determines the frequency of background scanning. Default is
50. If signal strength is higher than the threshold, scanning
happens at 10X the Background Scan Interval. If signal
strength is below the threshold, scanning occurs every Back-
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ground Scan Interval seconds.

Background Scan Interval
(sec)

Works with the RSSI Roam Threshold to determine how fre-
quently the AMR performs background scanning. Default is 3
seconds (recommend leaving at default)

Watchdog If enabled, automatically pings the Fleet Manager (if used) or
the gateway IP address. If successive pings fail for Watchdog
Timer seconds, the AMR automatically resets the wireless inter-
face.

Watchdog Timer (sec) If pings to the Fleet Manager fail consecutively for Watchdog
Timer seconds, the wireless Ethernet interface automatically
resets and attempts to reestablish communications.

User LAN Ethernet Settings

User LAN Ethernet Settings

Parameter Setting Definition

Interface Mode Use to set up a wired accessory interface (e.g., Acuity or the
touchscreen) for the AMR. This mode allows you to connect net-
work-based, hardware accessories to the jack. Onboard
accessories will be able to communicate with the software run-
ning on the AMR’s core, and reach the rest of the network via
the AMR’s wireless interface.

IP Address Set the IP address for this interface. Select a subnet that does
not conflict with settings on the wireless Ethernet interface.

Netmask Enter the Netmask.

DHCP Server for
Accessories

Disable or enable (default) a DHCP server for an accessory on
the AMR.

NOTE: You must enable this parameter for both
Acuity and the touchscreen (for more information
on these options, see theMobile Robots - LD Plat-
form Peripherals Guide (Cat. No. I613)).

DHCP IP Range Allows you to set the DHCP IP range for the address auto-
matically assigned to the accessories.

Port Forwarding

If your AMR’s payload has devices connected to the User LAN or Serial (RS-232) port, you can
forward those ports and make the payload’s device accessible via WiFi. Configure both RS-232
and Ethernet port forwarding in SetNetGo in the Network tab.

RS-232 Port Forwarding:

Controls forwarding serial data to a TCP port on the wireless and internal wired Ethernet net-
works. You can link an internal serial device and route it to an external port at a defined baud
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rate. This is useful for RS-232 devices connected to the AMR’s core, and accessing them over
WiFi.

Ethernet Forwarding:

These settings forward a TCP port on the User LAN Ethernet interface to a port on the Wireless
Ethernet interface. The Internal IP Address is the IP address of the device connected to the
AMR core’s User LAN connection. Internal and External port setting route the Ethernet con-
nection through WiFi.

Utilities

These tools allow you to view the ARP table, and ping or run a trace route to a specific IP
address.

8.5 Software Tab
The SetNetGo software tab offers choices for ARAM Settings and Manage Installed Software.

ARAMCentral/ARAM

Figure 8-7. SetNetGo, Software Tab - ARAM Settings

l ARAMCentral Settings (main software on the EM2100) - configure ARAMCentral’s fea-
tures (disabling ASync logging, disabling ARCL, and disaster recovery settings.

l ARAM Settings (main software on the AMR) - configure ARAM’s features (disaster
recovery settings).

Manage Installed Software

The settings in this section allow you to view current versions and status (for example,
Enabled Running, or Disabled Not Running) of software installed on the EM2100 appliance or
AMR.



Chapter 8: Using the SetNetGo Software

NOTE: The software version needs to match across the fleet. Also, make sure
that you upload the SNG, and FLOW packages together when new versions
released.

Figure 8-8. SetNetGo, Software Tab - Manage Installed Software

You can also use the functions on this tab to restart, disable, install and/or uninstall
MobilePlanner software, or the MARC or Polo microcontroller firmware.

8.6 Licensing Tab
The SetNetGo licensing tab allows you to get information, including license name, status, and
expiration date of any license that applies to the device you are currently connected to. It also
allows you to acquire, renew or upgrade any licenses from the field on either a Fleet Manager
or an AMR. Follow these steps in the given order to do so:

1. Go to the SetNetGo web interface of the Fleet Manager appliance or the AMR and open
the Licensing tab. Click on the Download option in the left pane.

2. On the download page, click the Download Button.
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Figure 8-9. Licensing Download Screen

The downloaded C2V file will have the format:

1234567890-MMM-DD-YYYY.C2V

where MMM represents the first three letters of the current month, DD the day of the month,
and YYYY the current year.

NOTE: OMRON recommends that you establish a specific location and folder
in which to store these license key files, in the event that they need to be accessed
in the future. We also recommend that the C2V ID number (the first ten digits in
the C2V file name) be referenced to its particular EM2100 or AMR to ensure that
the matching license key file can be quickly identified and uploaded to that
EM2100 or AMR.

3. Send the C2V file to your local OMRON representative or integration partner and
request the appropriate license for the Fleet Manager mode or for the AMR Advanced
Feature that you have selected. You will receive a V2C file with an ID and Date that
matches the C2V file that you submitted.

4. Confirm the file names match before proceeding. If the filenames do not match, then con-
tact your local OMRON representative or integration partner and report the issue.

5. Go to the SetNetGo web interface of the Fleet Manager or AMR. Select the Licensing tab
and choose the Upload option from the left pane.
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6. Click Choose File and select the appropriate V2C file.

7. Once the file is chosen, the SetNetGo Web UI shows the specific filename. Click Upload
File.

Figure 8-10. Licensing, Choosing a File to Upload

Now that a valid license is activated, SetNetGo will initiate the requested mode by starting the
appropriate code on your Fleet Manager or AMR.

NOTE: After a C2V file has been submitted to obtain a license, it cannot be
reused. If you need another license you have to generate a new C2V file for the
request. Likewise, a V2C file can not be reused with SetNetGo, either.

8.7 Uploading, Backing up, and Restoring SetNetGo
Through MobilePlanner, you can upload (upgrade to) a new version of SetNetGo by simply
choosing the proper file.

Your upload options allow you to choose whether to upload a new version of SetNetGo into
the Boot Image A slot (which is the default image slot), or the Boot Image B slot (which you
then have to make bootable), or have versions in both slots.
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In case of a software failure, you can also restore SetNetGo from a file maintained on the same
(or a different) AMR. You can only restore to a specific restore point on an AMR (identified by
its date/time), but only from the last restore point, and only on that AMR.

8.8 Uploading a New SetNetGo OS
1. In the MobilePlanner tool bar, click the SetNetGo Button, then click the System tab,
then click the Upload SetNetGo OS menu item (left-side pane).

Figure 8-11. SetNetGo, System Tab

The Upload New SetNetGo OS page, Current Versions field, contains information about
the current installed version (with option to view its release notes), and which image is
the current bootable image (Image A in the example above).

2. To install a new SetNetGo version into the Boot Image A slot, click the Choose File But-
ton, and browse to the location of the new image file. To upload a file, click the Upload
File Button.

NOTE: Clicking the Upload File Button will upload a new SetNetGo pack-
age, which will overwrite the existing image in the Boot Image A slot, and
ask you to confirm before proceeding.

3. Click Open when done.

4. To install a new image file into the Boot Image B slot (and make it bootable), click the
Choose File Button then, when you’ve chosen the file, click theMake Bootable Button.

8.9 Backing Up and Restoring SetNetGo
As with any system, it’s a good idea to back up your system files frequently, especially after
making configuration changes. After backing up, you then have a file from which you can
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restore your system back to working condition if a version becomes corrupted, if you swap
AMR cores, or add a new AMR to your fleet that’s identical to the others.

Creating a Restore Point

When you back up your system, the resulting file is date and time stamped with the current
day and time of backup, and becomes a specific restore point (overwriting the your previously
saved restore point).

1. In SetNetGo, click the System tab, then click the Backup/Restore Options item.

2. In the Restore-Point field, click the Backup now Button.

The following advisory dialog appears.

Figure 8-12. SetNetGo Create Restore Point Dialog

3. Read the confirmation then, if sure you want to proceed, click OK.

Reverting to a Restore Point

Reverting to a previously saved backup (restore point) takes your AMR’s core back to its con-
figuration as of the date and time of the restore point file you select. During the restore, you
will lose your connection to MobilePlanner while the restore process resets your con-
figurations.

Additional Information: Files stored on the AMR (such as maps) are inde-
pendent, and will not be affected by the revert process.

1. In SetNetGo, click the System tab, then click the Backup/Restore Options item then,
under the Restore-Point heading, click the Restore Now Button.
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The following advisory dialog appears:

Figure 8-13. SetNetGo Confirm Restore Dialog

2. Read the confirmation then, if you are sure that you want to proceed, click OK.

The selected file overwrites the previous settings in the AMR’s core, and the AMR dis-
connects from MobilePlanner. After the restore is complete, you can reconnect to the
AMR.

Restoring Settings from DebugInfo File

If you replace an AMR’s core, and want to update the new core with all of the existing con-
figuration information from that AMR onto the new core, use the Restore from same robot
option. This process does not overwrite other software on the core. You should verify those soft-
ware versions.

NOTE: The Restore from same robot option does not include WiFi credentials
(i.e., key, passphrase, certificates) or overwrite currently existing versions of other
software (you should determine which versions to use).

If you have a fleet of one type of AMR and are adding another AMR of that type to your fleet,
you would use the Restore from different robot option. This feature gives a quick method of
configuring the new AMR so it performs identically to the others.

NOTE: The Restore from different robot option does not change IP address or
AMR calibration data (including AMR identifier). After using this option, you
will need to re-set your AMR’s WiFi, IP address, and identifier.

1. In SetNetGo, click the System tab, then click Backup/Restore Options from the list on
the left.

2. Under the Restore Settings from DebugInfo File heading, click Choose File for either the
Restore from same robot option or the Restore from different robot option (see explan-
ations above for example use cases).

3. In the Open window, browse to and select the file you want to upload, then click Open.

4. Verify that the correct file name appears next to the Choose File Button, then click the
Upload Button.



Chapter 8: Using the SetNetGo Software

An advisory dialog will be displayed, asking for your confirmation.

5. Read the confirmation and, if you are sure that you want to proceed, click OK.

NOTE: Both of these processes creates a new restore point.

8.10 SetNetGo Recovery Mode
In the event that a specific AMR unit experiences a serious software malfunction that normal
solutions do not resolve, Recovery Mode can be used to revert the system back to a stable and
working state.

There are 5 Maintenance Options while in Recovery Mode.

Figure 8-14. Maintenance Options

Each option will reset different combinations of configuration data, files, or software from the
AMR. Exercise caution when selecting a recovery option. If you wish to cancel this procedure
without making any changes, you can exit this mode by power cycling the AMR. This will
revert the AMR back to normal mode in its current condition.

Maintenance Options

Refer to the following table below for more information on what data or settings each Main-
tenance Option will reset.
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Table 8-1. Recovery Mode options

Recovery Option Details

Reset SetNetGo Con-
figurations to Default

Returns all SetNetGo configuration settings to their default values.
The AMRwill require re-connection to the network and Fleet.

Resets ARAM General
Configurations to
Default

Returns the AMR's configuration to the original default settings.

Parameters will need to be re-input through MobilePlanner as neces-
sary.

Clear Map, Log,
DataLog, and onboard
Backup Files

Deletes all on-board files such as audio files, log files, andmap files.

Files will need to be re-uploaded to the AMR in order to be used.

Reset Robot Model-
Type and Calibration
Values

Resets the Robot Model Type parameter, removing the default con-
figurations until a new Robot Model Type is selected.

Without a Robot Model Type, the AMRwill not be able to fully power
ON. If the "Reset Entire ARAM Config" option was selected, the
AMR’s model parameter value will need to be re-input before the
AMR can be used.

An AMRwithout a definedmodel parameter will continuously power
cycle until the model value is set. To provide extra time to input a
model value, a pop upwindow will appear in MobilePlanner with an
option button to postpone the power cycle.

You can set the model parameter in Configuration > Robot Phys-
ical> Robot Type.

Remove Installed Soft-
ware Packages

Removes the software suite from the core, leaving only SetNetGo.

The Mobile Software Suite will need to be re-installed before the core
can be used again.

AMR Platform Recovery

Follow the procedure below to reset the AMR's settings using Recovery Mode.

Before beginning this procedure, ensure the following items are available:

l Computer
l Ethernet cable
l A web browser application
l MobilePlanner

IMPORTANT:Many of these Maintenance Options will remove the con-
figuration or data from the AMR. Exercise caution when selecting a recovery
option. If you wish to cancel this procedure without resetting the AMR, you can
exit this mode by power cycling the AMR. This will revert the AMR back to nor-
mal mode without any changes.
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Additional Information: Refer to Connect Your PC to the AMR via Ethernet on
page 45 and Set the IP Address on Your PC on page 46 for more information on
connecting to the AMR's maintenance port.

1. Connect a PC to the AMR maintenance port with an Ethernet cable.

2. Open a browser and connect to robot’s SNG by typing in the maintenance IP address.

3. Download a DebugInfo file from the AMR by selecting Status > Download DebugInfo,
and save the file in a safe place. Refer to Connect Your PC to the AMR via Ethernet on
page 45 and See "Set the IP Address on Your PC" for more information.

4. Access the Recovery Mode area by selecting System > Upload SetNetGo OS > Recovery
Mode and click on the Reboot and Enter Recovery Mode Button. You will be prompted
to confirm if you want to enter the recovery mode after the selection is made..

Figure 8-15. Reboot and Enter Recovery Mode Button
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5. Wait approximately 30 seconds and then refresh the page after entering Recovery Mode.
6. In Recovery Mode, on the left tree go toMaintenance Options. You will see 5 options.
Each option provides the functionality that have been checked for that option. Refer to
the following table for additional detail on each option.

7. After making your selection, wait for a message to appear stating that the change was
made successfully.

8. Power cycle the AMR (push the OFF button and then push the ON button).
9. Allow the power cycle to complete and confirm the AMR's status. Once the AMR's
status is confirmed to be in the intended post-recovery state, the procedure is complete.

The changes that you requested in previous steps will have altered critical configurations,
therefore you will need to make sure to properly configure the AMR to ensure normal and
intended function.

8.11 Configuring ARAM
This section covers using the SetNetGo to set up and manage accounts, and to update the
ARAM software.

Setting Up User Accounts

The SetNetGo Security tab allows you manage access control for accessing AMRs and the Fleet
Manager via MobilePlanner. This allows you to restrict users from performing specific tasks.

NOTE: At least one account must be enabled at all times. SetNetGo will enforce
this.

1. From MobilePlanner, click the SetNetGo Button, then click the Security tab.

Figure 8-16. SetNetGo Interface - Security Tab
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By default, access control for connecting to AMRs and/or Fleet Manager is enabled.

2. To change the access password for the admin, operator, or viewer accounts, click the
associated Enabled radio button, then click Apply next to each modified username.

Any change to account information will force a restart of ARAMCentral or ARAM.

3. Continue to the next section to set up user accounts.

To Set Up and Manage User Accounts

1. In MobilePlanner, open SetNetGo.

2. Click on the Security tab to display the page for Fleet Accounts (on the Fleet Manager)
or ARAM Accounts (on the AMR).

3. Follow the instructions in the table below to add, delete, or edit a user account.

To... Perform the following steps

Add a user
account

1. Enter a Username in the Add a new user field.

2. Enter a password in the first Password field (on the same line as the
Username). Passwords can have letters and numbers, and can be 1 to
20 characters long. .

NOTE: Usernames and passwords are alphanumeric
only, and do not accept spaces, special characters, uni-
code marks, underscores, or periods (.)

3. Re-enter the same password in the Confirm Password field.

4. Click Add, and verify the new user account appears under the User-
name column.

Delete a
user
account

1. Click Delete in the line of the Username you want to delete.

2. Click Apply to remove the user account from the list in the Username
column.

Permission Groups

For each user account, you can enable and disable access to various features in MobilePlanner.
For example, enabling FileUploading allows the user to upload and download files from
MobilePlanner to the AMR.

1. To modify account permissions for each user (for example, admin user), clickModify
Permissions (to the left, and below the Apply Button) to display the Change Account
Permissions page.

The following example shows account permissions page for the admin user who, by
default, has all permissions assigned. Other users have different sets. Use the side scroll
bar to see all permissions.
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Figure 8-17. Change Account Permissions Page

2. Check the box(es) for the permission(s) you want to grant to the selected user account.

You can quickly assign all permissions by clicking Select All, or click Select None to
clear all assigned permissions.

3. Click Apply to set the selected account’s permissions, and return to the ARAM
Accounts page.

Operator Account

The Operator Account, by default, has the following privileges:

l CustomCommands

l Localize

l Map

l Movement

l Motors

l Navigation

l NavigationInfo

l RobotInfo

l SensorInfo

l Shutdown

l SoundFromRobot

l SoundOutRobot
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l Stop

l MovementUnprotected

l QueueInfo

l QueueModification

l FileDownloading

Updating Fleet Operations Workspace Core

For an updated Fleet Operations Workspace Core package, contact your local
OMRON representative.

To Update the Fleet Operations Workspace Core

1. In MobilePlanner, click the SetNetGo Button, then click the Software tab, then click
Manage Installed Software from the left side list.
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Figure 8-18. SetNetGo Interface - Software Tab

2. Click the Choose File Button to access the directory where the update file is located, and
click Open.

3. Confirm that the correct file name is listed next to the Choose File Button, then click
Upload.

Figure 8-19. Confirm Upload Dialog

4. If you are certain you want to proceed, click Ok.
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Figure 8-20. Software Upload Status

The AMR will be unavailable as it goes through its restart sequence (a status window shows
the restart progress).

If the installation is successful, the new Mobile Software version appears in Manage Installed
Software.

Viewing Software Packages

Clicking a package name expands the selection and shows the options for that package, which
can include:

l Release notes
l The option to enable or disable the package (if the package is executable)
l Log files
l Uninstall (if available)

Restarting ARAM

ARAM automatically stops when any changes are made, but you can click the Restart Button
to force ARAM to restart.
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There are a large number of parameters that you can set in MobilePlanner to customize your
AMR's operation in your environment. Other sections in this manual describe localization and
mapping parameters. This section describes AMR operation parameters.

9.1 AMR WiFi Capabilities
OMRON’s AMRs have multiple network interfaces, including a built-in wireless com-
munications capability to enable their autonomous operation. The on-board wireless card can
use 802.11a, 802.11b, 802.11g, 802.11n, or 802.11ac wireless standards on 2.4 GHz or 5 GHz
channels, and the AMR will automatically switch between wireless access points as it moves
through its environment.

NOTE: If the AMR has difficulty connecting to a wireless access point, switches
between 2.4 GHz and 5 GHz channels, frequently disconnects, or has weak sig-
nal strength, try disabling the 2.4 GHz channel. If the problem discontinues,
inform your IT department of your finding.

The AMRs' wireless system can use the majority of the most common personal and enterprise-
grade security methods and encryption, including:

l Open
l 64-bit or 128-bit wireless equivalent privacy (WEP)
l WiFi-protected access (WPA2)-pre-shared key (PSK) ASCII or HEX passphrase
l Extensible authentication protocol-tranport layer security (EAP-TLS)
l Protected EAP-Microsoft challenge handshake authentication protocol version 2 (PEAP-
MSCHAPv2), or

l Advanced encryption standard/temporal key integrity protocol/counter mode with
Cypher block chaining message authentication code protocol (AES/TKIP/CCMP) encryp-
tion.

The AMRs can also use certificates (small files containing identifying information that allows
the AMR to connect to secure networks that require explicit identification and pre-author-
ization for access) with the following extensions:

l .pem - a privacy enhanced mail (PEM)-encoded X.509 certificate
l .pem/.cer/.crt - a PEM or distinguished encoding rules (DER) encoded X.509 certificate
l .p7b - a Public Key Cryptography standards (PKCS7) file containing one or more cer-
tificates (contains no private key)

l .p12 - a PKCS12 file containing one or more certificates (includes private key)

Your certificate authority (CA) server generates these certificates based on a certificate request
(.csr) file. You manually install the certificates on the AMR. The AMRs can generate their own
1024-bit or 2048-bit RSA keys, or use keys generated by the CA.
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9.2 Available Options and Peripherals
The following options and peripherals are available for your AMR. For more details, refer to
the Peripherals Guide for your AMR:

Pendant

The pendant is an optional hand-held input device for driving the AMR. It attaches directly to
the AMR's pendant port, and has controls to move the AMR forward and backward, turn left
or right, and adjust its speed. It also has a configurable goal button for adding goals while
mapping.

For the LD-series AMRs this is called a Joystick, and the port is the Joystick port. This is sim-
ilar to, but not the same as the pendant used with the HD-1500 AMR.

Acuity

In addition to using a safety scanning laser (navigation laser) to create a map of its envir-
onment, the AMR can, with an upward-facing camera mounted on top of the platform or its
payload, use overhead light localization for navigation (the laser then provides obstacle avoid-
ance). Called Acuity, this peripheral add-on is ideal for dynamic environments, such as ware-
houses, in which objects on the floor undergo frequent location changes. For more information
on localization, refer to What is Localization? on page 260.

NOTE: If not installed by the factory, Acuity requires installation of the Acuity
Support Package software via the MobilePlanner software. For information, see
theMobile Robots - LD Platform Peripherals Guide (Cat. No. I613), found in the
OMRON corporate website.

NOTE: Acuity localization is not currently available with the HD-1500 AMR.

High Accuracy Positioning System (HAPS)

The HAPS peripheral uses a sensor (called GuideSensor_Front in the Robot Physical con-
figuration) installed in the AMR to detect and follow magnetic tape applied to the floor. HAPS
allows you to position the AMR at pick-up and drop-off locations with a high degree of accur-
acy. For more information, refer to theMobile Robots - LD Platform Peripherals Guide (Cat. No.
I613)..

Side Lasers

The LD Cart Transporter AMRs have side lasers to detect obstacles on either side (such as over-
hangs, tables, etc.) to help the AMR navigate through tight areas, such as office spaces.

All other LD-series and the HD-1500 AMR offer these as an option.

Touchscreen

The Touchscreen allows interaction with the AMR at any location. You can check the AMR’s
status, send the AMR to goals, pause or release the AMR, or localize a lost AMR.

Call Buttons and Door Boxes

Call buttons issue a request for the AMR to go to the call button’s associated goal. Door Boxes
act as remote I/O, and can issue requests to open closed doors equipped with a door activator
so AMRs can pass through it. For additional information, seeMobile Robots - LD Platform Peri-
pherals Guide (Cat. No. I613)
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9.3 Types of Configurations
MobilePlanner allows you to view, modify, save, and import various AMR and fleet, and
debug configurations. You can set AMR interface, operation, and physical configurations, Fleet
Manager configurations (queuing tasks, fleet features, and connection), and debug con-
figurations that control the output of debug log files.

General Configurations

General configurations include site-specific parameters for the AMR interface (A/V config, con-
nection timeouts, language/location, speech synthesis, etc.), AMR operation (docking behavior,
localization settings, path planning settings, task features, etc.), EM2100 features and con-
nection, and debug information. General configurations are consistent across your site. If you
have a fleet of AMRs, the general configurations reside on the EM2100. If you have a single
AMR, the general configurations reside in the AMR’s core.

The configuration interface for the fleet is similar to that of a robot. If you change the con-
figuration of each level of the hierarchy, which includes robot family, robot type, and robot, it
will change the levels below it. Refer to the following figure.

B

A

C

D

Figure 9-1. (A) Robot Family, (B) Robot Type, and (C) Subfleet Name (D) Robot Name/ID

Model and Calibration Configurations

These configurations relate to the AMR itself.

Model configurations include AMR model-specific parameters like movement maximums, bat-
tery information, Acuity camera configurations (LD-series option only), the MARC or Polo con-
figuration, AMR type, sensor type(s) and location(s), fleet queuing tasks, etc.

Calibration configurations include general physical AMR information and parameters. Cal-
ibration configurations are specific to a single AMR and cannot be copied to other AMRs
Model and calibration configurations always reside in the AMR’s core.
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IMPORTANT: Care should be taken when adjusting the parameters in the Abso-
lute Movement Maximums section. These parameters can affect the safety of the
platform. For example, if AbsoluteMaxTransDecel is too high, it could cause the
platform to decelerate too quickly and tip over.

9.4 Using the Search bar
When MobilePlanner is in the Configuration tab, typing into the search bar allows you to filter all
configurations for specific key words. This allows you to find parameters by name, or search for a
specific word in a parameter’s description (searching for ‘Auto’ in the example below). Terms you
have searched for will appear highlighted in yellow in the interface.

Figure 9-2. Search Window - Searching for ‘Auto’

9.5 Setting the Configuration Parameters
Configuration parameters determine the available features on your AMR. You can enable or
disable them, or assign them a value. You can set these parameters in MobilePlanner for a
selected level (from single robot, Fleet manager, or at the Robot family level) in the Fleet
Explorer.

Figure 9-3. Configuration tab accessed from the Fleet Explorer

Using the categories listed here, you can set parameters for everything from audio feeds, to
docking, mapping, localization, server setup, move settings, and many more.

There are five AMR parameter categories:
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l Robot Interface
l Robot Operation
l Robot Physical
l Fleet
l Debug

The Configuration tab includes multiple categories which contain sections, and parameters.
Click on a category, such as Robot Interface, to open and view its sections. You can click on
the expand/ contract widgets next to each category to view its sections. To view individual
parameters in each section, click on the expand/ contract widgets next to the section. You may
click on the widgets again to collapse the category or the section. The following figures display
categories, sections, and the parameters.

Figure 9-4. Configuration Categories Displayed (Categories Collapsed)

Figure 9-5. Configuration Categories Expanded
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Figure 9-6. A/V Section Expanded (Displaying its Parameter)

Figure 9-7. Robot Interface Tab, Parameter Info Icons
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Table 9-1. Robot Interface Pane Description

Item Description

Automatic software restart if changed, and check mark removed. Also, this will
delete the old interface.

Important parameters that generally must be changed or at least verified in an
installation.

Advanced parameters that should only be adjusted by expert users.

Normal parameters that are likely to be modified.

Figure 9-8. Robot Interface Category in the Available to Customize Pane

Most configuration windows in MobilePlanner software describe most of the parameters, and
most are not repeated here. Where needed, this manual explains more complex parameters.

NOTE: The stylized ‘i’ icon to the right of the description column of a para-
meter indicates that more information is available by clicking on that icon. The
following figure is an example.
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Figure 9-9. Configuration Parameter with stylized ‘i’ icon

Figure 9-10. Pop-up Window for SideClearanceAtSlowSpeed when 'i' icon is Clicked

To set a parameter, open th configuration category in MobilePlanner, then select a Section to
see the available parameters. You can then modify the specific parameter in the parameter
table.

NOTE: If a parameter is grayed out you can not change the value of that para-
meter directly. You can only change the parameters with names that are in blue
color, and the values are highlighted in orange. The grayed out parameters indic-
ate that the parameter has been set at a higher hierarchy level (indicated by the
thick blue line used to highlight the relevent hierarchy level). Refer to the fol-
lowing figure for an example of grayed out parameters, as well as the parameters
in blue.

Figure 9-11. Grayed out Parameters
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Figure 9-12. Blue Parameters, (1) Default Values

In this table’s Value column, you can enter a value (numeric or text), choose a value from a
drop-down selection, or click a checkbox. Most text fields have drop-down menus for selection.

For parameters which allow numerical input, there is an indicator bar. If you select a value
that is above the default value, the indecator bar's arrow will change color to orange. If the
selected value is below the default value, it will turn blue.

There are different types of parameters that accept different types of input. Some parameter can
be checkboxes while others accept numbers or text. When looking at a parameter, the entry on
the right side indicates the default value, and the entry on the left indicates the current value.
If a parameter has its right entry set to a different value than the default, it means that the para-
meter has been altered.

Parameters with numeric values will be shown with an indicator bar. As the parameter's
value is altered the arrow on the bar will move and change color to convey the change. When
a parameter is changed, the indicator arrow will change color to show that the current value is
either above (blue) or below (red) the default setting.

Figure 9-13. Indicator bar at default value

Figure 9-14. Indicator bar above default value

Figure 9-15. Indicator bar below default value

Most parameters are not stand-alone and interact with other parameters. This manual dis-
cusses various parameters. For example, if you are localizing the AMR, you will find the para-
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meters related to localization in the Using Laser Localization on page 263 section of this
manual.

If you change any parameter settings, you have to click Save (or use the keyboard shortcut
Ctrl+S ) for those changes to take effect. When MobilePlanner sends the update to the AMR, a
small spinning icon and “Update Pending” message appear in the MobilePlanner status bar
until the AMR applies the changes (at its next idle period). You can also stop the AMR if you
want the changes to be applied more quickly.

NOTE: ARAM automatically restarts automatically after some parameter
changes.

If the parameter has a restart icon ( ) then, after ARAM writes the change, it displays the fol-
lowing dialog indicating the configuration change:

Figure 9-16. Robot Configuration Change

Additional Information: An asterisk sign on the mode tabs indicate that the
changes made to the parameters have not been saved.
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Figure 9-17. Asterisk Sign Indicating Unsaved Changes

Show Expert Parameters

The Show Expert Parameters check box is located on the top right of the Configuration win-
down. When you check the Show Expert Parameters check box, two extra tabs open on the
right side of the Configuration window, "Toolbox: Expert Parameters" tab and "Toolbox:
Reusable Sections" tab.

The Toolbox: Expert Parameters tab displays the parameters which you most likely will not
have to change as they are the non-essential parameters. However, if you decide to change one
of the parameters in Toolbox: Expert Parameters tab you can do so by simply dragging the
parameter and dropping it in the Customizations Pane. You can then change the parameter
value similar to how you would do for the other parameters. Refer to the following figures for
examples of how this is done.

Figure 9-18. Enabling the option for viewing Expert Parameters
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Figure 9-19. Clicking and dragging a specific parameter from the Expert Parameters section to the stand-
ard configuration section

Figure 9-20. The chosen parameter successfully relocated

When a parameter is changed at a level with dependents (for example at the robot type level),
the parameter at the lower level (robots in this case) is grayed out. This indicates that you can
not undo the change at that lower level, and instead you must find out which level the change
was originally made. You can do this by simply right clicking on the changed parameter, and
selecting Switch to edit option (as displayed in the following figure). You will then be taken to
the level where the change was inherited from. You can make the change there.
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Figure 9-21. Switch to Edit Option

Figure 9-22. Original level where change was inherited from

Indicator Lines

Indicator lines appear in the Fleet Manager to tell you at which level the parameter was
changed, and at which levels have taken effect. There is also an indicator line for searched
items. You will see three types of lines as displayed in the following figure:

l The thick dark blue line indicates the original level the change was made.

l The thin light blue line indicates the robots that are affected by the changed parameters..

l The thick yellow line indicates where the searched items exist.
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Figure 9-23. Blue Indicator Lines in MobilePlanner

Figure 9-24. Yellow Indicator Lines in MobilePlanner

Show All Inherited

The Show All Inherited check box is located on the top right of the Configuration window.
From Show All Inherited, you can see all paramters at a given level that have been inherited
from a higher level in the hierarchy. When you check the Show All Inherited check box, a pop-
up window is displayed which explains four options available to the users are:

l Override here

Change the value of this parameter for the selected Fleet Explorer item, and its des-
cendants. The change will not apply to descendants which have already overridden the
parameter at their level. Other fleet items that use the parameter setting are not affected.

l Switch to edit

Select the fleet item that defines this parameter setting so that its value can be changed
for all of the fleet items that are using it.

l Remove parameter

Stop customizing the parameter for the selected fleet item and its descendants. Instead,
inherit the value from the parent.

l Promote parameter
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Moves the parameter to the parent Fleet Explorer item. This enables it to affect a wider
set of robots.

Toolbox: Reusable Sections

When a change is made to a parameter at a lower level in the hierarchy, the parameter will
appear as a changed section in the Toolbox: Reusable Custom Sections tab located on the right
side of the Other Parameters tab. When viewing a higher level of the hierarchy, you can see all
sections that have been changed at lower levels. Clicking and dragging a changed section from
the Reusable Custom Sections tab onto the main Configuration tab will overwrite the current
values with what was set at the lower hierarchy level.

9.6 Saving and Importing the Configuration Parameters
You can save parameter settings on either an AMR or in the Fleet Manager:

1. In MobilePlanner, click the Configuration tab.

2. In MobilePlanner's main menu, select File > Save As, and give a file name and location
for the file on your local PC.

The Save <robot IP address> Configuration window opens.

Figure 9-25. Save Robot Configuration Window

3. In the Save <robot IP address> window, select the type of file that you want to save
(General, Robot Model, or Calibration), then either accept all checked configurations
(default), or de-select the individual configurations that you do not want.

4. Click Save when done.
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Importing

You can import parameter settings from your PC to either an AMR or the EM2100 appliance:

1. SelectMobilePlanner > Config.

2. From the main menu, select File > Import Config ..., then select the file from your local
PC.

3. Click Save from the main toolbar.

NOTE: If ARAM restarts after saving a configuration, you will need to repeat
the above steps until the software no longer restarts.
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9.7 Managing Files
MobilePlanner allows you to manage files associated with Fleet Operations Workspace Core,
including:

l raw map-scans (.2d or .z2d) files
l maps (.map) files
l log files
l data files

Downloading, Uploading, and Saving Files

You can upload and download map, scan, log, and data files using File > Download/Upload
from the top bar. Select the AMR you want to use, and then select the file or folder on the AMR
and the file or folder on the PC that you want, and click either Upload or Download.

You can save map files using File > Save As... or, if the file already exists and you just want to
save modifications, use File > Save (Save only affects the previously saved file). This is the
same as clicking the Save icon in the Toolbar.

You can import a configuration file onto the current AMR using File > Import Config...

NOTE: Import Config applies to the config copy on MobilePlanner, and must be
Saved before it is on the current AMR.

9.8 Setting Up Data Logging
The ARAM software can log many kinds of data into one or more files. These data logs allow
you to manipulate the data, using your own third-party data-processing software.

NOTE: Log Config is a Section of parameters you can set in MobilePlanner.
These logs are not the same as the files generated with data logging.

To set up data logging on an AMR, click the Config category, then click the Debug tab. When
checked, the Show Expert Parameters checkbox displays advanced parameters that, by
default, do not appear in the parameter list. Expand the Data Log Settings category and set the
Log parameter to True.
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Figure 9-26. MobilePlanner Config, Debug Tab (Show Expert Parameters Checked)
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MobilePlanner gives you the flexibility to manually program a complex series of tasks for the
AMR to perform at a goal before moving on to the next goal and performing additional tasks.

Instead, you could create macros that include all of the tasks the AMR is to perform at a given
goal. You can add tasks and goals to macros, then use the macros within a route or several
routes. In other words, macros are "reusable." You can also have individual tasks call a macro
and execute the sub tasks within the macro.

For example, you could create a macro in which the AMR drives to Goal1, speaks a phrase
and waits for a human action, after which it then drives to Goal2, where it waits for a spe-
cified time, then drives to Goal3.

You can use the MobilePlanner software to add tasks, goals, and macros into your facility’s
map, associate tasks with routes and goals, and assemble series of goals, tasks, and macros
into routes.

10.1 AMR Tasks
Tasks are activities that the AMR can perform, such as going to a goal or checking sensors.
The AMR executes tasks at goals to accomplish useful work, such as enabling Digital IO and
telling the AMR to move. These tasks are already available on the AMR but need to be defined
and associated with the map that you are creating.

There are both instant and non-instant tasks available for the AMR to perform. Instant tasks
allow other tasks to be started before the instant task finishes. Non-instant tasks force the next
task to wait until they are completed.

You can add tasks to goals and routes. For details, refer to Using the Route Builder on page
205.

IMPORTANT: Use of AMR tasks or ARCL commands to remotely or auto-
matically re-enable motor power is not permitted. Doing so could result in unex-
pected AMR motion. Motor power may only be enabled by intentional, manual
action at the AMR.

Assigning Tasks

You can assign tasks to a route or goal, or use them in macros. You can find available tasks
under the Robot Tasks tab in the Source Lists pane. See Setting Up Special Tasks on page 197.

Many tasks need to have their corresponding ARAM parameters enabled to be available. For
more information on enabling ARAM parameters, refer to Configuring ARAM on page 147. If
you do not see a task displayed in the Source Lists pane, it might have previously been turned
off. To display the task, enable (or re-enable) the appropriate ARAM parameter.
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1. In MobilePlanner, click theMap Button, then click the Build tab.

Figure 10-1. The Map Build Tab

2. In the Source Lists pane, click Robot Tasks tab to view tasks that are available on the
AMR.

3. In the Editable Lists pane, click the Routes, Goals,Macros, or Special tab that cor-
responds to where you want to assign the task.

4. To assign a task to a route, goal, macro, or special item, in the Source Lists, Robot
Tasks tab:

a. Click on the task that you want to assign, and drag it over to the desired route,
goal, macro, or special item, or

b. Highlight the task, then highlight the desired goal, macro, special item or route,
and click the Add Button (the arrow between the lists).

NOTE: By default, tasks that are added to goals become part of the
goal's "after" list (the AMR will perform the task after it arrives).
The process also creates a "before" list for tasks that the AMR will
execute before driving to the goal (you can also move tasks to the
“before” list).

If the task has associated parameters, a dialog box, shown below, opens ("sayIn-
stant" task shown) :
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Figure 10-2. MobilePlanner Task Description Dialog

5. Click inside the Value field to add and edit each parameter's values.

For more information on using individual tasks, refer to the task type (such as wait,
driving, etc.) in the following section.

Using Instant and Non-Instant Tasks

In general, there can be only one sequence of non-instant tasks running at a time. AMRs can
start an instant task without waiting for a previous instant task to finish. Non-instant tasks
must finish before the AMR starts another task. In other words, both kinds of tasks are on the
task list, but the non-instant tasks must finish before the AMR starts next task on the list.
When an instant task runs, the task after it can start right away, without interrupting whatever
else is happening.

Instant Tasks

Instant tasks allow the next task in the list to start while the instant task is still running, so the
AMR can be running two tasks at once. The following are examples of instant tasks available
in the software. The complete list of instant tasks and descriptions are available directly in the
software.
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Instant Task Description

ARCLSendText Sends a given string to the ARCL server.

customOutputOff Turns a custom output OFF.

customOutputOn Turns a custom output ON.

playBackgroundSound Plays a random background sound (at 'Least Important')
from a set of prefixes and suffixes (wild cards do NOTwork),
waiting a length of time between sounds, optionally resum-
ing interrupted sounds, andwith the ability to stop playing in
some different circumstances.

NOTE: To interrupt this sound, set the audio
task Cancel less important to True.

playInstant Plays a sound file and then continue while the sound plays.

popupSimple Requests client applications to show a simple pop-upmes-
sage (Client applications include MobilePlanner).

sayInstant Speaks text with a synthetic voice.

sendSoundInstant Sends sound from an AMR sound file to all clients and con-
tinue immediately.

sendSpeechInstant Sends synthesized speech to all clients and continue imme-
diately.

Non-Instant Tasks

Non-instant tasks run in their own time slot (the AMR must wait for them to complete before
starting the next task in the list).

The following are examples of non-instant tasks. The complete list of non-instant tasks and
descriptions are available directly in the software.

Non-Instant Task Description

arbitraryServerSend Sends the given text to a specified server and port.

cartCapture Task to capture a cart.

cartRelease Task to release a captured cart.

customInputsCheckAll/Any/Each Checks whether all/any/each specified custom
inputs properly triggered and executes a macro.

deltaHeading Changes the heading by the specified relative
amount.

followGuide Usedwith HAPS - task to follow amagnetic guide
strip on the floor.

gotoRandom Drives to a random goal (could be optionally con-
strained by amatching name prefix).
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Non-Instant Task Description

laserCheckBox Waits for something to enter the rectangular area
surrounding the AMR. Macros may be triggered
upon detection or timeout.

laserCheckEmptyBox Waits for the rectangular area surrounding the AMR
to be empty. Macros can trigger upon detection or
timeout.

macroRepeat Repeats the specifiedmacro a given number of
times or until it fails.

move Moves forward by the specified distance, provided
that no obstacles are encountered.

play Plays a sound file andwaits until it finishes playing.

say Speaks text with a synthetic voice andwaits until it
is finished.

sendSound Sends sound from an AMR sound file to all clients,
continues when done.

sendSpeech Sends synthesized speech to all clients.

setHeading Turns to a specified global orientation/heading.

wait Waits for the specified number of seconds. The wait
may be interrupted by an explicit continue com-
mand.

waitActive Calls a macro, and optionally waits a given number
of seconds or until told to continue by command and
control.

waitIndefinitely Waits until commanded otherwise.

To verify if a task is instant or non-instant, right-click on the task and select Description. Or,
go into ‘custom responses’ (Build tab > Editable Lists > Special tab) and click on one of them.
The non-instant tasks are grayed out, instant tasks are active. Task classification appears in
the "Class" category, as shown in the following figure.
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Figure 10-3. Task Class Category

Using a Wait Task

A wait task tells the AMR to wait a given number of seconds (or until told to continue by
another command), before continuing. A wait task is not an instant task.

1. Open the map you want to edit. For details, refer to Using MobilePlanner Software on
page 52.

NOTE: Ensure that Show Robot is OFF, or you will not be able to pro-
ceed.

2. Click the Build tab.

3. Click the Robot Tasks tab in the Source Lists pane to view the tasks currently available
on the AMR.

4. Add the Wait task to the route, goal, or macro where you want the AMR to pause before
continuing its route. Refer to Assigning Tasks on page 172 for details.

5. Enter the number of seconds that you want the AMR to wait in the Value field of the
seconds to wait parameter, as shown below.
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Figure 10-4. Parameters for Wait Task

6. Click OK to close the parameter dialog box and save your changes.

Using Driving Tasks

Driving tasks cause the AMR to move about its environment, carrying out various tasks at
each goal. Driving tasks can include the following:

Task Task Description

move Tells the AMR tomove the specified distance.

deltaHeading Changes the AMR's heading.

setHeading Turns the AMR toward a specified heading.

Step 1: Enable Movement Tasks

Not all available tasks are enabled by default. Before you can use those tasks, enable them in
MobilePlanner by clicking the Config Button, then clicking the Robot Operation tab, then click-
ing Task Features. After clicking the checkboxes that you want to enable, click Save to save
your changes.

The following table lists some examples of the driving and movement parameters that you can
enable.

NOTE: Some of the parameters in the following table require checking the Show
Expert Parameters checkbox.
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ARAM Parameter Description

Engage When usedwith HAPS, calls a macro when the AMR
arrives at the goal, so that the AMR can be sent on a
series of tasks, such as a followGuide task to go to a
marker on the magnetic strip.

MovementParametersTempTasks Enables tasks for temporarily changingmovement
parameters.

Step 2: Assign Movement Tasks

Driving tasks are non-instant, but the MovementParametersTempTasks are instant.

1. Open the map you want to edit.

2. Click the Build tab to display Source and Editable Lists panes.

3. In the Source Lists pane, click the Robot Tasks tab to view available tasks.

4. Add the driving task to the route or macro (for details, refer to Assigning Tasks on page
172.

5. Enter the parameter values for the assigned task.

Figure 10-5. Parameters for setHeading Task

The following table shows examples of some of the task parameters and the tasks that
use them.
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Task Para-
meters Parameter Definition Associated Task(s)

heading (Integer) The number of degrees to
turn the AMR. Positive values turn the
AMR left or counterclockwise. Negative
values turn the AMR right or clockwise.
For deltaHeading, if the absolute value
exceeds 360, the AMRmakes at least
one full rotation.

deltaHeading, setHead-
ing

distance (Integer) The distance (in mm) the AMR
shouldmove from the current position.

move, move2,
moveProx1

speed (Integer) The speed (in mm/s) the AMR
shouldmove from the current position.

move, move2,
moveProx1

1 moveProx and other "Prox" tasks are not supported for the HD-1500 AMR.

6. Click OK to accept the parameter value and save any changes you made.

Cell Alignment Positioning System (CAPS)

The Cell Alignment Positioning System (CAPS) is a set of advanced features that provide
improved destination alignment accuracy without requiring additional peripheral hardware
on the AMR. These features are intended for use in applications that require better alignment
accuracy than the standard solution.

CAPS now uses the PrecisionDrive task for improved alignment. Legacy versions of FLOW
CAPS used the task TriangleTargetDrive and related tasks. These can still be used, but are not
covered in this manual. Contact your local OMRON representative for information on legacy
tasks.

PrecisionDrive

PrecisionDrive is a software task designed to increase the final position accuracy of the
OMRON AMR platforms. It forms the basis of the Cell Alignment Positioning System (CAPS).
PrecisionDrive uses the onboard OS32 scanning laser. It requires a reference target to be placed
in the operating space. The AMR will locate and drive relative to this target.

The entire target must be visible by the selected or main laser for the duration of the task, as
the laser does not capture and remember reference points while the AMR moves. Using a par-
tial view of the target will cause repeatability to suffer. If the view of the target is completely
lost while the task is in progress, the robot will continue using the last known position, and
repeatability will suffer.

PrecisionDrive is configured using the MobilePlanner user interface. It is a robotic task that
can be scheduled before or after a map goal.

The figure below lists the default parameter values for PrecisionDrive. These default values are
the recommenced values for normal usage in mm, and are measured from the center of the
robot.
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Normal Setup

Figure 10-6. PrecisionDrive Normal Parameters

Target Shape

This dropdown controls which target the AMR will locate and move relative to in the oper-
ating space. The Standard shape is the default and is defined in Standard Target on page 190.
Other shapes can be used based on need and space requirements. Users should give preference
to the Standard shape when designing and setting up an application. Both legs of the target
must be in the field-of-view of Laser_1 (the front navigation laser) at the beginning of the task
– the AMR will not rotate to find the target.

NOTE: The Standard target is the only target with listed accuracy specifications.
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Final Offset X

Final Offset Y

Final Offset Angle

These three settings (X, Y, Angle) specify where the AMR will attempt to stop at the end of the
task execution. They are 2D spatial coordinates and the diagrams for setup are provided in
Standard Target on page 190.

NOTE: These values are relative to the target, not the AMR. This is to simplify
setting up tasks as they correlate directly to measurements taken from the target
in geometric space.

Initial X

Initial Y

Initial Angle

These three settings (X, Y, Angle) specify the position for the AMR, from which it will attempt
to locate the target when first starting the task. From the Initial position, the AMR should be
able to see both legs of the target from the concave side. There is an associated search area to
account for real world position uncertainty after arriving at the pre-goal. These are described in
more detail under the Advanced Setup section. They are 2D spatial coordinates, and the dia-
grams for setup are provided in Target to Robot Coordinate Frame Transformations on page
190.

NOTE: These values are relative to the target, not the AMR. This is to simplify
setting up tasks as they correlate to measurements taken from the target in geo-
metric space.

These three parameter sets are all that are needed to successfully set up and use the Pre-
cisionDrive task in most applications. Users should use the Normal setup whenever possible.
All other parameters (listed in the Advanced Setup section) are optimized for most use cases
with the Normal setup setting.

Parameter Mode

This parameter toggles the Normal and Advanced setting menus. Normal only shows the para-
meters previously described in this section. Advanced shows the parameters listed in the
Advanced Setup section that follows.
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Advanced Setup



Chapter 10: Working with Macros, Tasks, and the Route Builder

Figure 10-7. PrecisionDrive Advanced Parameters

Timeout

This sets the time before the AMR declares a timeout failure. The timer begins at the time the
task first starts looking for the reference target. If the tasks has not reached the desired ending
position before the specified time, the system will come to a stop, and signals failure of the
goal task.

Path Shape

This parameter selected the desired path to the end position.

l PreAlign: This shape uses an arc-shaped path to first align with the vector path defined
by the X,Y, and Angle Final position components, then follows the rest of the way mov-
ing straight with generally little or no final rotation required to achieve the desired final
position. Some PreAlign moves may start and end with a straight path.

l Straight: This shape draws a straight line between the Initial position of the AMR and
the desired Final location. In-place rotation at the beginning and end of the straight path
is performed as necessary.

Search Mode

This parameter controls the amount of initial tolerance allowed. The general guideline is that
larger tolerances are more likely to find a target, but more likely to choose the wrong item as
the target. Smaller tolerances are more likely to fail to find a target, but less likely to choose the
wrong target.

NOTE: The Search coordinate frame is relative to the target, not AMR reference
frames.

Mode Tolerance

X Y Angle

Normal 500 mm 500 mm 15°

Wide 250 mm 750 mm 20°

Tall 750 mm 250 mm 20°

Minimum 200 mm 200 mm 8.5°

Max 750 mm 750 mm 30°

Rotation 350 mm 350 mm 45°

Match Mode

This parameter specifies how closely the laser data must match the selected TargetProfile.

l Normal: Balanced behavior between allowing for minor match errors with a reasonable
guarantee that the target was correctly matched.

l Lenient: This behavior allows more error in the final line fit to decrease risk of failing
the task due to sensor noise or poor geometry. This mode should only be used when the
target is in open space to decrease the likelihood of an incorrect match.

l Strict: This behavior allows very little error in final data fit, but has a higher guarantee
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that the target was correctly matched. This mode should only be used when incorrect
target matches will have very detrimental effects on the application. Using this mode
will result in more failed tasks, especially when operating large fleets as each scanning
LIDAR has its own intrinsic errors and noise profiles that affect the final match quality.

Fail Mode

This parameter controls the different failure modes that would cause the task to immediately
fail instead of attempting recovery to finish the task within the FailTime timeout.

FailOnSafetyStop: Any Safety stop (either from E-Stop buttons or Safety LIDAR)
will cause the task to immediately fail.

Clearance Mode and Clearance Shape

These two parameters control how the AMR deals with obstacles (both real and virtual) that
are detected in close proximity to the AMR.

Clearance Mode controls how the clearances behave.

l Normal: uses the default settings.

Approach Distance = 400 mm away from sensed obstacles.

l Variable: allows two difference clearance sets to be used.

Parameter Clearance Switch Distance controls when, during the task, the clearance
switches from the initial clearance to the final clearance. This parameter is defined by
the distance to the final location.

This also allows control of the Approach Distance parameter.

l Custom: allows control of the Approach Distance parameter.

Clearance Shape is the clearance relative to the footprint of the AMR.

This parameter allows control over the size of the clearances around the AMR. All of the clear-
ances are defined from the front, rear, and side edges of the AMR.

In general, clearances should be set to fairly low values (<100 mm). Clearances are a sup-
plement to the Safety system but do not in any way replace the hardware Safety.

l Normal: Clearances sizes and definitions are set to give a good compromise between
staying a safe distance away from the obstacle and still completing the required task.

Front Clearance Side Clearances Back Clearance

50 mm 75 mm 20 mm

l Tight: Clearances sizes and definitions are set to minimize likelihood of task failure. The
AMR will be allowed to drive slowly past obstacles very close to the physical footprint
of the AMR. Using this setting will result in fewer task failures, but an increased chance
of failure upon leaving the area (AMR can get into a space that it may not be able to
extract itself from).

Front Clearance Side Clearances Back Clearance

20 mm 20 mm 5 mm

l Expanded: Clearances sizes and definitions are set to maximize the likelihood of being
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able extract itself from the situation. The AMR will stop sooner due to the increased size
of the clearances areas. Using this setting will result in more task failures, but an
increased chance of success upon leaving the area (AMR will stay out of a space that it
may not be able to extract itself from).

Front Clearance Side Clearances Back Clearance

100 mm 250 mm 20 mm

l Custom: You can specify the area around the AMR for obstacle protection while moving
to the final location. These parameters are only visible when Clearance Shape is set to
Custom. Refer to the following figure.

Figure 10-8. Clearance Shape Set to Custom

Allows control over Front, Left, Right, and Back Clearances.

Negative clearances (clearances that allow obstacles internal to the defined shape of the
AMR) can also be programmatically set. Use with Caution!

PrecisionDrive Clearance Differences

NOTE: The clearances used in PrecisionDrive have a few key differences com-
pared to other Clearance parameters within the FLOW Core software.

l The slowdown/stop behavior is different. The Approach Distance controls how far away
the platform should stop instead of the Front Clearance (or Front Padding depending on
the Task). This results in allowing smaller front clearances in most applications.
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l Obstacles near the clearances but not within the clearances will cause the AMR plat-
form to slow down.

Drive Mode

This parameter controls the driving behavior of the AMR.

l Normal: A balanced optimization giving the best all-around driving behavior.
l Precise: Minimizes Path and final error at the expense of being slower and with
increased jitter in its motion.

l Fast: Minimizes time to goal at the expense of being less precise and increased jitter in
its motion.

l Smooth: Minimizes motion jitter at the expense of being slower and less precise in its
motion.

Precise Fast Smooth

Cycle Time Increased Decreased Increased

Smoothness Decreased Decreased Improved

Precision Improved Decreased Decreased

Table 10-1. Drive Mode Behaviors

Forward Speed

This parameter controls the maximum forward translation velocity that the AMR could
achieve during the motion. This does NOT represent the speed at which it will complete the
task - only the maximum. The Drive Mode will dictate the local speed based on the optim-
ization chosen. Depending on the Drive Mode setting and the application, increasing this para-
meter may have no effect on the resulting motion.

Reverse Speed

This parameter controls the maximum reverse translation velocity that the AMR could achieve
during the motion. This does NOT represent the speed at which it will complete the task - only
the maximum. The Drive Mode will dictate the local speed based on the optimization chosen.
Depending on the Drive Mode setting and the application, increasing this parameter may
have no effect on the resulting motion.

Rotational Speed

This parameter controls the maximum rotational velocity that the AMR could achieve during
the motion. This does NOT represent the speed at which it will complete the task - only the
maximum. The Drive Mode will dictate the local speed based on the optimization chosen.
Depending on the Drive Mode setting and the application, increasing this parameter will have
no effect on the resulting motion.

OffsetCorrection

NOTE: This feature is only available to PrecisionDrive if there is a CAPS license
activated.

MobilePlanner allows for the configuration of a custom offset for each AMR. The primary pur-
pose is to compensate for minor mechanical tolerance differences between individual vehicles
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across a “uniform” fleet. Users should first verify that Laser_1 is well-aligned and in good con-
dition before trying to use OffsetCorrection as a quick fix for a potentially larger problem.

NOTE: This is a part ofMobilePlanner -> Robot Configuration -> Robot Phys-
ical. It is not a part of the PrecisionDrive task.

Only one OffsetCorrection (X, Y, and Angle) is allowed for each AMR. This will be applied to
all PrecisionDrive tasks for that AMR - it is not task- or target-specific. In most applications the
overall approach and motion generally stay consistent and a single offset (if needed) is suf-
ficient. The OffsetCorrection is added to the final position requested in the PrecisionDrive task
(Final Offset X, Final Offset Y, and Final Offset Angle values). The OffsetCorrection values are
relative to the target using the same coordinate reference frame for the Final Offset values as
shown in Standard Target on page 190. For example, if the Final Offset X in the task is –1000,
and the individual AMR needs to have a Final Offset X of –1005, Offset X for that AMR would
be set to –5. The same approach is used for Offset Y and Offset Angle.

Figure 10-9. OffsetCorrection Parameters
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The Descriptions of the Parameters shown in the preceding figure are in the following table:

Parameter Description

Offset X AMR specific axial offset in mm in the coordinate system of the specified target
(used in all PrecisionDrive Tasks)

Offset Y AMR specific lateral offset in mm in the coordinate system of the specified target
(used in all PrecisionDrive Tasks)

Offset Angle AMR specific rotational offset in degrees in the coordinate system of the specified
target (used in all PrecisionDrive Tasks)
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Standard Target

The target must be constructed to accurately reflect the dimensions shown below. The local flat-
ness of the two segments and the 90° angle must be strictly observed for repeatable motion.

Notes for Drawing:

l All general tolerances ISO 2768 - Class M (Medium)
l Material: 5052-H32 Aluminum
l Finish: Paint matte gray. Option gray Cardinal X-Press polyester TGIC powder coat,
P/N X041-GRW02871, 0.127- 0.254 mm thick (0.005 - 0.010 inches)

l debur and break all sharp edges between 0.10 mm - 0.25 mm max.
l Use minimum bend radius 1.5 max.

 

150 mm

1000 mm

1.6 mm

90°

250 mm
R1.5

Figure 10-10. Standard Target

Target to Robot Coordinate Frame Transformations

These examples illustrate how to set the Initialn and FinalOffsetn parameters to achieve the
desired behavior. The values shown by each AMR in the drawings represent the values that
would be set in the PrecisionDrive task for each use case.

Example 1: The graphic below shows the results of a move with a MotionProfile of Straight,
starting at (-2000, +250, Th 0) and moving to (-500, -500, Th 180). The AMR has to rotate in
place at both the Initial and Final locations. The target is a Standard target. The AMR icons are
for LD-250.
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X = -2000

Y = +250

Angle = 0.0

X = -500

Y = -500

Angle = 180.0

-Y

250 mm

1000 mm

90˚

0,0
X -1000X -2000

+Y

+X

Figure 10-11. Straight Motion Profile

Example 2: The graphic below shows the results of a move with a MotionProfile of PreAlign,
starting at (-2000, -500, Th 0) and moving to (-500, 0, Th 90). The AMR only turns for a part of
the path. The target is a Standard target. The AMR icons are for LD-250.

-Y

250 mm

1000 mm

90˚

0,0
X -1000X -2000

+Y

+XX = -2000

Y = -500

Angle = 0.0

X = -500

Y = 0

Angle = 90.0

Figure 10-12. Prealign Motion Profile
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CAPS License

CAPS is a licensed feature, and requires a license key file that must be loaded onto the AMR
before CAPS takes effect. Licenses are granted to individual AMRs, minimizing cost by apply-
ing this feature only to those AMRs that require the higher accuracy it provides. Contact your
local OMRON representative for instructions on ordering and obtaining the license key files for
this feature.

The PrecisionDrive task can be used with or without a CAPS license. If PrecisionDrive detects
a CAPS license, its alignment accuracy will improve significantly.

With or without the CAPS license, the setup, configuration, and use of PrecisionDrive does not
change. With the license, the accuracy improves. The CAPS license is P/N 20271-805.

NOTE: The TriangleDrive version of CAPS is legacy but can still be used if a
CAPS license is detected. Contact your local OMRON representative.

The relative alignment accuracy of OMRON AMRs, with and without these features, is presen-
ted in the following table:

Table 10-2. FLOW Core Goal Alignment Features

Feature Alignment
Accuracy

Condition

Standard ± 100 mm Standard FLOW Core Feature

PrecisionDrive without CAPS
license

± 25 mm
± 2.0°

Standard FLOW Core Feature

PrecisionDrive with CAPS
license

± 8 mm
± 1.0°

Licensed Feature (CAPS)

High Accuracy Position System
(HAPS)

± 10 mm Not licensed, requires optional hardware
(sensors) to work

Using Speech and Sound Tasks

Speech and sound tasks control the AMR's audio. As the AMR navigates the operating space,
it can (for example) play a sound file while driving, make a noise to alert anyone in the area
that it is entering a room, or announce what task it intends to perform next.

The speech and sound tasks combine instant and non-instant tasks, as shown in the following
table.

Instant Tasks Non-instant Tasks

l playInstant
l sayInstant
l sendSoundInstant
l sendSpeechInstant
l playBackgroundSound

l play
l say
l sendSound
l sendSpeech

Instant tasks send audio to the AMR as it continues on its path. Non-instant tasks cause the
AMR to wait until the speech or sound is done playing. For example, if you want the AMR to
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announce that it is entering a room and then wait for a moment to allow people to get out of
its way, use the say task rather than the sayInstant task.

The AMR speaks say tasks with a computerized voice. Play tasks play a sound file on the
AMR. Sound tasks encode a file from the AMR and send it out to all MobilePlanner instances
connected to that AMR.

To Use Speech and Sound Tasks

NOTE: Speech and sound tasks are normally enabled by default.

1. Click the Config Button, then click on the Robot Interface tab, then click on A/V Config,
and enable the Audio parameter (click the checkbox). For more details, refer to Con-
figuring the AMR on page 154.

2. For sound tasks, ensure that the sound file is stored on the AMR. You can use File
> Upload/Download.

3. Click theMap Button, then click the Build tab.

NOTE: Ensure that Show Robot is OFF, or you will not be able to draw
or edit objects in the map pane.

4. In the Source Lists pane, click the Robot Tasks tab to view tasks currently available on
the AMR.

5. Add the speech or sound task to the goal, route, or macro. For details, see Assigning
Tasks on page 172.

6. Enter the parameter values for the assigned task. If using a speech task, enter the text
for the AMR to speak in the Value field. If using a sound task, enter the name of the
sound file in the Value field. If needed, click the Browse Button to search for the sound
file.

7. Click OK to accept the parameter value and save any changes.

Using Sound Files with Tasks

Both the play and sound tasks use sound files. Play tasks play a file on a specified AMR.
Sound tasks encode a file from the AMR and send it out to all the MobilePlanner instances con-
nected to that AMR.

All sound files must be in AIFF WAVE (.wav files), .ogg files, or MP3 format.

Additional Information: Audio files with an encoded volume over 0.5 dB can
cause playback issues when played at high volumes on the AMR. If playback
issues occur, lower the AMR's playback volume or check the encoded volume
level of the audio file and reduce if it is over 0.5 dB.

Adjusting the Audio

You can use the MobilePlanner software to adjust the audio input and output (if turned ON),
and adjust both the software and AMR audio using the audio slide bars.
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1. Click theMap Button from the main window to display the map window.

2. Click theMonitor icon to display the list of available items to monitor (see below).

Figure 10-13. MobilePlanner Monitor Drop-down Menu

3. Click Audio to display the Audio dialog.

Figure 10-14. MobilePlanner Audio Dialog Box

4. Click on the slider bar and drag it left or right to adjust output volume.

5. If desired, you can enter a text string the AMR will speak (when configured to do so).

6. Click OK when done.

Accessing and Adjusting the Audio Parameters

Click Config > Robot Interface > A/V Config to display audio and video parameters.
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Figure 10-15. MobilePlanner A/V Configuration Page

I/O Tasks - LD-series AMRs

Digital Input/Output (I/O) provides an interface between the AMR’s equipment and sensors
and the payload which often requires power (I/O inputs and outputs can, for example, control
conveyor rollers). If you have an AMR with a conveyor payload aboard, you can use digital
I/O to turn the rollers ON and OFF, check sensor inputs, and execute one or more macros
based on a tote’s location (whether the tote is on the AMR’s conveyor or on the feed conveyor).

The LD-60, LD-90, and LD-250 AMR cores provide 16 digital inputs and 16 digital outputs,
and have a User Interface connection for creating custom user interfaces with the AMR’s E-
Stop, ON, OFF, keyswitch, and brake-release buttons.

With MobilePlanner, you can:

l Configure core digital inputs and outputs, and give these inputs and outputs aliases
which make it easier to use them when needed.

l Create custom I/O tasks that turn payload power on or off to activate automatically-
toggled proximity sensors.

l Detect single inputs and execute specific macros.

Using I/O Tasks

Custom inputs and outputs are digital inputs, outputs, and peripheral power outputs. You
make them custom by setting their input type to custom and (optionally) giving them an alias.

NOTE: Making theses tasks custom allows them to be shown in the MobilePlan-
ner I/O window, as well as in the optional Touchscreen.

1. Click Config > Robot Interface > Core Digital Inputs (or Core Digital Outputs).

2. Configure the devices, then click Save.
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3. In MobilePlanner’s main menu, click File > Open to open the map you want to edit.

NOTE: Ensure that Show Robot is OFF, or you will not be able to pro-
ceed.

4. Click theMap Button, then click the Build tab.

5. In the Source Lists pane, click the Robot Tasks tab to view the tasks currently available
on the AMR.

6. Add the task to the route, goal, or macro. See Assigning Tasks on page 172 for details.

Digital Inputs

To configure the digital inputs, click Config > Robot Interface.

Tasks: customInputsCheckAll and customInputsCheckAllInstant

These tasks check whether all specified custom inputs trigger and properly execute a macro.

Parameters Description

timeout Duration (in seconds) to check the custom inputs.

timeoutMacro Macro to invoke if no inputs are triggered before the timeout.

triggerMacro Macro to invoke if all inputs are triggered before the timeout.

input<n>
n = 1 to 8

Names of the custom inputs to check. Prefix the names with '!' to check
the inverted value.

Tasks: customInputsCheckAny and customInputsCheckAnyInstant

These tasks check whether any of the specified custom inputs trigger and properly execute a
macro.

Parameters Description

timeout Duration (in seconds) to check the custom inputs.

timeoutMacro Macro to invoke if no inputs are triggered before the timeout.

triggerMacro Macro to invoke if any of the inputs are triggered before the timeout.

input<n>
n = 1 to 8

Names of the custom inputs to check. Prefix the names with '!' to check
the inverted value.

Tasks: customInputsCheckEach and customInputsCheckEachInstant

These tasks check the custom inputs and executes a particular macro for each triggered input
(on only if ‘tasksForBetterCustomIO’ is ON).
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Parameters Description

timeout Duration (in seconds) to check the custom inputs.

timeoutMacro Macro to invoke if no inputs are triggered before the timeout.

input <n>
n = 1 to 8

Names of the custom inputs to check. Prefix the names with '!' to
check the inverted value.

input <n> macro
n = 1 to 8

Macro to invoke if input <n> is triggered before the timeout.

Digital Outputs

To configure digital outputs click Config > Robot Interface.

Task: customOutputOff

This task turns off the specified custom output.

Parameters Description

output Name of the custom output to turn OFF.

Task: customOutputOn

This task turns on the specified custom output.

Parameters Description

output Name of the custom output to turn ON.

I/O Tasks - HD-1500 AMRs

If I/O tasks need to be configured for the HD-1500 AMR, contact your local
OMRON representative.

Setting Up Special Tasks

Special tasks allow you to define custom responses to events that the AMR might encounter.
You can set up and use tasks for the AMR to perform in certain situations, such as when enter-
ing certain areas, before or after docking, or at every goal. Special Tasks can also be used as
attributes for coordination between specific AMR sub-groups and map objects.

The Special Tasks below are detailed in the following sections:

l Custom Responses.
l Custom Tasks.
l Performing a task before or after every goal.
l Performing a task at a dock.
l Queuing Manager tasks.

NOTE: Special events don't have to be unusual. Going to a Goal or Point can be
a special event.
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To Customize AMR Operation:

1. In MobilePlanner, click theMap Button, then click the Build Tab.
2. In the Editable Lists pane, click on the Special tab.

Since you cannot assign a goal to a Special task, the Goals tab is grayed out. Also, select-
ing one of the special events in the Special tab only enables instant tasks. All custom
responses have to be instant, but other lists in this tab can allow non-instant tasks.

Figure 10-16. Build Tab Lists - Details

3. In the Source Lists pane, highlight a task from the Robot Tasks tab and drag it to the
desired special event in the Special tab.

NOTE: Most custom responses (e.g., Dock responses) have to be instant;
all others can be non-instant.

Custom Responses

You can customize the AMR's operation using the Custom Responses found in the Special tab.
The predefined conditions or events that trigger a custom response include:

NOTE: The following list is not an exhaustive list. The Custom Responses
defined for a particular AMR depend on the parameters that you enabled or dis-
abled. For configuration details, see Setting the Configuration Parameters on page
157.

l Fault responses.
l Localization.
l Path Planning (Failed, replanning).
l ‘sayInstant’ tasks (such as ‘excuse me’).
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l Bumping into something (has four sub-events, based on what the AMR is doing when
the bump occurs).

l Map Creation (has two sub-events, for starting and stopping a scan).
l Patrolling a route (has four sub-events).

Using custom responses, you can make the AMR talk when it encounters one of these events,
and tell the people around the AMR what to expect.

All custom responses must contain instant tasks, such as sayInstant. Although the conditions
that trigger a custom response are predefined for the AMR, you can customize the AMR's oper-
ation by adding one or more instant tasks to these events. For example, if the AMR bumps
something in front of it, the AMR can respond appropriately (for example, the AMR could
speak a phrase when it bumps into something).

Events automatically trigger the custom responses that make the AMR respond to its envir-
onment.

If there is no task associated with a specific Custom Response, the AMR will not do anything
special when that condition occurs.

Custom Tasks

Custom Tasks allow AMRs to filter their recognition of objects on the map for more fine-tuned
control of fleet movements. Custom Tasks are set for both the AMR and for goals on the map.
Once a Custom Task has been applied to a goal, only AMRs that also have the Custom Task
will accept pickup or dropoff jobs at the goal. In this way, Custom Tasks can be used and
implemented like a label or tag that designates specific goals and AMRs on the fleet as com-
patible with each other. Goals with no Custom Task applied will still be compatible with all
AMRs in the fleet.

Custom Tasks are assigned to an AMR in Configuration, and are a subset of Instant Tasks.
When assigned to an AMR family, Custom Tasks are inherited to all AMRs lower in the fleet
hierarchy level. Custom Tasks can only be added to AMR groups at lower fleet hierarchy
levels, not removed.

Figure 10-17. Custom Task applied to AMRs in the fleet hierarchy

Custom Tasks are assigned to goal objects on the map in the Editable Lists pane. Tasks can be
applied to goals in either the Before Goal or After Goal lists. Once a Custom Task is applied,
only AMRs in the fleet that share this Custom Task will recognize the goal.
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Figure 10-18. Custom Task applied to a map object in the Build Tab

Required Custom Tasks

Required Custom Tasks are an extension of Custom Tasks for other types of map objects, bey-
ond goals. For example, specific AMRs can be configured to recognize and respect cetain for-
bidden zones that other AMRs would be able to move through unimpeded. Required Custom
tasks can also be used with path planning to establish different behaviors between AMR
groups, like setting different clearances for LD-60 and LD-90 AMRs.

Required Custom Tasks can be added to most map objects that apply to individual AMRs,
including forbidden areas, path planning sectors, and movement parameter sectors. They are
not supported by map objects that are used by the Fleet Manager to coordinate multiple AMRs,
such as managed motion sectors and single robot sectors. If a map object has a non-empty
name and supports Required Custom Tasks, then the map object is added to the Special tab.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 200



201 Fleet Operations Workspace Core User's Manual 20569-020 Rev. E

10.1  AMR Tasks

Figure 10-19. Tooltip display showing Required Custom Task on a map object

Performing a Task Before/After Every Goal

Special tasks can include instant and non-instant tasks the AMR performs before the AMR
departs for a goal or after it reaches any goal.

Drag instant tasks from the Source Lists pane to either event in the Special tab in the Editable
Lists pane.

NOTE: You can override these tasks for specific goals within specific routes by
un-checking the before/after this goal checkbox.

Performing a Task at a Dock

Special tasks can include instant tasks the AMR performs when docking. The AMR already
has a set of defined docking events, including:

l Forced dock
l Idle dock
l Requested dock
l Driving to dock
l Driving into dock/docked
l Dock now unforced
l Dock now forced
l Undocking/undocked

You can add instant tasks to these docking events (e.g., have the AMR announce it is going to
dock because it is ‘idle.’). Drag instant tasks from the Source Lists pane to the appropriate
event in the Special tab in the Editable Lists pane.

Queuing Manager List

AMRs can perform a variety of special tasks when they reach goals. For example, you can use
the JobTypeCheck task to specify different macros depending on whether a goal is pickup,
dropoff, or neither. Other examples of special tasks include:

l Before/After Pickup
l Before/After Dropoff
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Drag instant tasks from Source Lists to a queue-related event in the Special (Editable Lists
pane).

Editing a Special Task in the Editable Lists Pane

1. Right-click on the task you want to edit.

2. In the pop-up window, click Edit.

If the task has associated parameters, the following dialog box opens:

Figure 10-20. MobilePlanner Parameter Description Dialog

Click in the Value field to add and edit the parameter’s value . Click on a parameter to
see its description.

3. Click OK when done.

Copying a Special Task from the Editable Lists Pane

1. Right-click on the task you want to copy.

2. In the pop-up window, clicking Duplicate creates a copy of the task.

3. Drag the copied task anywhere within the current tab.

Deleting a Special Task from the Editable Lists Pane

1. Right-click on the task you want to delete.

2. In the pop-up window, click Cut (or press the Delete key) to remove the selected task.
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Editing a Task

To edit a task, from the Editable Lists pane:

1. Right-click on the task you want to edit.

2. In the pop-up window, click Edit.

3. Click inside the Value field to edit the value for each parameter.

NOTE: You can reorder or move tasks to another goal/macro/route by dragging
them there.

Copying a Task

To copy a task, from the Editable Lists pane:

1. Right-click on the task you want to copy.

2. In the pop-up window, clicking Duplicate adds a copy of the task.

3. Drag the copied task to any position within the current tab.

Deleting a Task

To delete a task, from the Editable Lists pane:

1. Right-click on the task you want to delete (or click, the press the Delete key).

2. In the pop-up window, clicking Cut removes the selected task.

10.2 AMR Jobs Overview
Jobs are basic activities for the AMR(s) to execute. ARCL and protocols within the Integration
Toolkit (ITK) can send job requests to the Fleet Manager for assignment to an AMR.

NOTE: Jobs are the recommended method for commanding the AMR or fleet of
AMRs.

Jobs typically have one or two job segments (if queueMulti is enabled). All segments are clas-
sified either as PICKUP or DROPOFF.

l PICKUP: A PICKUP job request tells the Fleet Manager that any available, appropriate
AMR can be assigned a PICKUP task.

l DROPOFF: A DROPOFF job request tells the Fleet Manager that only a specific AMR
can be assigned a DROPOFF task.

Once the Fleet Manager receives the job request from ARCL or the ITK, it assigns a job ID and
unique job segment ID (or, you can optionally assign a job ID).

Job Priorities

MobilePlanner prioritizes submitted job requests either by Non-First-In-First-Out (Non-FIFO) or
First-In-First-Out (FIFO) priority. The requestor can specify the job priority, or jobs can use the
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default value for queuePickup, queuePickupDropoff, and queueDropoff commands. You can
enable this in Config > Fleet tab > Fleet Features, FleetQueuingConsumptionMethod.

l Non-FIFO: Non-FIFO executes the highest priority jobs first, followed by lower priority
jobs. Its goal is to minimize the AMRs’ driving distance.

l FIFO: In FIFO, the system prioritizes jobs by which was submitted first, second, and so
forth.

The default PICKUP priority is 10, and the default DROPOFF priority is 20. You can expedite a
job by raising the pickup priority, while keeping the dropoff priority the same. For example,

l queuePickupDropoff goal1 goal2 10 20

l queuePickupDropoff goal3 goal 4 10 20

l queuePickupDropoff goal5 goal6 11 20

If you queued all of the above jobs at the same time, the third job’s higher priority means the
AMR will execute the third job before jobs 1 and 2. Otherwise, job1 or job2 will start.

Job vs. Job Segment

All submitted jobs carry a specific JobID (also referred to as the “job). Each part of a job is a
‘job segment,’ even if the job has multiple parts to it (for example, a Pickup-Dropoff sequence).

Custom Job ID

MobilePlanner uses the jobID to track the status of a request. A job ID must be unique among
active jobs. Active jobs can share a jobID with previously completed or cancelled jobID still in
the system. You can use a custom job ID that matches some other information in your auto-
mation system when submitting the pickup or pickupDropoff request.

Basic Job Commands

The following are some basic example job commands:

l “queuePickup goal1”: submits a request to send any available AMR to “goal1.”

l “queuePickupDropoff goal1 goal2”: requests that any available AMR first drives to
“goal1,” then, once completed, drives to “goal2.”

l “queueCancel jobid JOB7”: immediately cancels job7, regardless of whether an AMR is
performing that job.

Basic Job-Supporting ARCL Commands

The following ARCL commands support job queuing:

NOTE: In ARCL command syntax, commands are not case sensitive, values in
angle brackets < > are required, and values in braces [ ] are optional. Refer to the
Advanced Robotics Command Language Reference Guide (Cat. No. I617) for more
information.

l queuepickup <goal_name> [priority] [job_id]

l queuepickupdropoff <PICKUPgoal_name><DROPOFFgoal_name> [PICKUPpriority]
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[job_id]

l queuecancel <canceltype> <cancelvalue> [echo_string] [reason]

l queuedropoff <goal_name> [priority] [job_id]

l queuequery <querytype> <queryvalue> [echo_string]

l queueshow [echo_string]

Refer to the Fleet Operations Workspace Core Integration Toolkit User's Guide (Cat. No. I637)
for information about using RabbitMQ, REST, or SQL to submit jobs.

10.3 Using the Route Builder
With MobilePlanner Route Builder, you can set up tasks for the AMR to perform and goals for
it to drive to. You can also customize AMR operation and build routes for the AMR to follow.
All of this information is embedded into the map file. Once you download the map file to the
AMR, you can use MobilePlanner to drive the AMR in its operating environment, and perform
tasks.

NOTE: Jobs are preferred over routes in industrial environments.

Use the Route Builder to set up the following:

l Tasks: Activities that the AMR can perform, such as going to a goal or checking
sensors. Tasks give the AMR useful work to perform. These tasks are already available
on the AMR, but need to be defined and associated with the map that you are creating.

l Goals: Virtual destinations that the AMR drives to in its environment. These goals are
defined in the map, and represent real-world places in the operating environment.

l Macros: Containers for sequences of tasks and goals. Once these macros are created, you
can select the macro, rather than all of the individual tasks and goals, for the AMR to
perform. You only have to define a macro once, but can use it as many times as neces-
sary. You can also use macro templates, which are special macros that can accept
simple parameters. You define parameter types when you create a new macro template,
and specify the values when you use the template in another macro, route, etc.

l Custom responses: Actions such as making the AMR talk (e.g., when its path is
blocked, fails the path, or does global replanning, etc.), performing a particular or
sequence of tasks at all goals, when docking, or when a special event (such as a bump
or E-Stop) occurs.

l Routes: A "to do" list or a series of tasks, goals, or macros for the AMR to follow. An
AMR can execute a route continuously, unlike macros.

The Route Builder Interface

MobilePlanner’s Route Builder allows you to set up macros, tasks, goals, and routes for the
AMR to follow.

Click theMap Button, then click the Build tab.

The Route Builder (Build tab) appears in the window, as shown in the following figure.
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Figure 10-21. The MobilePlanner Map Workspace with the Route Builder Open

The Route Builder Elements

The Route Builder has two panes: Source Lists and Editable Lists. Each section uses tabs to
switch between the different available options.

Figure 10-22. The Route Builder Elements

The Source Lists pane lists available AMR tasks, goals, and macros you can add to new
routes, goals, macros, and special tasks.

The Editable Lists pane displays routes, goals, macros, or special tasks. The tabs allow you to
switch between the different types of objects that you can build.

You can drag Source Lists objects into any of the Editable Lists routes (or macros) you are
working on, or use the arrow icon between the lists.

Source Lists: Robot Tasks, Goals, and Macros Tabs

The tabs in the Source Lists pane display the tasks, goals, and macros you can use in building
new routes, adding tasks to goals, and building macros and special tasks.
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NOTE: Some of the Robot Tasks listed below need to be specifically enabled by
clicking the Config Button, then clicking the Robot Operation tab, and the Task
Features section.

l Robot Tasks: Lists the tasks available for creating new objects (routes, macros, etc.) on
the map. Tasks are AMR and accessory-related operations, such as moving the AMR,
talking, or playing a sound. These tasks are already available on the AMR, however
you must include them in one of the Editable List items for the AMR to know when and
where to perform them. For more information on using tasks refer to AMR Tasks on
page 172.

l Goals: Lists the goals available for creating routes or macros. Goals are locations on the
map that are destinations for the AMR. For more information on using goals, see Creat-
ing and Adding Goals and Docks on page 108.

l Macros: Lists available macros which you can add to tasks or goals. Macros are
reusable containers for multiple tasks. For more information refer to Creating Macros on
page 210.

For detailed information about a task, goal, or macro, right-click on the item and select Descrip-
tion.

Figure 10-23. Accessing the Task Description

Click on the task parameter to read a brief description of the selected task. The figure below
shows an arbitraryServerSend task. To set up different tasks and their parameters, refer to the
specific task (Using Audio Tasks, for example).
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Figure 10-24. arbitraryServerSend Task Description

Editable Lists: Routes, Goals, Macros, and Special Tabs

l Routes: Lists created routes, and allows you to build new routes. For details, see Creat-
ing Routes on page 218.

l Goals: Lists created goals or destinations. You can add tasks for the AMR to perform at
the specified goal. For more information on using goals, refer to Creating and Adding
Goals and Docks on page 108.

l Macros: Lists created and defined macros, and allows you to create new macros. Refer
to Creating Macros on page 210 for more information.

l Special: Used to customize AMR operation. Custom tasks allow you to have the AMR
perform certain activities at every goal or at a dock. They also allow you to program the
AMR to take special actions when specific events happen. For more information, refer to
Setting Up Special Tasks on page 197.

Macros

Macros are reusable sequences of tasks that have their parameters set when you add them to
the macro. So every time you use a macro, the tasks inside use the same settings. Macros are
extremely effective if you have groups of tasks that you need to repeat in multiple places.

For example, you might have an AMR delivering parts to various places. At each of the mul-
tiple delivery locations, it needs to navigate to each, pause, announce its arrival, wait for the
part recipient to retrieve the part, then move on to the next delivery site. Instead of manually
programming each of these tasks at each goal, you can use macros to replicate this same func-
tionality across multiple goals.

You can create macros in Editable Lists (in the Build pane) by clicking the New Button. Then,
drag the appropriate tasks from the Robot Tasks list (under Source Lists) into the macro in the
desired point. After adding the tasks to the macro, you can reorder and reconfigure them as
needed.

Macro Templates

Macro templates are simple, text-only features for adding simple parameters to macros.
Allowed parameters for macro templates are named $1 to $9. They do not allow variables or
expressions.
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To create a macro template, click theMap Button, Build tab, then use the New dropdown
menu directly below the Editable Lists pane and selectMacro Template.

For details, see Macro Templates on page 213.

The Build Tab

The Build tab allows you to create macros, and add tasks for the AMR to perform.

To display the route building tools, click the Build tab. The Build tools, shown in the following
figure, are displayed on the left side of the map window. The Build tab displays two scrollable
panes, each using tabs to organize the lists available for use.

Figure 10-25. The Source Lists and Editable Lists Pane

The following table lists the toolbar icons and describes their functions.

Item Description

Source Lists pane Contains lists of AMR tasks and goals that you can use to create
macros or routes for the AMR to navigate. You can also put mac-
ros in other macros as well. To view the different lists, select
the appropriate tab.

Editable Lists pane Contains lists of all current routes, goals, andmacros. You can
also add new tasks the existing lists that tell the AMRwhat to
do in certain circumstances, such as after reaching a goal,
when docking, andwhen specific event occur, such as bumping
into something.
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Item Description

If the MobilePlanner workspace is filled with multiple windows
and some tabs are not visible, move between tabs using the
arrows.

New Route/Macro Button Creates a new route and/or macro (depending on the window
in which you are working), and adds it to the Routes tab.

Pick Goal Button When ON and a route is selected, lets you click goals on the
map, to add to the route. After adding the goals to the route,
you can drag the goals up/down to set their order.

For more information on creating tasks, goals, routes and macros, see Using the Route Builder
on page 205.

Creating Macros

Macros are containers that hold a series of tasks, goals, and other macros. After you create a
macro, you can reuse it as many times as needed. Macros can hold goals and use tasks with
conditionals, and they can be embedded within macros and other tasks. As a result, macros
are very versatile.

To Create a Macro:

1. Click theMap Button, then click on the Build tab.

The Source and Editable Lists appear on the left side of the map.

2. Under Editable Lists, click theMacros tab.
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Figure 10-26. MobilePlanner Build Tools - Macros Tab

3. Click on the New Button an the bottom of the Editable Lists pane.

This adds a new macro to the Macros tab which, by default, has the name "Macro1."
This new macro name increments by 1 with each new added macro. See Renaming the
Macro on page 213 for directions on changing the macro name.

4. Highlight a task from the Robot Tasks list and either drag it to the desired macro in the
Macros tab or click the Add arrow (between the two panes).

The new macro expands with each added task, as shown the following figure.

Figure 10-27. Macro Detail

5. Click the Goals tab to access the goals available to add to the macro, then drag the
desired goal into the new macro you are creating. You can also pick a goal from the dis-
played map to add to the macro (see Picking a Goal from the Map on page 212 for
details).

6. Click theMacros tab to access existing macros. You can then drag an existing macro
into the new macro.
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The macro below shows an example of tasks, a goal, and a macro named "Greeting" added to
the new Macro1 macro.

Figure 10-28. Macro Details

Using the Add Button

In addition to dragging a task, you can use the arrow (Add) Button to add a task to the macro.

1. Click on theMacros tab in the Editable Lists pane.

2. Highlight the macro to which you want to add a task, goal, or macro.

3. Click on the Robot Tasks, Goals, orMacros tab from the Source Lists pane.

4. Select the task, goal or macro you want to add to the new macro.

5. Click the Add Button to add the task, goal, or macro.

If parameters are associated with the task, a dialog box appears that allows you to
adjust parameters appropriately.

For specific parameter information, refer to the task type (such as a wait task) for more
information.

Picking a Goal from the Map

You can add goals to macros by clicking the goal on the map. This allows you to add multiple
goals within the same vicinity.

1. Be sure that the goals you want to add to the macro are visible in the map window. For
details, see Using MobilePlanner Software on page 52.

2. From the Editable Lists pane, select theMacros tab, then select the appropriate place in
the desired macro to add the goal.

3. Click the Pick Goal Button at the bottom of the pane (next to the New Button).

4. In the map, click on the goal to add the goal to the macro (you can select multiple goals
without having to click on the Pick Goal Button each time).

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 212



213 Fleet Operations Workspace Core User's Manual 20569-020 Rev. E

10.3  Using the Route Builder

To Move the Goal within the Macro:

1. Click on the goal name in the macro list.

2. Drag it to the position you want the goal to be.

Renaming the Macro

1. Right-click on the macro you want to rename.

2. In the pop-up window, click Rename to change the macro name to editable text.

3. Type in the new name for the macro.

Copying a Macro

1. Right-click on the macro you want to copy.

2. In the pop-up, click Duplicate with the left mouse button.

A copy of the macro appears in the Macros tab.

Deleting a Macro

1. Click the macro then hit the Delete key, or

2. Right-click on the macro you want to delete then, in the pop-up window, click Cut with
the left mouse button to delete the selected macro.

Macro Templates

Using macro templates, you can easily add a variable to a set of tasks. This makes reusing
macros or task sets with slight differences (depending on the goal or application) fast and
easy. For example, you can create macro templates for changing wait times, status to wait
with, line to log, activating a different IO, etc.

NOTE: To use macro templates, you must have (at minimum) MobilePlanner
4.4.0 and ARAM 4.8. If you are using a map created under an older version of
MobilePlanner, you will need to update it. After updating, it will not be back-
wards compatible with older MobilePlanner versions.

To update your map

1. In MobilePlanner’s main menu, click on Tools > Update Map Features.
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Figure 10-29. Update Map Dialog

2. Read the notes and information in the pop-up window, then click Continue to update
the map.

3. After updating the map, you will need to save and reload the map.

Macro Templates and Grouped Items will then be available for use, and there will also
be default group items such as door goals, docks, and cart transporters.

Creating a New Macro Template

1. In the Build pane, Editable Lists, click on theMacros tab, then click the New Button
drop-down arrow, and selectMacro Template.

Figure 10-30. New Macro Template Dialog

2. Enter a name and description for the template, and set variable number(s), type(s), and
descriptions.

Types can be Text, Integer, Double, or Boolean.

Type Allowed Value Default

Text (or
String)

Any letters or numbers Zero

Integer Number without decimal Zero
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Double Number either with or without a decimal Zero

Boolean True or False False

3. Enter up to nine parameters in the macro template.

Parameter names use ‘$1’ to ‘$9.’ You can enter a text description of each ‘$#’ variable
in the Description field.

4. Add tasks to the template.

Add ‘$#’ to call a variable (‘#’ is limited to previously defined parameters).

5. To add the new macro template, drag and drop from the Source list into the Editable
list.

Custom Groups

Using custom groups, you can define a reusable group of complex map objects, such as goals,
sectors, etc. This allows you to place repeatable tasks (e.g., cart goals) on your map quickly and
consistently, which helps to speed up application building time. Custom groups can interface
with macro templates. Once created, you can add grouped items from the build tab as you
would an advanced area.

Notes on using custom groups:

l You cannot edit or delete custom group definitions.
l You cannot modify originally selected map items, and they do not automatically
become members of a new group instance.

l You cannot nest groups. The software ignores groups already in the original selection
list.

l You cannot ungroup groups (i.e., you cannot convert them to top-level objects).

Custom groups also contain all tasks and macros (which you can individually edit) from
every goal and sector that you included in the group.

Creating a New Custom Group

NOTE: Update the map format, then create a backup of your map before cre-
ating the custom group.

1. Ensure Show Robot is OFF.
2. Highlight all map objects (goals, sectors, etc.) you want to include in the group.

3. Right-click on the map location that is the group’s anchor point (its origin), and select
Advanced > Create Custom Group.
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Figure 10-31. Create Custom Group Explanation Dialog

4. Read the information in the pop-up, then click Continue to create the custom group.

Figure 10-32. Create Custom Group Dialog

5. Enter the custom group’s name and description.

6. Click OK.

The new group will appear under the Custom Groups Button drop-down menu in the
Draw pane.

To edit a single item in the group, right-click and select the component you want to edit.

Adding a Grouped Item

After you create a grouped item, you can add it to the map as follows:

1. Verify that Show Robot is OFF.

2. In the Draw tab, click the Custom Groups drop-down arrow, and select a grouped item.
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3. Move the cursor (appears as a ‘pencil’) to the grouped item’s intended location, and
click to place the item on the map.

Figure 10-33. Add Grouped Item Dialog

4. Click OK to add the grouped item.

Adding New Goals to the AMR’s Current Location

MobilePlanner software's AMR monitor allows you to interact with the AMR (for example,
you can move the AMR to a new location or goal, then add a new goal where the AMR is loc-
ated).

1. Drive the AMR to the location where you want to add a goal or task (for details, see
AMR Driving Overview on page 90).

2. When the AMR is at the desired position, click the Item at Robot Button (in the toolbar),
and select Create Goal.



Chapter 10: Working with Macros, Tasks, and the Route Builder

Figure 10-34. Edit Goal Dialog

3. In the Edit Goal dialog, enter the information, then click OK.

Creating Routes

A route is essentially a "to do" list for the AMR. It is a series of ordered tasks, goals, and mac-
ros for the AMR to complete. Tasks are AMR and accessory-related operations, such as talking
or playing a sound, reading inputs, and triggering outputs.

Building Your Route

To build routes for the AMR, simply drag a task, goal, or macro from the Source Lists to the
Editable Lists > Routes tab, as described in the following procedure.

To Build a New Route:

1. Click the Build tab to display the Route Builder.

2. Click on the Routes tab in the Editable Lists pane.

3. Click on the New Button on the bottom of the Editable Lists pane to add a new route to
the Routes tab.

The default name for this new route is "Route1," and each new route name increments
by 1. See Renaming the Route on page 219 for details on renaming a route.

4. Highlight a task from the Robot Tasks tab (in the Source List pane) and drag it to the
desired route in the Routes tab.

The new route expands with each added task, as shown below.

Figure 10-35. Route Detail

5. Click the Goals tab to access the goals available to add to the route, then drag the
desired goal into the new route you are building. You can also pick a goal from the dis-
played map to add to the route, see Picking a Goal From the Map on page 219 for
details.

6. Click theMacros tab to access the macros available to add to the route, then drag the
desired macro into the new route you are building.

Using the Add Button

In addition to dragging a task, goal or macro into your route, you can use the arrow button to
add the task to the route.
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1. Click on the Routes tab in the Editable Lists pane.

2. Highlight the route to which you want to add a task, goal or macro.

3. Click on the Robot Tasks, Goals orMacros tab from the Source Lists pane.

4. Select the task, goal or macro you want to add to the route.

5. Click the Add Button to add the task, goal or macro to the route.

If parameters are associated with the task, a dialog box appears in which you can
adjust parameters appropriately. For specific parameter information, refer to the task
type (such as a wait task) for more information.

Picking a Goal From the Map

You can add goals to routes simply by clicking the goal on the map. This allows you to easily
add multiple goals to the route that are in the same vicinity on the map.

1. Be sure that the goals you want to add to the route are visible in the map window (see
Using MobilePlanner Software on page 52 for details on using the workspace).

2. From the Editable Lists pane, select the Routes tab.

3. Click on the Pick Goal Button at the bottom of the pane.

4. Highlight the route in which you want to add the goal.

5. In the map, click on the goal you want to add to the route.

This adds the goal to the route. You can select multiple goals without having to click on
the Pick Goal Button each time.

To Move the Goal within the Route:

1. Click on the goal name in the route list.

2. Drag it to the desired position.

Renaming the Route

1. Right-click on the route you want to rename.

2. In the pop-up window, select Rename to change the highlighted route to editable text.

3. Type in the new name for the route.

Copying a Route

1. Right-click on the route you want to copy.

2. In the pop-up window, select Duplicate with the left mouse button.

A copy of the route is displayed in the Routes tab.
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Deleting a Route

1. Right-click on the route you want to delete.

2. In the pop-up window, select Cut (or use the Delete key) with the left mouse button to
delete the selected route.

10.4 Managing Queuing
This section describes how to manage AMR job queues.

10.5 Queuing and Job Definitions
l Job - a single command issued to the Fleet Manager, consisting of one or more related,
ordered moves (job segments). Each job has a unique job ID.

l Job segment - one discreet move assigned to an AMR. A segment consists of a single
goal name, and you can define it as either a PICKUP or a DROPOFF job segment. The
goals might have tasks that are assigned to the AMR, which count as part of the job seg-
ment. Each job segment has a unique ID.

l Queue - a collection of requested jobs and job segments, stored on the Fleet Manager,
that are either assigned or waiting to be assigned to AMRs.

l Assigned Job - a job segment becomes assigned after the Fleet Manager has allocated an
AMR to perform the job. A job segment transitions from Pending to InProgress after
assignment.

l Pickup - a job segment that ends at a goal so that a payload is loaded onto the AMR. If
the first segment of a job is a PICKUP, then the Fleet Manager assigns this job to
whichever AMR it decides is most appropriate.

l Dropoff - a job segment that ends at a goal so that a payload is removed from the
AMR. A DROPOFF segment is handled only by the required AMR.

l Required Robot - certain job segments are serviced only by a specific AMR. For
example, the DROPOFF segment of a PICKUP-DROPOFF job must be handled by the
same AMR that performed the pickup. Thus, whichever AMR handles the initial
PICKUP job is the required AMR for the DROPOFF.

The Fleet Manager enables you to queue jobs. It can accept multiple requests for AMRs, and
then select the best AMR for each job, based on the criteria you specify. It sends the selected
AMR to the requested location. It tracks the status of jobs and AMRs as they perform their
assigned jobs.

The requests that are queued include:

l a request for any AMR to be sent for a pickup (PICKUP) for which the delivery des-
tination (DROPOFF) is not yet known (queuePickup ARCL command).

It is assumed that the delivery destination is communicated directly to the AMR that
responds, prior to completion of the pickup.

l a request that a specific AMR drive to a particular goal (DROPOFF) (queueDropoff
ARCL command).
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This is communicated directly to the AMR, but is queued and tracked by the Fleet Man-
ager.

l a request that an AMR be sent for a job that has predetermined pickup and dropoff des-
tinations (queuePickupDropoff ARCL command).

To complete the job the AMR requires no further job commands.

The Fleet Manager manages jobs associated with either a PICKUP or a DROPOFF goal. Any
AMR tasks that are associated with the goals are executed at the proper times, though they are
not managed as separate jobs in the queue.

We recommend that you use the task pause when an AMR arrives at its destination, although
this is not managed by queue. Use the associated pauseTaskCancel task to signal dismissal after
the AMR is loaded or unloaded. You can trigger this task either by a manually-activated but-
ton, or by an automated system event.

When the Fleet Manager receives a request, it does the following:

1. Queuing

l The request is assigned a default priority (unless another priority is
specified) and put into the queue.

Pickup/Dropoff requests are entered as two separate jobs - a pickup, and a
dropoff.

Each segment has a unique queue ID, as well as a job ID that tracks the entire
pickup/dropoff sequence.

l Queuing enables job cancellation.

2. Dispatching

l An AMR is selected, based on the criteria you specified.

l The AMR is sent to the goal.

3. Tracking

l The queuing manager monitors the AMR and job status.

l The job is deleted from the queue when the request is satisfied, or is requeued if
the job fails.

Jobs might be in one of six states:

l Pending - new, unassigned jobs.

l In Progress - jobs that are being actively processed.

l Completed - jobs that were successfully processed.

l Failed - jobs that failed, due to reasons such as a blocked path or E-Stop.

l Canceled - jobs that were manually canceled with the queueCancel command.

l Interrupted - jobs that have been interrupted by an Operator manually controlling
the AMR. These jobs are reassigned after a brief pause.
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10.6 Queuing Examples
The following flowcharts represent sample usage scenarios, and require some application-layer
support to fully implement.

The following flowchart illustrates a simple pickup and delivery cycle. Other factors, such as
state of charge, can alter this flow.
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Figure 10-36. Manual Queuing Cycle
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Figure 10-37. Fully-automated Queuing Cycle

10.7 Queuing Parameters
You configure various parameters to specify how the Fleet Manager processes queued requests.
You set most of these parameters from within MobilePlanner. See Using MobilePlanner Soft-
ware on page 52.

To access these parameters from the Fleet Manager:

In MobilePlanner click Config > Robot Operation > Queuing Manager.

The parameters that control the way that the Fleet Manager handles queuing are:

l IdleTimeUntilResume - Number of minutes to wait, after an AMR becomes available,
before automatically resuming an interrupted job.

If an AMR has recently booted, or recently operated manually, then this is the number
of minutes that the queuing manager waits before assigning any new jobs to this AMR.
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The parameter supports decimal numbers (such as 0.1 minutes for 6 seconds).

l LowStateOfCharge - This is the state-of-charge (SOC) below which the queuing man-
ager no longer assigns new jobs to that AMR. If an AMR is below this state of charge
when it completes a job, it is sent to dock.

The AMR continues its assigned jobs until it reaches the SOC limit set by the value of
the AutoDockStateOfCharge parameter. Consider the following constraints:

o An AMR drives to a docking station any time that its state of charge falls below
the limit set for AutoDockStateOfCharge even if it is performing a job. This is an
AMR-level parameter, not visible or settable on the Fleet Manager.

o We recommend that at least a 10% difference between LowStateOfCharge and
AutoDockStateOfCharge, to make sure that the AMR does not drive to a docking
station while performing a job.

o An AMR docks only if you set AutoDock to True.

l DefaultDropoffPriority - The default priority to use in all dropoff requests to the
queuing manager.

l DefaultPickupPriority - The default priority to use in all pickup requests to the queuing
manager.

l DeleteCompletedItemsMinutes - Number of minutes to keep completed jobs.

l MaxNumberOfCompletedItems - Maximum number of completed jobs to keep.

l EnableParking - Sends the AMR to a standby goal after it completes its jobs.
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The following screen shows configuration parameters for queuing:

Figure 10-38. Queuing Manager Parameters

The following list shows the commands available for queuing.

l CancelQueueId

l CancelQueueJobId

l DisplayDeliveryQueue - Presents a pop-up window showing the delivery queue.

l DisplayShowRobot - Presents a pop-up window that shows the status of all AMRs in
the fleet.

l QueuingLog

l QueuingStats

To find these parameters in MobilePlanner, click Config > Robot Operation > Queuing Man-
ager.

10.8 Manually Clearing (Flushing) the Entire Queue
For a Fleet Manager, using SetNetGo, you can flush the queue via the Software page, and the
ARAMCentral Settings tab. Check the box next to recoveryEnterpriseQueuingFlush and click
apply. This will restart the Fleet Manager, and flush the queue. After the Fleet Manager is
restarted, uncheck the checkbox.

Alternatively, for either a Fleet Manager or an AMR operating in single robot mode, you can
open the configuration window using MobilePlanner, then select the Debug category and find
the section called Custom Arguments. Add a custom argument -
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recoveryEnterpriseQueuingFlush, and then save the configuration. This will restart the Fleet
Manager or robot and flush the queue. After restarting, this parameter will be removed from
the configuration.
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This section describes managing traffic flow in your operating environment. Whether you are
using a single AMR or a fleet of AMRs, defining how the AMR moves within the space allows
you to better control the AMR's behavior. As a result, you can prevent the AMR from running
into problems, allowing it to complete the tasks assigned to it more efficiently.

In MobilePlanner, you can add objects and areas to the map and manage how the AMR
moves through its environment. You can add areas that direct or restrict traffic, and that con-
trol speed and docking behavior.

11.1 Understanding Traffic Control
MobilePlanner provides traffic control guidelines for the AMR to determine the best path
through the operating space. You can control AMR traffic by adding areas to the map that tell
the AMR which direction to go, how fast to drive, or how many AMRs you want to allow in
an area at one time. With MobilePlanner, you can add these features and more to the map.

This section discusses the following traffic control features:

l Using Preferred Lines on page 241

l Using Preferred Directions on page 243

l Using Forbidden Lines and Areas on page 248

l Adding Switchable Forbidden Lines and Areas to the Map on page 249

l Using Resisted Lines and Sectors on page 252

l Using Need-to-Enter Sectors on page 255

l Using Single AMR Sectors on page 256

l Controlling AMR Speed on page 246

11.2 Traffic Control Concepts
In environments with more than one AMR, managing traffic becomes increasingly more crit-
ical. The main goals in managing traffic flow are safe and efficient operations, and minimizing
traffic jams and collisions. The following sections describe some of the more important traffic
control concepts.

Taxi Line (Multi-Robot Standby Goal)

Much like a row of taxis waiting outside the airport, the concept allows multiple AMRs to
approach and arrive at the same Standby goal (called a ‘Multi-Robot Standby’ goal), in
sequence, without bunching up and causing a traffic jam.

The Multi-Robot Standby (MRS) goal acts as a traffic control tool. The MRS goal extends the
standard Standby map object to enforce sequenced queuing for multiple AMRs at a single start-
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ing point, each of which then moves linearly, in sequence to an end point. Along the way, the
AMRs become available as they reach the end of their ‘after’ task.

The following figure shows the general design. The MRS start point is at the left, the MRS end
point is on the right.

Figure 11-1. Taxi Stand (Multi-Robot Standby) Goal Design

An ideal implementation is at a map corridor that frequently becomes congested with multiple
AMRs. By placing the start point some distance from the goal (for example, at the corridor
entrance), the AMRs move through the corridor in sequence and reach the end point of the
‘after’ movement near the corridor’s exit. Another ideal implementation is for high throughput
sources of parts that need to go to many places (like a plant that has a few gantries serving a
few hundred goals. The AMRs waiting in line near the source means a much higher through-
put.

Implementing Taxi Line

Using this feature requires setting the Boolean ‘AllowMultipleRobots’ on standard standby
objects (standbys with this Boolean flag active become Multi-Robot Standbys), and each goal
using a nearby MRS must also have a Managed Destination sector placed over it, with the
‘AlwaysBuffer’ parameter enabled, and the sector’s ReservedBuffer parameter set to the name
of the MRS.

Figure 11-2. Taxi Stand Implementation Example

NOTE: You can only use MRSs as ReservedBuffers. An MRS with no sector ref-
erencing it as a ReservedBuffer will display an error when saving the map, and
will be ignored during normal operations. Each MRS can only be reserved by
one map object.

A typical implementation is to place a standard goal on the map to use as the end point of the
buffering line. The figure below shows how this would work with a single AMR (the dashed
lines are for illustrative purposes only - they do not appear in the map).
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Figure 11-3. Taxi Stand (Multi-Robot Standby) Goal Design, Single AMR Use

As shown above, each AMR drives to the MRS start point (line 1), rotates to the correct pose
(line 2), signals the Fleet Manager of its arrival, then executes an ‘after’ task (in this case, a
‘gotoStraight’) to the associated goal (lines 4 and 5).

With multiple AMRs, the sequence works as shown below. In line 1, a second AMR is moving
towards the end goal, which is already occupied by another waiting AMR. It assumes a pos-
ition behind the first AMR (line 2), and is then joined by two more AMRs (line 3).

Figure 11-4. Taxi Stand (Multi-Robot Standby) Goal Design, Multiple AMR Use

Managed Motion Sectors

Certain situations might require that multiple AMRs drive in narrow spaces, like hallways
and aisles. Without proper management, the AMRs could bunch up and cause traffic dead-
locks. The Fleet Manager uses managed motion sectors to control AMR traffic flow in difficult
areas, by directing the AMRs to wait at standby goals while awaiting permission to enter the
sector. It allows only one AMR to drive autonomously through the sector at a time, while still
performing tasks (such as pickup/dropoff) without requesting Fleet Manager permission. Man-
aged Motion can use Taxi Line queuing, with each sector capable of having up to four
reserved buffers.

Standby Buffering

Standby buffering is another type of ‘StandBy’ behavior in which an AMR must wait for
another AMR to clear a sector or goal. The awaiting AMR can automatically select and move
to a nearby ‘StandBy’ goal to wait.
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Preferred Lines and Directions

You can specify preferred lines, and directions that govern how your AMRs move through
their environment. Once placed on a map, the AMRs will, if possible, use the preferred areas.
If something prevents an AMR from keeping to the preferred line or direction, it will seek out
another path.

Resisted Areas and Lines

You can also place areas and lines on the map that you want your AMRs to avoid If the AMR
is unable to complete a goal without moving into, or crossing over, one of these areas, it will
do so, with a higher cost. Typically, resisted areas, lines, or directions are for special cases,
such as setting up travel lanes in which moving is allowed but should be avoided. For an
explanation of cost-based path planning, see Cost-Based Path Planning on page 231.

Forbidden Areas and Lines

As the name implies, these areas, lines, and directions are areas or lines the AMRs must never
enter or cross over. These could be loading docks (or other areas that might lead outside),
stairs, internal structures with walls, or other areas where the AMR could pose a hazard. Refer
to Using Forbidden Lines and Areas on page 248.

DistanceUncrossable and DistanceAdjustment Lines

If the path between the AMR and its goal intersects a DistanceUncrossable line, the AMR will
alter its path. You can use these lines to guide an AMR to the appropriate dock or standby
goal. The DistanceAdjustment line artificially increases the distance calculation between two
points. Queuing uses the distances to determine actions such as which dock to go to.

11.3 Path Planning and Collision Avoidance
MobilePlanner’s tools allow you to plan the most expedient routes for your AMRs, while keep-
ing them from running into objects in your facility and each other. There are may traffic con-
trol mechanisms associated with path planning.

This section discusses cost-based path planning, difficult spaces, and virtual doors.

Cost-Based Path Planning

ARAM uses a path planning scheme called Cost-Based Path Planning. In this scheme, an
AMR instructed to proceed to a goal searches the map for the most efficient path from its cur-
rent location to the goal, based on what it knows about the map. This path, called the global
path, is the optimal path from point a to point b. The AMR then follows that path to the goal
while avoiding unmapped obstacles. If the AMR detects unmapped obstacles, it alters its local
path to avoid them. If unable to proceed along the global path, the AMR can re-plan a new
global path.

The Path Planning Grid

The ‘cost-based’ aspect of this path planning scheme breaks a map into discrete 100 mm
squares (typically sufficient), called the path planning grid (which is not the same as
MobilePlanner’s 1000 mm (1 meter) reference grid), and assigns a cost to each square. Free
(empty) squares (those not close to any obstacles) have a cost of 0.1. The cost for squares
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containing walls and other fixed objects is infinite (meaning the AMR will never enter those
squares because the cost is far too high).

NOTE: Although you can improve path planning accuracy by decreasing the
path planning grid squares (done in the PlanRes parameter), doing so increases
AMR processing time. For example, changing the PlanRes parameter (Config >
Robot Operation > Path Planning Settings) from 100 mm to 50 mm quadruples
processing time.

Using cost-based path planning, the AMR plans a path with the lowest cost, and follows that
path to its goal. If it detects any unmapped obstructions, it alters its path to avoid them. And
while the resulting path deviation might be longer, the AMR will always choose the path of
lowest cost.

Factors Affecting Cost

Generally, a grid’s cost increases as its distance to an obstacle decreases, and occupied grid
squares have infinite cost. Preferred lines and directions generally have the lowest cost, while
resisted lines and areas have higher costs. Forbidden lines and areas (like those with walls or
other fixed obstructions, loading docks, etc.) have an infinite cost, meaning the AMR will
never cross or enter them.

For more information about preferred, resisted, restricted, and forbidden lines and areas, see
Understanding Traffic Control on page 228.

Path Planning Parameters

MobilePlanner has dozens of path planning-specific parameters that control how the AMR
moves through its environment, including (not an all-inclusive list):

l The AMR’s maximum traveling and rotating speed
l Turning radius (radius needed to safely pivot in place, without forward or backward
movement)

l Grid resolution
l Fast and slow speeds
l AMR padding and clearances (at fast and slow speeds)
l AMR rotational speeds at goals
l The amount of resistance for resisted sectors and lines
l Preferred and resisted lines, areas, and directions

To view and set these path planning parameters (when connected to an AMR), click Config >
Robot Operation > Path Planning Settings.

NOTE: MobilePlanner has the most complete and up-to-date descriptions of all
path planning parameters, which will not be repeated here.

Version Information: The default values of the two following Path Planning
Parameters have changed from Mobile Software Suite 4.9.x to FLOW Core:

l SmoothingWt
Default value for FLOW should be 1.0 (ARAM 4.9x was 0.0)
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l ObsThreshold
Default value for FLOW should be 0.3 (ARAM 4.9x was .33).

AMRs running FLOW Core will drive poorly if you copy your existing 4.9x path
planning configuration values to a new FLOW Core robot, as the default values
of the two parameters listed above have changed.

Dealing with Difficult Spaces

Clearance settings limit how close the AMR can move to detected obstacles. You can increase
or decrease the required clearance based on the AMR's speed, and have the software stop the
AMR if it will come too close to an obstacle in its path before it can stop by decelerating.

Changing clearance settings alters the AMR's behavior if it moves very slowly through door-
ways or other tight spaces, or stops too quickly when it senses an approaching obstacle. Con-
versely, if your AMR moves too close to obstacles or doesn't slow down rapidly enough, these
settings can improve its behavior.

You can set the clearance and padding parameters in MobilePlanner by clicking Config >
Robot Operation > Path Planning Settings.

l Front Clearance: a narrow (100 mm default), fixed buffer zone at the front of the AMR
that does not change with AMR translational velocity.

Figure 11-5. Front Clearances

l Side Clearance at Slow Speed (75 mm default) is the minimum side clearance applied at
any translational velocity.
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Figure 11-6. Side Clearances

l Front Padding and Side Clearance grow as AMR speed increases if you set these para-
meters. This is done as a safety precaution for faster-moving AMRs. The values for
Front Padding at Slow and Fast Speeds, as well as Side Clearance at Slow and Fast
Speeds can be set larger or smaller than the values shown in the figure above based on
your facility, the expected level of traffic, and the general nature of the environment the
AMR will be working in.

As the AMR accelerates, Front Padding and Side Clearance increase from Slow Speed
size towards Fast Speed size.

NOTE: If side clearance at high speed is set too large, the AMR will
speed up and slow down in hallways and similar spaces. This is because
the side clearance grows until it touches the wall, forcing the AMR to
slow down until its side clearance shrinks. It is best to have a small gap
between sideClearanceAtSlowSpeed and sideClearanceAtFastSpeed.

Dynamic Obstacle Tracking

This document introduces Dynamic Obstacle Tracking functionality. Dynamic Obstacle Track-
ing (DOT) allows AMRs to avoid moving objects by predicting the object’s path. Moving
objects can include people, bikes, trucks, or other AMRs. Dynamic Obstacle Tracking is not a
suitable replacement for an Fleet Manager with MultiRobot, but can enhance the performance
of a fleet. DOT should be considered when moving vehicles such as bikes, trucks, and other
AMRs are in the environment. People do not typically present a collision risk unless people
are jogging or running, though DOT will make the AMR appear to be “friendlier” around mov-
ing people by moving around them at farther distances. Additionally, a customer may want to
consider Dynamic Obstacle Tracking when non-employees will frequently be around the AMR,
to prevent people unfamiliar with the AMRs from feeling uncomfortable.
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Figure 11-7. Path Projected by Two Moving Legs of a Walking Person (Shown in Cyan)

Configuration

Default settings for DOT are suitable for tracking people-sized obstacles in well-mapped and
low-noise environments. Parameters can be adjusted to consider moving obstacles of other
sizes and speeds, as well as environments with high noise.

Additionally, high-noise areas can be ignored using a new map area, by specifying those areas
in the map editor. The map area, called IgnoreDynamicObstacleSector must be enabled as
shown in the following figure.

Figure 11-8. Enabling the IgnoreDynamicObstacle Sector
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Description of Parameters

Figure 11-9. Configuration Parameters for Dynamic Obstacle Tracking

Parameters can be found in the Dynamic Obstacles configuration section of the Robot Oper-
ation tab of the configuration page, as shown in the figure above. Additional information is
added here:

l Disable – Checking the box disables Dynamic Obstacle Tracking.
l AdditionalLogging – Adds highly verbose debugging info to the ARAM log, general not
needed.

l EnableVariableSize – Scales the size of dynamic obstacles points (cyan colored) to
match the objects they are tracking (see Figure 4 below).

l ObstacleSize – This is the size of the obstacles that DOT will create on the map if
EnableVariableSize is turned off, otherwise it’s the smallest obstacle size to track.

l DisableMaxObstacleSize – Checking the box disables the next parameter.
l MaxObstacleSize – DOT will not track obstacles large than the size defined here.
l TimeHorizon – DOT will predict obstacle trajectories this far into the future, for
example: an object moving 1 m/s will project a 7.5 m path when TimeHorizon is set to
7.5 s.

l MinAvoidanceSpeed – Minimum speed of a tracked obstacle to have its path predicted,
for example: if an AMR is moving less than 300 mm/s and the MinAvoidanceSpeed is
300, then that object will not have its path predicted.

l MinObstacleAge – The minimum amount of time in seconds for an obstacle to be
tracked for its path to begin being projected.

l ForceWithMultirobot – Checking the box causes the Fleet Manager’s multirobot to work
with DOT, instead of overriding DOT when multirobot and DOT overlap. This should
remain unchecked unless the environment has poor connectivity.

l MinReadings – The minimum number of primary laser readings necessary to project a
predicted trajectory.
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l MaxNeighborDistance – Maximum distance between laser groupings to be considered a
as a single grouped obstacle.

l MatchLikelihood – Chooses a standard deviation percentage to scale with to determine
if obstacle readings are outliers to be ignore, this should generally not be changed.

l DisableFilterOccGrid – Checking the box disables a grid which filters out unmapped
static obstacles, this should generally remain unchecked.

l FilterOccGridThresh – Tenths of seconds required to determine if an unmapped obstacle
is static, this should generally not be changed.

l MaxFilterOccGridValue – Tenths of a second to stop incrementing an unmapped
obstacle as static, the difference between this parameter and FilterOccGridThresh is the
time in tenths of a second required to forget a static area, this should generally not be
changed.

Figure 11-10. EnableVariableSize Parameter Causes the Cyan Obstacle Points to Match the Size of the
Blue Obstacles They Track

Adjusting for Noise

Two parameters which are very easy to understand are also very easy to use for noise adjust-
ment, MaxObstacleSize and MinAvoidanceSpeed. MaxObstacleSize should be set about 20%
larger than the largest obstacle you expect to need to track, for humans this should be about
1000 mm or less, but forklifts and other objects may be larger.

MinAvoidanceSpeed should be set to at least 300 mm/s, as most objects travelling below this
speed do not pose a collision risk. This parameter can be raised further if only slower AMRs
(such as Cart Transporters) are being used, but should typically be left at or below 500 mm/s.
The MinObstacleAge parameter can also be used to filter out static obstacles. Increasing this
parameter increases the amount of time necessary for an object to have its path projected,
which can cause lag in tracking. This lag could pose a risk if set too high when faster AMRs
or obstacles (running persons, bikes) are present in the environment. This parameter should be
left below 1.0 seconds, and 0.3 seconds is typically a good tradeoff between responsiveness
and filtering. MinReadings can be used to tune to very specific obstacles and distances, more
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information is given in the section “Tuning”, below. MaxNeighborDistance prevents moving
objects which appear to be multiple moving objects from being projected multiple times. For
example, a walking person will appear to be two moving groups of laser readings, but by set-
ting the MaxNeighborDistance greater than the distance between two legs the legs are treated
as one dynamic obstacle. As such, both legs are given a single projection. FilterOccGridThresh
and MaxFilterOccGridValue are more difficult to configure. Default values are set to handle
most situations, and ignore areas will generally be a better fit for noise removal (see next sec-
tion). These values should only be increased if unmapped static obstacles are taking too long
to be filtered out as being static.

Zone Ignore Area

Dynamic obstacles can be ignored IgnoreDyanmicObstacleSector, just as sonar readings can be
ignored with an IgnoreSonar sector. Dynamic obstacles from within an IgnoreDy-
namicObstacleSector will not create obstacle points which the AMR ignores, the AMR will not
predict paths of obstacles located inside of the ignore sector. AMRs will not ignore the pro-
jected points of a dynamic obstacle inside the ignore sector if the obstacle is moving toward
the sector. IgnoreDynamicObstacleSectors should be considered for use in areas where the
AMR both will not enter and have workers or machines that commonly move around. This
prevents the workers, whom are not likely to get in the AMR’s way, from being seen as
dynamic obstacles to be avoided. Ignore sectors should also be used when a large amount of
noise is present in an area, especially if most obstacles are static, as in the following figure.

Figure 11-11. An IgnoreDynamicObstacleSector (Purple) Used in a Noisy and Mostly Static Area

Turning

NOTE: Data from testing is provided in this section but any configuration setup
should be tested in the application environment to ensure safe operation.
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Tuning for People

In the following figure there are three data series. Each series represents the maximum dis-
tance that a person can be detected for any given MinReadings setting. Each series exists for a
different type of relative motion. The “Perpendicular” series describes values for humans walk-
ing perpendicular to the AMR’s line of motion. “Straight to” series describes values for
humans walking directly at the AMR. And the “Straight away” series is for humans walking
away from AMRs. Dynamic Obstacle Tracking is best when tracking people walking per-
pendicular to the AMR’s line of motion, which would be crossing its path. Performance is sim-
ilar for people walking away from the AMR, which can be useful for avoiding the area. The
worst performance, by only a meter or two, is seen with humans walking straight towards the
AMR. This is due to the time it takes to process a dynamic obstacle. To pick a MinReadings
value, determine how far away you would like to detect people from. 15 meters is ideal, but
not practical as a MinReadings of 3 or 4 will allow large amounts of noise through. If it was
acceptable to start tracking people about 8 meters away, then a MinReadings value between 5
and 7 would be ideal. Determining the best distance to begin tracking people in the envir-
onment depends on how noticeable the AMR is. A very short AMR could be overlooked by a
person, requiring a greater detection distance. Large, loud, and bright AMRs could be more
noticeable and could only track people nearby. Additionally, members of the public or non-
employee customers may not be comfortable around the AMRs and demand greater detection
distances for their comfort and perception of safety.

Figure 11-12. Turning for People

Tuning for Other LD AMRs

In an environments with poor Wi-Fi connectivity, DOT may be useful to prevent collisions if
MultiRobot cannot broadcast correct positions of nearby AMRs in real time. The following
chart can be used in the same manner as the chart in the previous section. For example, if
detection to 8 meters was appropriate then a good value for MinReadings would be between 7
and 10.
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Figure 11-13. Turning for Other AMRs

Virtual Doors

Virtual doors (DefaultDoorWithGoals, for example) are areas on the map that allow the AMR
to drive, automatically and seamlessly, through special areas. For instance, they allow an
AMR to drive through plastic curtains that it would normally avoid.

When an AMR plans a path through a virtual door, it instead drives to a specified goal before-
hand, and optionally to another specified goal afterward. As with normal goals, tasks can be
done at the goals associated with virtual doors.

The following dialog opens when you insert a virtual door in a map:
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Figure 11-14. Edit Advanced Area, DoorVirtual

11.4 Directing Traffic
With MobilePlanner, you can direct AMR traffic by adding preferred lines and directions to
your map.

Preferred lines make the AMR drive as though it’s on a virtual rail, and reduce the ‘cost’ of
grid squares it crosses. Though a preferred line might be longer than a straight path from Point
A to Point B, the preferred line reduces the cost of each cell it crosses (the Preference parameter
divides the cost of each cell the line crosses by 2, which means it costs half as much to drive
close to the line), so it could be the least expensive in terms of the cost.

NOTE: You can have MobilePlanner add grid lines to the map to help you
place lines and areas more accurately. In MobilePlanner’s main menu, clickMap
> Grid.

Using Preferred Lines

Before adding a preferred line to the map, enable (click the checkbox for) the PreferredLine para-
meter (in Config > Robot Operations > Map Features > PreferredLine) and Save the Config.

1. Click theMap Button to open the map you want to edit (see Using MobilePlanner Soft-
ware on page 52 for details).

2. In the Draw pane, click Advanced Lines, then select PreferredLine from the list (the
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cursor changes to indicate it is in drawing mode).

3. Place the mouse cursor on the map where you want the preferred line to start.

4. Click and hold the left mouse button, drag the mouse to where you want the preferred
line to end, then release the mouse button.

Figure 11-15. Edit Advanced Line, PreferredLine
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The following table describes the parameters available on the Edit Advanced Line dialog box.

Parameter Definition

Name An optional name for the preferred line.

Description An optional description for the preferred line.

Type Set to PreferredLine. Selecting a different type from the pull-
down menu changes the map’s highlighted area to the selected
type and updates the dialog box.

Start Point X and Y coordinates of the PreferredLine starting point.

End Point X and Y coordinates of the PreferredLine end point.

UseDefaultPreference True or False (Boolean) value. If set to:
l True: uses the default preference setting, ignores the
Preference value.

l False: the AMR overrides the path planning settings with
the value of the Preference parameter.

Use Path Planning Settings to specify default settings (see Path
Planning and Collision Avoidance on page 231 for details).

Preference Integer representing the line’s preference. A normal line has a
cost of ‘1’, so a setting of ‘1’ turns off the line’s preferred beha-
vior. A line with a preference of ‘2’ means driving on the line
costs half as much. Higher preferences yield a lower cost. Applies
only when UseDefaultPreference is false. See Cost-Based Path
Planning on page 231 for more information.

Using Preferred Directions

Preferred directions cause the AMR to attempt to drive on the specified side. In the image
below, the AMR does not move directly down the center of the hall, but along the right wall
(the preferred directions).

Figure 11-16. Preferred Direction

If the AMR cannot drive in the preferred direction for some reason, it will change its path to
reach its goal, including driving against the preferred direction on the left side of the hallway
(above). MobilePlanner allows you to add the following preferred directions to the map:
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NOTE: You must enable each of the preferred directions listed below (Config >
Robot Operation > Map Features) and Save before they will appear in the
Advanced Areas pulldown menu (in the Draw tab).

l PreferredDirectionLeft: Places an area on the map that tells the AMR to drive on the
left, in both directions.

l PreferredDirectionLeftSingle: Places an area on the map that tells the AMR to drive on
the left, in one direction only. If you use this option and have two of these areas next to
each other, align the two areas carefully. This is an advanced option. Use Pre-
ferredDirectionLeft for most applications.

l PreferredDirectionRight: Places an area on the map that tells the AMR to drive on the
right, in both directions.

l PreferredDirectionRightSingle: Places an area on the map that tells the AMR to drive
on the right, in one direction only. If you use this option and have two of these areas
next to each other, align the two areas carefully. This is an advanced option. Use Pre-
ferredDirectionRight for most applications.

Adding a Preferred Direction to the Map

1. Click Config > Robot Operations > Map Features.

2. In the PreferredDirection (Right or Left) row, enable the PreferredDirection parameters
you want to use, then Save the Config.

3. Click theMap Button to open the map you want to edit (see Using MobilePlanner Soft-
ware on page 52 for details).

4. In the Draw pane, click Advanced Areas, then select the PreferredDirection from the
list.

5. Place the mouse cursor on the map where you want the preferred direction to start.

6. Click and hold the left mouse button, drag the mouse to where you want the preferred
area to end, then release the mouse button.

The new area appears on the map, and the Edit Advanced Area dialog box appears.
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Figure 11-17. Edit Advanced Area, PreferredDirectionLeft

Edit Advanced Line
Parameter Definition

Name Optional name for the preferred area.

Description Optional description for the preferred area.

Type Set to the type of preferred area you selected.

Angle The preferred area’s rotation angle.

Corner The X and Y coordinates of the preferred area’s starting corner.

Opposite The X and Y coordinates of the preferred area’s ending corner.

UseDefaultSideOffset True or False (Boolean) value. If set to:

l True: uses the default side offset.

l False: the AMR overrides the path planning settings
with the value of the PreferredDirectionSideOffset para-
meter.

Use Path Planning Settings to specify default settings (see Path
Planning and Collision Avoidance on page 231 for details).

PreferredDirectionSide
Offset

(Integer) Represents how far away from the edge of the pre-
ferred direction area the AMR can drive.
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Edit Advanced Line
Parameter Definition

!
CAUTION: Setting this value too low can
cause the AMR to drive out of the preferred
area.

11.5 Controlling AMR Speed
You can control the AMR’s speed in certain areas by adding Movement Parameter Areas to
the map.

NOTE: You can have MobilePlanner add grid lines to the map to help you
place lines and areas more accurately. In MobilePlanner’s main menu, clickMap
> Grid.

Adding Movement Parameter Areas to the Map

NOTE: Movement parameters take effect after the AMR is in them.

1. In MobilePlanner, click Config > Robot Operations > Map Features > Move-
mentParameterSector (checkbox).

2. Click theMap Button to open the map you want to edit (see Using MobilePlanner Soft-
ware on page 52 for details).

3. In the MobilePlanner main menu bar, clickMap > Grid to display the grid lines on the
map.

4. In the Draw pane, click Advanced Area, then selectMovementParameters from the
pull-down menu.

The cursor changes to indicate it is in drawing mode.

5. Place the mouse cursor on the map where you want the area to start.

6. Click and hold the left mouse button, drag the mouse to where you want the sector to
end, then release the mouse button.

The new area appears on the map.

Editing Movement Parameter Areas

1. In the Draw pane, click Select, then click on the area you want to edit to highlight it.

2. Right-click on the highlighted area, and select Edit from the pop-up menu.

The Edit Advanced Area dialog box appears.
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Figure 11-18. Edit Advance Areas, MovementParameters

The following table describes the parameters available in the Edit Advanced Area dialog box.

Parameter Definition

Name An optional name for the area.

Description An optional description for the area.

Type Set toMovementParameters. If you select a different type of advanced
area, the highlighted area on the map changes to the selected type and the
dialog box updates.

Angle The angle the area is rotated within the map.

Corner The X and Y coordinates of the starting corner of the area.

Opposite The X and Y coordinates of the ending corner of the area.

Parameters Parameters that affect the AMRs’ behavior in the sector you drew on the
map. A value of 0 means use defaults.

11.6 Restricting Traffic
You can restrict the AMR's movement by adding forbidden lines and areas to the map. These
areas typically correspond to an area of the operating environment that you don't want the
AMR to enter, or in which you want to restrict the number of AMRs operating at the same
time (managed motion sectors). You can also add advanced features to the map that control
traffic flow based on certain conditions. For example, you might want the AMR to avoid an
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area during monthly maintenance. You can set that up using switchable forbidden areas. You
might also have an area in which you want only one AMR at a time.

You can set the parameters for these features in MobilePlanner by clicking Config > Robot
Operations > Map Features.

The following features allow you to restrict AMR traffic in your operating space:

l Adding Switchable Forbidden Lines and Areas to the Map on page 249
l Using Resisted Lines and Sectors on page 252
l Using Need-to-Enter Sectors on page 255
l Using Single AMR Sectors on page 256 (helpful when you have multiple AMRs oper-
ating in the same environment)

NOTE: You can have MobilePlanner add grid lines to the map to help you
place lines and areas more accurately.

Using Forbidden Lines and Areas
You can place lines and areas on the map that correspond to places in your operating envir-
onment where you do not want the AMR to go. You can also add lines and areas that can be
temporarily forbidden.

Forbidden lines are invisible barriers (virtual walls) in the operating space that the AMR will
not cross when driving in Autonomous Drive mode (the default driving mode). The cost of
map squares under a forbidden line is infinite. For more information see Manual Override on
page 90.

Forbidden areas are places in the map that you do not want the AMR to enter. For example, if
your operating environment has a loading dock that is open to the outside you might not want
the AMR to accidentally drive outside, and off the loading dock. The area might be accessible
on three sides, so you could place forbidden areas on the map corresponding to the loading
dock.

You can also add forbidden lines and areas that you can turn on and off (switchable forbidden
lines and areas).

Adding Forbidden Lines and Areas to the Map

NOTE: There are no required parameters for Forbidden Lines and Areas, which
are always enabled.

1. Click theMap Button to open the map you want to edit. Refer to Using MobilePlanner
Software on page 52 for details.

2. In the Draw pane, click on either Forbidden Line or Forbidden Area.

The cursor changes to indicate it is in drawing mode, using a box around the icon to
indicate an area.

3. Place the mouse cursor on the map where you want the forbidden line or area to start.

4. Click and hold the left mouse button.
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5. Drag the mouse to where you want the line or area to end and release the button.

The new forbidden line or area is selected and displayed in the map.

Adding Switchable Forbidden Lines and Areas to the Map

You can have certain tasks activate switchable forbidden lines and areas. These tasks can
toggle individual lines and areas or they can toggle groups of switchable forbidden lines and
areas.

1. To enable the SwitchableForbiddenAreaAndLine parameter, click Config >Robot Oper-
ation >Map Features, and click the checkbox to the right of the Switch-
ableForbiddenAreaAndLine parameter.

NOTE: The server will automatically restart when you change the para-
meters.

2. Click theMap Button to open the map you want to edit. See Using MobilePlanner Soft-
ware on page 52 for details.

3. In the Draw pane, click Advanced Lines or Advanced Areas, depending on what you
want to add to the map.

4. Select SwitchableForbiddenLine or SwitchableForbiddenArea from the corresponding
pull-down menu.

The cursor changes to indicate it is in drawing mode, using a box around the icon to
indicate an area.

5. Place the mouse cursor on the map where you want the line or area to start.

6. Click and hold the left mouse button, drag the cursor to where you want the line or area
to end, then release the mouse button.

The new switchable forbidden line or area appears on the map, and the Edit Advanced
dialog box appears.

Editing Forbidden and Switchable Areas

NOTE: The following procedures only apply if you want to edit an existing
advanced area.

1. Verify Show Robot is OFF then, in the Draw pane, click Select.

2. Either double-click on the area or line in the map, or right-click and select Edit from the
pop-up menu.
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Figure 11-19. Edit Advanced Area, SwitchableForbiddenArea

The following table describes the options available in the dialog box.

Parameter Definition

Name A name for the forbidden area.

NOTE: Since you switch forbidden areas by name, it’s use-
ful to use a common prefix when naming the ones you
want to group together.

Description An optional description for the forbidden area.

Type Not displayed for ForbiddenLine. If you select a different type of
advanced area in the drop-down list, the highlighted area on the map
changes to the selected type and the dialog box updates accordingly.

Angle The forbidden area's rotation angle (in degrees) in the map.

Corner The X and Y coordinates of the forbidden area's starting corner.

Opposite The X and Y coordinates of the forbidden area's ending corner.

Editing a Forbidden Line or a Switchable Forbidden Line

1. Verify Show Robot is OFF then, in the Draw tab, click Select.

2. Either double-click on the line in the map, or right-click and select Edit from the pop-up
menu.

If you selected a forbidden line, the Edi Forbidden Line dialog box appears. The Edit
Advanced Line dialog box appears if you selected a switchable forbidden line.
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Figure 11-20. Edit Forbidden Line Dialog

Edit Forbidden Line
Parameter Definition

Name An optional name for the forbidden line.

Description An optional description for the forbidden line.

Type Displayed for SwitchableForbiddenLine. If you select a different
type of advanced line from the drop-down menu, the high-
lighted line changes to the selected type and the dialog box
updates.

Start Point The X and Y coordinates of the starting point of the forbidden
line.

Opposite The X and Y coordinates of the ending point of the forbidden line.

Switchable Forbidden Lines and Areas

There are two ways to turn on or off a Switchable Forbidden Line or Area:

l Tasks

l ARCL

NOTE: ARCL is outside the scope of this manual. Refer to the corresponding ref-
erence guides for those products.

There are four tasks you can use to turn a Switchable Forbidden Line or Area ON or OFF:

l switchForbiddenOff

l switchForbiddenOn

l switchForbiddenOffByPrefix (you can specify a text prefix that turns all switchable areas
with that prefix OFF)

l switchForbiddenOnByPrefix (you can specify a text prefix that turns all switchable areas
with that prefix ON)
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Driving into a Forbidden Area

Occasionally you might need the AMR to drive into a forbidden area. You can make the AMR
do this by turning ON Manual Override mode, or using the pendant (even with Autonomous
Drive mode ON).

1. Click theMap Button to open the map containing the forbidden area.

2. Attempt to drive the AMR into the forbidden area from multiple sides - the AMR
should slow down and stop just before the forbidden area.

3. Click Robot > Robot Tools > Manual Override to turn Autonomous Drive mode OFF.

!
WARNING: Turning Autonomous Drive mode OFF disables the AMR's
obstacle-avoidance (of obstacles detected by the navigation laser) at
speeds under 300 mm/second. Use extreme caution when driving the
AMR under these circumstances.

4. Select Yes to turn Autonomous Drive mode OFF.

5. Drive the AMR into the forbidden area. This time the AMR should drive into the area.

NOTE: Manual Override must remain ON to drive the AMR out of the for-
bidden area. Notice that the background color of the map changes to yellow
when Manual Override is turned ON.

Using Resisted Lines and Sectors

You can add lines and areas to the map, called resisted lines and sectors, that the AMR will
attempt to avoid because they cost more to drive through. The AMR's path planning system is
similar to a GPS system that recalculates a route to avoid road construction. However, if
another route is not available, the AMR follows the original. Similarly, the AMR will resist
entering a sector or crossing a boundary if it is possible to avoid it; however, if it needs to
drive through a resisted sector to reach its goal, it will.

Adding Resisted Boundaries and Sectors to the Map

1. In MobilePlanner > Config > Robot Operation > Map Features, enable Res-
istedSectorAndLine. See Setting the Configuration Parameters on page 157

2. Save your change to the AMR.

3. Click theMap Button to open the map you want to edit.

4. Ensure Show Robot is OFF, then click Draw > Advanced Lines or Draw > Advanced
Areas, depending on what you want to add to the map.

5. In the pull-down menu, select ResistedLine or ResistedSector, and note that the cursor
changes to indicate that it is in drawing mode (has a box around the icon to indicate an
area).

6. Place the mouse cursor on the map where you want the resisted line or sector to start.

7. Click and hold the left mouse button.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 252



253 Fleet Operations Workspace Core User's Manual 20569-020 Rev. E

11.6  Restricting Traffic

8. Drag the mouse cursor to where you want the line or sector to end and release the but-
ton to display the new resisted line or sector in the map, and the Edit Advanced Area
dialog box.

Editing Resisted Sectors

1. Verify that Show Robot is OFF and, in the Draw tab, click Select.

2. Either double-click or right-click on the sector in the map and select Edit from the pop-
up menu.

Figure 11-21. Edit Advanced Area, ResistedSector
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Edit Advance Area
Parameter Definition

Name A name for the resisted sector.

Description An optional description for the resisted sector.

Type Set toResistedSector. If you select a different type of
advanced area, the highlighted area changes to the new type
and the dialog box updates.

Angle The rotation angle of the resisted sector in the map.

Corner The X and Y coordinates of the resisted sector’s starting corner.

Opposite The X and Y coordinates of the resisted sector’s ending corner.

UseDefaultResistance (Boolean) value. A True setting uses the default resistance set-
ting , and ignores the Resistance value (default settings are set
using the Path Planning Settings - see Path Planning and Col-
lision Avoidance on page 231).

If this is False, the AMR overrides the path planning settings with
the value of the Resistance parameter.

Resistance (Integer) Determines the cost of crossing the area. Defines how
much the AMRwill resist driving through a particular sector, and
find an alternative path. The cost of driving through a resisted
sector is multiplied by its resistance value. A normal area or sec-
tor has a cost value of 1. Set this value to 1 to turn off the res-
istance behavior.

Editing Restrictive Lines

1. Verify that Show Robot is OFF and, in the Draw tab, click Select.

2. Double-click (or right-click) on the boundary in the map, and select Edit from the pop-
up menu.

Figure 11-22. Edit Advanced Line, ResistedLine
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Edit Advanced Line
Parameter Definition

Name A name for the resisted boundary.

Description An optional description for the resisted boundary.

Type Set toResistedLine. If you select a different type of advanced
area, the highlighted area changes to the new type and the dia-
log box updates.

Start Point The X and Y coordinates of the starting corner of the resisted
boundary.

End Point The X and Y coordinates of the ending corner of the resisted
boundary.

UseDefaultResistance (Boolean) A True setting uses the default resistance setting (set
in the Path Planning Settings in the Advanced Areas pull-down
menu). See Path Planning and Collision Avoidance on page 231
for details. If False, the AMR overrides path planning settings
with the Resistance parameter value.

Resistance (Integer) Determines the cost of crossing a boundary, how much
the AMR resists driving across it, and finds an another path. The
cost of driving across a boundary is multiplied by its resistance
value. A normal area has a cost of 1, so set this value to 1 to turn
off the resistance behavior.

Using Need-to-Enter Sectors

You can add areas to the map that only allow the AMR to enter if the goal the AMR is trying
to reach is inside the sector. These are referred to as need-to-enter sectors. If the AMR is already
in a need-to-enter sector, it can drive around in the sector or drive out of it.

Need-to-enter sectors are useful in (for example) cases in which there are loading or unloading
areas where another AMR could cause congestion if it tries to pass through.

Adding Need to Enter Sectors to the Map

1. In MobilePlanner > Config > Robot Operation > Map Features, enable NeedToEn-
terSector. For details on how to do this, see Configuring the AMR on page 154.

2. Save your change to the AMR.

3. Click theMap Button to open the map you want to edit.

4. Click Draw > Advanced Areas.

5. Select Need to Enter from the pull-down menu, and note the cursor changes to indicate
it is in drawing mode.

6. Place the mouse cursor on the map where you want the sector to start.

7. Click and hold the left mouse button.
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8. Drag the mouse cursor to where you want the sector to end and release the button. The
new need-to-enter sector highlights and appears in the map, and the Edit Advanced
Area dialog box appears.

Editing Existing Need-to-Enter Sectors

1. Click Select.

2. Either double-click on the resisted sector in the map, or right-click on the sector and
select Edit from the pop-up menu to display the Edit Advanced Area dialog box.

Figure 11-23. Edit Advanced Area, NeedToEnter

The following table describes the options available on the Edit Advanced Area dialog box.

Parameter Definition

Name A name for the need-to-enter sector.

Description An optional description for the need-to-enter sector.

Type Set toNeedToEnter. If you select a different type of advanced area, the
highlighted area on the map changes to the selected type and the dialog
box updates accordingly.

Angle The angle the sector (rectangle) is rotated within the map.

Corner The X and Y coordinates of the starting corner of the sector.

Opposite The X and Y coordinates of the ending corner of the sector.

Using Single AMR Sectors

Single AMR sectors allow you to add areas to the map that only allow one AMR at a time to
be in the specified area. This is useful for narrow hallways or narrow areas with only one
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entry/exit.

Adding Single AMR Sectors to the Map

1. In MobilePlanner > Config > Robot Operation > Map Features, enable SingleRo-
botSector. See Configuring the AMR on page 154 for details.

2. Save your change to the AMR.

3. Open the map you want to edit. See Using MobilePlanner Software on page 52 for
details.

4. Ensure that Show Robot is OFF, then click on the Grid toolbar icon to display the grid
lines on the map. This helps you to place the lines and areas more accurately.

5. Click Draw > Advanced Areas.

6. Select SingleRobot from the pull-down menu (the cursor changes to indicate that it is in
drawing mode).

7. Place the mouse cursor on the map where you want the single AMR sector to start.

8. Click and hold the left mouse button.

9. Drag the mouse cursor to where you want the sector to end and release the button to
highlight the new area in the map.

Editing Existing Single AMR Sectors

1. Click Select.

2. Either double-click on the sector in the map, or right-click on the sector, and select Edit
from the pop-up menu to display the Edit Advanced Area dialog box.

Figure 11-24. Edit Advanced Area, SingleRobot

The following table describes the options available on the Edit Advanced Area dialog box.
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Parameter Definition

Name A name for the single AMR sector.

Description An optional description for the single AMR sector.

Type Set to SingleRobot. If you select a different type of advanced area from
the pull-down menu, the highlighted area on the map changes to the
selected type and the dialog box updates accordingly.

Angle The angle the sector is rotated within the map.

Corner The X and Y coordinates of the starting corner of the area.

Opposite The X and Y coordinates of the ending corner of the area.
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When a moving AMR is operating in an environment such as an office building or a ware-
house, it must have some way of tracking its position and orientation on a map. This tracking
is called localization. Accurate localization is a prerequisite for autonomous navigation.

This section discusses the types of localization your AMR uses. For more information, refer to
the following:

12.1 What is Localization?
Localization is the way in which the AMR knows its location on the map. It is a process the
AMR uses to estimate its position in its environment based on data collected during operation.
Currently, the AMRs can use two types of localization:

l Laser localization uses data from the AMR's laser in conjunction with the map to cal-
culate the AMR's position. This is the default way the AMR keeps track of its position
in the operating space and is most useful in a static environment such as an office
building or hospital.Using Laser Localization on page 263.

l Optionally, an AMR can use overhead lights to track its position in the environment.
This localization process is often used in dynamic environments, such as a warehouse,
where objects move too frequently for the AMR to localize based on their past positions.
Using Acuity for Light Localization on page 267.

The key to localization is obtaining an accurate map of the environment (see Working with
Map Files on page 99). The AMR compares the map to the data collected from its sensors to
correct its position. With this information, the AMR knows its position on the map.

NOTE: The AMR combines data collected with either of these methods with
data from encoders on its wheels and the gyroscope in its core to determine its
location.

Overview of Localization Process

Localization requires an iterative process of correcting for errors in the AMR odometry. When
an AMR is powered up, it must determine its initial position (which could be its last position
when it shut down). During operation, the AMR calculates the current position based on its
last known position, along with the AMR's speed and direction. The AMR periodically recal-
culates its position to make sure it knows where it is. If the AMR cannot calculate a reliable
pose, it is lost and must stop. After the AMR recalculates its position, the current location
becomes the last known location.

12.2 Comparing Laser and Light Localization
The AMR can use data from its laser or from an upward-facing camera viewing the position
of overhead lights (or a combination of the two), to accurately determine where it is in its phys-
ical space and in the map.
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The following table highlights the differences between laser and light localization. For more
information on each localization process, refer to the appropriate section.

Laser Localization Light Localization

Description Uses a laser range finder
located on the AMR to
perform localization.

Uses a camera located on the AMR to
monitor overhead lights in the envir-
onment as points of reference to per-
form localization.

Equipment Laser range finder (stand-
ard)

Upward-facing camera option.

Accuracy vs.
Reliability

Provides more accurate
location data, but the
AMR cannot deal with
highly dynamic envir-
onments.

Provides more reliable localization in a
dynamic environment, because there is
less chance for the AMR to get lost, but
the AMR positioning is less accurate.

Recommended
Environment

Static (such as an office
building)

Dynamic (such as a warehouse)

12.3 What Causes the AMR to be Lost?
When an AMR no longer has enough confidence in its position, it broadcasts that it is lost,
and stops driving until a human intervenes. When an AMR is lost, it stops moving and broad-
casts a notification (in the form of the dialog box below) that it needs attention.

Figure 12-1. Localization Dialog - Lost Robot

Localizing a Lost AMR

1. Click Localize to Point in the lost AMR dialog box.

2. Click and hold the mouse on the map where you want to localize the AMR (at the
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AMR’s current physical location) and, while holding the left mouse button, drag the
mouse cursor to set the AMR's heading.

The Localization Score (or confidence threshold) should be 80% or better for optimum
navigation.

3. Click Done when the AMR's localization score is where you want it to be.

Adjusting the Confidence Threshold

The PassThreshold and LostThresholdDistance parameters (for laser localization) and Lock-
Threshold and LostLockUncertaintyThreshold parameters (for light localization) set the criteria
for when an AMR is lost. With each localization, the AMR generates a localization score. The
AMR is not considered lost until the localization score drops 20% below the PassThreshold
parameter (for laser localization) or -100 on the LostLockUncertaintyThreshold (for light loc-
alization), and fails to recover. Once the localization score drops below PassThreshold-
/LockThreshold, the AMR will move up to
LostThresholdDistance/LostLockUncertaintyThreshold, trying to raise its score. If it fails, it is
considered lost. You can adjust the parameter values as needed.

LostThresholdDistance is the maximum distance (in mm) that the AMR will move from the
last localized pose before the AMR will be considered lost. This parameter will only come into
play if none of the samples during the sensor correction is higher than PassThreshold. As soon
as this happens, the position uncertainty distance will grow based on the movement from the
last localized pose.

1. In MobilePlanner, click Config > Robot Operation > Localization settings (or Light
Localization settings).

2. Click on the PassThreshold Value (or LockThreshold value for light localization) field
and enter a new threshold value (the minimum score to consider the AMR localized).

3. Click on the LostThresholdDistance Value (or LostLockUncertaintyThreshold value for
light localization) field and enter a new distance value if desired.

12.4 Optimizing Localization
Localization accuracy depends on the accuracy of the map and sensor measurements. Typ-
ically, the AMR should be able to localize in most indoor environments. Occasionally, how-
ever, the AMR encounters situations in which it has trouble localizing, which can impact its
ability to navigate.

The most common problem with localization is map accuracy. It might not have been accurate
enough to begin with, or the environment might have changed enough (partitions moved, etc.),
that the map no longer reflects the working environment.

You can improve localization accuracy, to some extent, by adjusting the localization para-
meters. However, changing one parameter generally affects other parameters. Therefore you
will likely need to adjust several parameters to fine tune the localization score.

Laser and Light Localization use different parameters that you can adjust. Those parameters
are discussed in Localization Parameters on page 264 and Light Localization Parameters on
page 270 respectively. However, there are a few general guidelines to consider before you
change parameter values.
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Before Changing Parameter Values

Before changing any parameters (localization or other), make sure your map contains as much
accurately scanned data as possible. The more static features the map has (walls, doors,
shelves, etc.), the better the AMR is at navigating its way through the space.

l Don't erase any data from the map unless those points really do not correspond to any
real, fixed object.

l Re-scan areas where features have been removed from or added to an area in the envir-
onment.

l If there were errors in the map-making process, and your map does not match the real
space, re-scan the area again more carefully.

!
CAUTION: Before changing parameters, save a copy of your current
config file. When experimenting with parameters, try one parameter or a
small combination of parameter changes at a time. Revert to your saved
config file if the AMR's performance does not improve. See Configuring
the AMR on page 154.

12.5 Using Laser Localization
OMRON AMRs use one of two methods to locate their position in their environment: laser or
light localization. For more information on using light localization, refer to Using Acuity for
Light Localization on page 267.

Laser localization uses a laser range finder, located on the AMR, to detect walls and other
objects in the environment. The data collected from the laser is combined with the AMR's odo-
metry information and the map, which enables the AMR to determine its location.

Overview of Laser Localization

The most common way to localize an AMR in a given space is to use a laser range finder. The
laser range finder takes a planar snapshot of the environment, then compares this with the
map of the environment to determine the AMR's position. This is a relatively accurate method
of localization for environments that tend to be static, such as an office space.

If the laser localization cannot match the laser readings to the map, it does have some logic
that allows the AMR to drive for a while before reporting that it is lost. However, this is only
useful in temporary situations, such as the AMR driving through a small area where a group
of people have gathered.

In a dynamic space where unmapped cargo and equipment move in and out of the area (such
as in a warehouse), data from the unmapped objects can easily overwhelm the mapped data,
causing the laser localization to fail. In these situations, it is better to use light localization. See
Using Acuity for Light Localization on page 267 for details.
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Key Features

l Laser localization gives accurate positioning data for precise navigation, particularly in
a relatively static environment.

l No potentially expensive retrofitting required to use laser localization.

l The map only needs to be updated if there is a change in the static environment.

l The AMR continues to operate even if some of the map features have changed, resulting
in a flexible solution.

Limitations of Laser Localization

Laser localization is an accurate method of localization in a static environment such as an
office, but has some limitations to consider:

l The laser cannot see glass, mirrors, or shiny objects. Environments with a lot of these
objects make it difficult for the AMR to localize.

l In dynamic environments in which objects frequently change positions (such as a ware-
house), laser data might not match mapped data closely enough for the AMR to loc-
alize. In these areas, the map won't contain objects added or moved after you created
the map.

l In an environment with a lot of high racks for the AMR to navigate through, the con-
fidence threshold could fall below 20% and cause the AMR to become lost.

Localization Parameters

In MobilePlanner, you can access the AMR's localization parameters and adjust them as
needed.

To access the laser localization parameters, click Config > Robot Operation > Localization set-
tings.

Improving Accuracy and CPU Usage

For laser localization, two settings directly affect the CPU usage for each localization:

l GridRes represents the size of the grid used for localization. The smaller the value is,
the more accurate the localization score.

l NumSamples represents the number of poses sampled (or checked) each time the AMR
moves; this number scales linearly, so adjusting a value of 2000 to 3000 takes up 1.5
times more processing power.

Other factors, such as TriggerDistance and TriggerAngle determine how often it attempts to re-
calculate (or re-localize) its position. Recalculating uses a lot of CPU so, if the value of
NumSamples is set too high, the AMR will localize less often. This can actually cause more
problems than an AMR that localizes less accurately, but more often.

The K parameters (KMmPerMm, KDegPerDeg and KDepPerMm) are error parameters, and are
explained below.
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Using Laser Localization Parameters

With MobilePlanner, you can access the AMR's configuration parameters and adjust them as
needed.

To access the laser localization parameters, click Config > Robot Operation > Localization set-
tings.

In general, high CPU use for one laser scan might prevent the AMR from scanning as often as
needed. Setting these parameters requires balance.

You can change parameters that affect the level of detail in an AMR's scan, how many pos-
sible locations (poses) the AMR will compare those results with, and how frequently, both in
time and travel, it rechecks its location. There are also parameters to adjust the amount of
expected error, both linear and rotational.

Additional Information:
l The robot configurations allows the end-user to adjust the Rotational
Deceleration as well as the Rotational Acceleration. Make sure that the val-
ues of these two parameters are equal, and lower than the default values.

l The robot configurations allows the LD robot series to have a value of 360
deg/s2. This large value, however, may not be an ideal value for smooth
run when turning.

l The RotAccel and RotDecel parameters should be the same value. Setting
differing values may result in sub-optimal driving smoothness.
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Localization Parameters and Effects on CPU Use

Parameter Description Effect(s) on Localization

AdjustNumSamples
Flag

Varies the number of
samples based on the
localization score.

When enabled, lowers the number of
samples when the AMR is moving and
the localization score is high. Reduces
CPU demand.

AngleIncrement Separation (in degrees)
required between laser
settings used for loc-
alization.

Discards readings too close together.
Reduces CPU demand.

GridRes Resolution (in mm) of
map grids.

Scan resolution. Decreasing this value
increases localization accuracy, but
increases demand on RAM.

KMmPerMm Millimeters of linear
error per linear mil-
limeter of travel.

Allowed percentage error (in mm) of the
AMR’s linear odometry readings. If set
too high, sample poses are too spread
out for the AMR to determine its loc-
ation. If set too low, the AMRmight not
be able to localize.

KDegPerDeg Degrees of error per
degrees rotated.

Allowed percentage error (in deg) of the
AMR’s rotational odometry readings. If
set too high, sample poses too spread
out for the AMR to determine its loc-
ation. If set too low, the AMRmight not
be able to localize.

KDegPerMm Degrees of error per lin-
ear mm traveled.

Allowed error (in deg) of the AMR’s rota-
tion per one mm of linear travel. If set
too high, sample poses too spread out for
the AMR to determine its location. If set
too low, the AMRmight not be able to loc-
alize.

NumSamples Number of pose
samples AMR uses for
localization.

Scan resolution. Increasing this value
increases localization computations. If
too low, the AMR fails to localize.

TriggerDistance Distance AMR travels
(in mm) before loc-
alizing.

How often to localize – helps reduce CPU
demand. The AMR only localizes when it
travels beyond listed value.

TriggerAngle Angle (in deg) AMR
turns before triggering
localization.

How often to localize – helps reduce CPU
demand. The AMR only localizes when it
rotates beyond the listed value.
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12.6 Using Acuity for Light Localization
Light Localization uses a wide-angle camera mounted on the AMR to detect the fixed over-
head lights in the operating environment. After combining light position data with its odo-
metry readings and map data, the AMR knows where it is in physical space on its map.

NOTE: The navigation laser remains active for obstacle avoidance even when
not being used to for navigation.

NOTE: Acuity localization is not yet available for the HD-1500 AMR.

Overview of Light Localization

Using overhead lights as landmarks, the AMR is able to reliably calculate its position within
its environment.

Light Localization allows the AMR to localize in a dynamic environment where change is fre-
quent. A warehouse, for example, includes many boxes, pallets, vehicles and people that move
frequently. In this situation, the AMR can use the overhead lights to determine its position in
the environment. The AMR uses both camera and odometry data to calculate its current pos-
ition.

Key Features

Key features of light localization include:

l No expensive retrofitting required to use light localization.

l The lights do not require special maintenance.

l Because the lights are overhead, they are not blocked by ground level obstructions that
could prevent laser sensors from working.

l The map does not need to be updated because the light positions typically do not
change.

l Even if some lights have failed, the AMR still has a reliable solution and continues to
operate.

NOTE: Using light localization in spaces with lights at different heights, or
places with lights visually behind others, can require different scanning tech-
niques not covered in this guide. For details, see theMobile Robots - LD Platform
Peripherals Guide (Cat. No. I613).

Creating the Light Map

Before creating a Light Localization map, be sure you are familiar with creating an initial map
scan. Refer to Scanning the Operating Area on page 96 for more information.

NOTE: When scanning the operating environment using Light Localization, be
sure to drive under the lights or as close to the lights as possible. You need to do
this in more than one direction, to make sure the camera sees the lights from all
angles, collecting pan and tilt data along the way.
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Compared with laser localization scan files, Light Localization scan files contain additional
information about the AMR's operating environment and, therefore, require extra processing
steps. The resulting map files also contain information about the location and height of over-
head lights detected during the scanning process.

Light Localization is only available on AMRs equipped with the Acuity option, and you must
enable the LightLocalization parameter in the MobilePlanner software to activate it. Refer to
Configuring the AMR on page 154 for details.

Adjusting the Light Analysis Parameters

1. In MobilePlanner click Config > Robot Configuration > Light Analysis.

This will display the parameters associated with light analysis.

2. Select Show Expert Parameters to access the main light analysis parameters.

The following table describes the most important parameters for light analysis:

Parameter Name Description

3d:MinLightHeight Minimum height (in mm) of the lights above the floor. This value is
approximate and should be lower than the real value. It is used to
establish a valid range and eliminate false positives (Double).

3d:MaxLightHeight Maximum height (in mm) of the lights above the floor. This value
is approximate and should be higher than the real value. It is used
to establish a valid range and eliminate false positives (Double).

3d:MinLightLength Minimum length (in mm) of the lights. This value is approximate
and should be slightly lower than the real value. If -1, then this
value is ignored (Double).

3d:MaxLightLength Maximum length (in mm) of the lights. This value is approximate
and should be slightly higher than the real value. If -1, then this
value is ignored (Double).

Set the 3d:MinLightHeight and 3d:MaxLightHeight parameters to a range that encompasses
the ceiling and light heights, but not too large.

If the lights are fluorescent tubes or the lights are partially hidden from the camera's view, you
may also need to adjust the 3d:MinLightLength and 3d:MaxLightLength parameters.

After making these adjustments, reprocess the light scan in MobilePlanner. This does not
require redoing the laser portion of the map creation, just reprocessing the light data.

Creating the Light Map

1. Turn all lights ON in the operating environment.

2. Open MobilePlanner and start the scan process. See Scanning the Operating Area on
page 96 for details.

3. Drive the AMR around the environment, paying special attention to the overhead
lights. Drive under the overhead lights in several directions.

4. Stop the scan.
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5. Turn the scan into a map (see Convert the Scan into a Map on page 97 for details).

6. Verify the scanned map shows overhead lights in the correct position and with the cor-
rect height.

You can view the height data by moving the mouse over the light icon on the map. The
overhead lights appear as blue squares, rectangles or points (depending on the type of
light), as shown below.

Figure 12-2. MobilePlanner Light Map - Detail

7. If the light map looks correct, click Finish on the Scan Tools toolbar.

8. If the light map does not look correct, you will need to adjust the light analysis para-
meters and reprocess the scan. See Adjusting the Light Analysis Parameters on page
268 for details.

By default, the overhead lights are hidden from the map after turning the light scan into a
light map. You can view the lights by selectingMap > Map Data > Light Items from the
MobilePlanner main screen.

The light map contains data (such as height) about the lights seen by the camera, but does not
contain images of the lights themselves.

Limitations of Light Localization

Light Localization is a reliable method of localization, even in a dynamic, frequently changing
environment such as a warehouse. The number of lights visible lights affects the accuracy of
the AMR's estimated position and, if the AMR travels for a long time in a sparsely lighted
area, it will end up with a low localization score. However, in general, the AMR tends not to
get lost as often using light localization which is, therefore, more reliable in a dynamic envir-
onment.

Consider the following limitations:
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l The lights must be on and visible for light localization to work.

l Skylights can be problematic.

l Currently, light localization works with LED lights, can lights (displayed as squares on
the map) and fluorescent tube lights (displayed as rectangles).

l The more lights visible to the AMR, the better. Light localization does not work well
with only one or two lights in an area.

l The lighting must be direct. The AMR must see a bulb or diffuser, not just a light reflec-
tion off of another surface.

l An environment that has lights of varying brightness might have problems.

l The tilt of the camera is assumed to be fixed. A change to this, such as when the AMR
is on a tilted floor in the building, adversely affects the light localization.

l The accuracy of the localization depends on the accuracy of the light map. If the lights
in the map are incorrect due to mapping errors, the localization will show a similar off-
set.

l The vertical distance from the camera to the lights should be at least a couple of meters
for the light localization to work well. If the lights are too close to the camera, the error
will be more than when the lights are farther away.

Light Localization Parameters

In MobilePlanner software, you can access the AMR's configuration parameters and adjust
them as needed.

Accessing Light Localization Parameters

Click Config > Robot Operation > Light Localization.

This will display the parameters associated with light localization.

NOTE: The parameters for light localization are described in the software, and
are not repeated here.
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The following table lists acronyms and abbreviations, and defines key terms found in this user
guide:

Term Definition

802.11a, b, g, n,
or ac

Standard for wireless local area networks (WLAN) in the 2.4GHZ and
5GHz frequency bands.

Acuity AMR-mounted camera system for localizing the AMR using overhead
lights versus its laser.

AES Advanced encryption standard

AIFF Audio interchange file format

AMR Autonomousmobile robot

ARAM Advanced robotics automation management

ARC4 Alleged Rivest Cipher 4 (RC4)

ARCL Advanced Robotics Command Language. A simple, text-based, com-
mand-and-response operating language. Usedwith the Fleet Manager,
ARCL can helpmanage a fleet of AMRs.

ARP Address resolution protocol

A/V Audio/Visual

Boolean A type of data with two possible values, usually ‘true,’ or ‘false.’

CA Certificate Authority

CAPS Cell Alignment Positioning System. A software option that uses a fixed-
mount target in the workspace to provide more accurate AMR positioning
when approaching a destination.

CCMP Counter mode with Cipher block chainingmessage authentication code
protocol.

Cost An arbitrary numeric value assigned tomap grids, lines, routes, etc. to
determine the cumulative, net effect of an AMR’s actions. Breaks maps
into discrete squares called grids. Squares with walls, etc. have an infinite
cost, and free squares, by default, have a value of 0.1. By design, AMRs
always seek to execute their assigned tasks and goals at the lowest pos-
sible cost.

Cost-Based Path
Planning

Amethod of planning optimal, ‘least expensive’ paths from “point a” to
“point b” for the AMR to follow.
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CPU Central processing unit

DER Distinguished encoding rules

DHCP Dynamic host configuration protocol

DNS Domain name service

Dock Map location where the AMR “looks for” the charging station. Dock map
icon should be 1 to 1.5 meters in front of the charging station, with the
dock icon’s black line pointing to the charging station.

DROPOFF Job segment classification - tells the Fleet Manager that only a specific
AMR can be assigned to the job segment.

EAP Extensible authentication protocol

EAP-FAST EAP flexible authentication via secure tunneling

EM2100 A network appliance that hosts the FLOW Core software. All fleet man-
agement capabilities of the FLOW Core software run on the EM2100 appli-
ance.

Ethernet A type of computer network used in local area networks. Typically uses a
Category 5 (CAT5) or (CAT6) Ethernet cable; supports data speeds up to
100 MHz.

FIFO First-In-First-Out - refers to the method used to prioritize jobs (higher
number equals higher priority).

Fleet A group of AMRs that operate in the same area, share the samemap, and
are controlled by one standalone Fleet Manager or a Paired Primary Fleet
Manager, operating with a Paired Secondary Fleet Manager.

Fleet Manager The set of capabilities within the FLOW Core software that executes all
fleet management activities. These include the management of maps,
AMR configuration, job queue management, and traffic coordination.

Forbidden (lines,
areas)

Lines or areas onto or into which the AMRmust not drive or enter on its
own. In special cases, you can manually drive an AMR into a forbidden
area.

Goal Map-defined virtual destination(s) for AMRs (e.g., pickup or drop-off
points).

GUI Graphical User Interface

HAPS High accuracy positioning system. Uses add-on sensors which detect and
follow magnetic tape applied to the floor. Allows for very precise AMR pos-
itioning.

IP Internet protocol. IP address is a computer’s unique internet “address”.

Job An AMR activity, usually consisting of either one or two “job segments”.
(either PICKUP or DROPOFF). The Fleet Manager receives all job requests
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from ARCL.

LAN Local Area Network

LEAP Lightweight EAP

License Dongle A USB device that contains the software ( license key) required to run a
licensed program.

Localization The process by which AMRs determine their location in their operating
environment. Laser localization uses the AMR’s laser to scan its envir-
onment which it compares to its internal environment map. In light loc-
alization, the AMR uses overhead lights to determine its location.

Macro A virtual “container” with a series or sequence of nested tasks and/or
goals. Similar to routes. You can use macros as many times as needed to
perform the same sequence of discrete functions in different tasks.

MARC The Mobile Autonomous Robot Controller (MARC) firmware computes and
reports the AMR's odometer (X. Y, and heading) readings and other low-
level operating conditions to ARAM.

MobilePlanner The primary software application for programming AMR actions.

MobilePlanner
(Operator Mode)

A limited-functionality version of the MobilePlanner software. Has tools to
monitor AMRs, AMR statistics, monitor and add jobs. Does not have tools
to create or edit maps.

MSCHAPv2 Microsoft challenge handshake authentication protocol version 2

MP3 Moving picture experts group (MPEG) -2Audio Layer III

OS Operating system (e.g., Mac OS,Windows OS, MARC, SetNetGo OS, etc.).

Path The manner in which the AMRs drive from place to place in their envir-
onment.

PEAP Protected extensible authentication protocol (EAP)

PEM Privacy enhancedmail

Pendant A handheld, external input device for manually driving an AMR. Connects
to the AMR’s pendant (or joystick) connection port.
In this manual, pendant can mean either pendant (for HD AMRs) or joy-
stick (for LD-series AMRs). The two devices are similar, but not inter-
changeable.

PICKUP A job segment classification - tells the Fleet Manager that any available,
appropriate AMR can be assigned to the job segment.

PKCS Public key cryptography standards

Platform The base AMR (with or without payload) – includes chassis, drive train,
suspension, wheels, battery, safety scanning laser, sonar, on-board core
with gyroscope and software to navigate, interface connections for pay-
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load, and covers.

Pose An AMR’s position (location and heading).

PrecisionDrive Using a target in the environment to aid in more accurate maneuvering.
Targets can be placed on charging stations and other locations where you
need accurate positioning. Associated with certain tasks.

Preferred (lines,
directions)

Lines, directions you want the AMR to travel.

PSK Pre-shared key

RC4 Rivest Cipher 4 (aka ARC4 – Alleged RC4)

Resisted (lines,
areas)

Lines and/or areas the AMRs resist (attempt to avoid) crossing or enter-
ing, unless it must drive over/through resisted lines/areas to reach a
goal.

Route A “to do” list or series of tasks, goals, or macros for the AMR to follow.

Safety
Commissioning

Allows testing and commissioning (verification of proper function) of an
AMR's on-board safety systems. Uses a wizard to test E-Stop (tests brake
activation) and Safety Laser (tests max speed limits and obstacle detec-
tion). Per EN-1525, Commissioningmust be done by specially trained
people.

Sector Map areas that direct specific AMR actions, like ignoring sensor readings,
driving on the right or left, limiting the number of AMRs in the area at one
time, etc.

SetNetGo Software OS, resides on AMRs and the Fleet Manager appliance. Used to
configure AMRs’ communication parameters. Accessed via the SetNetGo
tab in MobilePlanner.

SNG SetNetGo.

Spline Mathematical function for smoothing arcs and curves.

SSID Service Set Identification – identifies a wireless LAN

Tasks Instructions for the AMR to perform certain actions like reading inputs,
setting outputs, movement commands, talking, waiting, etc. Tasks have
adjustable parameters, which can be individually set for each copy of the
task. There are two types of tasks; instant (allows concurrent processing
of tasks while original task is executing), and non-instant (can interrupt a
currently running task).

TCP Transmission control protocol

TKIP Temporal key integrity protocol

TLS Transport layer security

Virtual Doors Specially designated areas on the AMR’s mapwhich the AMR performs cer-
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tain tasks (like ‘move’ or ‘say’ tasks, flashing lights, etc.) and/or allow the
AMR to drive through special areas (e.g., plastic curtains).

WAVE Waveform audio file format with an extension of .wav.

WEP Wireless equivalent privacy

WPA WiFi protected access
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A.1 Network Port Allocation
Network ports are assigned as described below.

Table 14-1. Logical Ports and Protocols

Protocol Port(s) Initiator to Recipient

Intra-fleet Communications
Used to broadcast configuration updates to AMRs, to dispatch job commands, and to share
position and trajectory updates throughout the fleet.

TCP 37 AMR to Fleet Manager Maintenance, Management and Fleet
ports use this.

TCP/UDP 5000 AMR Fleet Manager. Fleet port uses this.

UDP Range 10000
and up

For UDP Range 10000 connections and up, such as an AMR
connecting to an EM2100 appliance, this protocol grows
with the number of robots. For best results, allocate at least
twice as many UDP ports as there are AMRs in the fleet. For
instance, a fleet of 20 AMRs should have an allocated range
of 10000-10039.

TCP/UDP 7272 AMR to Fleet Manager Appliance

Integration Toolkit TCP Ports

This list excludes dynamically allocated port numbers. All ports belong to TCP connections.

TCP 5672 RabbitMQ AMQP

TCP 8443 ITK REST

TCP 5432 PostgreSQL

Configuration and Monitoring of Fleet
Used for MobilePlanner connections to the Fleet Manager Appliance and AMRs for mon-
itoring and configuration.

TCP 443 Client PC to Fleet Manager Appliance

Maintenance and Management ports use this.

TCP/UDP Range 7272
and up

Client PC to Fleet Manager Appliance
This protocol uses as many ports as there are AMRs. Each
AMR that connects uses the next available port >= 7272.

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 278



279 Fleet Operations Workspace Core User's Manual 20569-020 Rev. E

A.1  Network Port Allocation

Protocol Port(s) Initiator to Recipient

For best results, allow a large number of ports, such as 7272-
7999.

TCP/UDP 7272 Client PC to AMR

UDP Range 10000
and up

Fleet Manager Appliance to Client PC
This protocol uses as many ports as there are AMRs. Each
AMR that connects uses the next available port >= 10000.
For best results, allow a large number of ports such as
10000-10999.

UDP 10000 AMR to Client PC.

Job Monitoring and Submission (ARCL Interface)
Used for managing jobs on the Fleet Manager Appliance. These are typically submitted
from a Warehouse Management System (WMS) or Manufacturing Execution System (MES).

TCP 7171 WMS/MES to Fleet Manager Appliance
ARCL Server: if enabled in the configuration (Robot Interface
and then ARCL Server Setup), this port is open on the Fleet
Manager and accepts unlimited incoming connections. The
port number is configurable.
(This port might be available on the AMR, depending on the
application.)

TCP Configurable
port #

Fleet Manager Appliance to WMS/MES
Outgoing ARCL Connection: if enabled in the configuration
(Robot Interface then Outgoing ARCL connection setup), then
the Fleet Manager initiates an outgoing connection to the spe-
cified hostname and TCP port number.

Optional

TCP 123 Fleet Manager Appliance to NTP server
If you enable a Network Time Protocol (NTP) client Fleet
Manager Appliance (SetNetGo then System and then
Date/Time), the Fleet Manager Appliance attempts to set its
clock from the network time server at the specified IP
address. (This function is available on the AMR, if you do
not use a client Fleet Manager Appliance.)

UDP/TCP Range 1000-
65535

Offboard devices to AMR
If RS232 or Ethernet Port Forwarding is enabled on the AMR
(SetNetGo then Network) then the configured TCP ports are
open on the AMR for incoming connections.

Flow iQ EXTERNAL PORTS: None
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A.2 FLOW Migration: Upgrades and Downgrades

This section contains information that is necessary to either upgrade or down-
grade the Fleet Operations Workspace (FLOW) Core Software or Legacy Mobile
Software Suite (MSS) software for operating your existing fleet of AMRs.

If you prefer to use your existing MSS solution, this document provides instruc-
tions on how to downgrade any newly purchased AMRs or EM2100 appliances
to be compatible with your existing fleet software solution.

Most installed AMRs can be upgraded via software without having to purchase
new equipment. Some legacy AMRs may require a dongle change, and the steps
to make these changes are included in this section. All Local Area Network, IP
Addresses, wiring and power connections can remain the same.

Before either upgrading or downgrading your fleet operations you need to con-
sider the existing fleet topology, hardware and any license requirements are
needed. These topics are shown in the following sections.

OMRON recommends, that if you are operating a beta version of FLOW Core,
that you contact your local OMRON representative for upgrade assistance.

Hardware

The only hardware change required to upgrade your fleet operations is that any
existing EM1100 appliances must be upgraded to EM2100 appliances, refer to
the EM2100 Installation Guide (Cat. No. I634) for more information.

NOTE: OMRON does not provide a path for downgrading a phys-
ical appliance from an EM2100 to an EM1100. OMRON does
provide an EM2100 to legacy downgrade path for your Fleet Man-
ager.

Fleet Topology Overview

The legacy and (FLOW) Core fleet topologies are similar in that they both control
OMRON AMRs, MobilePlanner and a Fleet Manager, which interfaces with the
factory systems.

The legacy versions of MobilePlanner 4.7.9 and earlier require a licensing dongle
but current releases of MobilePlanner are an integral part of the FLOW Core
license. Legacy fleets may use the EM1100 or the initially released EM2100 appli-
ance to perform the Fleet Manager role, as illustrated in the following diagram.
Legacy applications running both a primary and secondary EM1100 for redund-
ancy will have the same functionality within FLOW Core using the new
EM2100s.
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Figure 14-1. Legacy Mobile Software Suite Fleet Topology

FLOW Core fleets require that the EM2100 appliance running a licensed version
of the FLOW Core software, as shown in the following figure, have the
FLOW Core software replacing the Mobile Software Suite.

Figure 14-2. FLOW Core Fleet Topology with EM2100
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OMRON Software, Licenses and Equipment

This section lists the necessary software and OMRON equipment needed to com-
plete your migration to FLOW Core. Please consult with your local OMRON rep-
resentative before performing any migration.

OMRON Software

The following table lists all software versions related to the migration.

Name Location

Migrating from a Legacy to Fleet Operations Workspace (FLOW) Core
Solution

FLOW Core 1.0.1 Software Obtain this software from your local OMRON
representative

NOTE: You can also download
MobilePlanner 5.0 software dir-
ectly from the SetNetGo Web
interface of an EM2100 or AMR
running FLOW Core 1.0.1.

SetNetGo EM 5.0.0 Software

SetNetGo Robot 5.0.0 Soft-
ware

SetNetGo 4.10 Recovery Soft-
ware

MobilePlanner 5.0 Software

Downgrading from Fleet Operations Workspace Core to a Legacy 4.x
Solution

Mobile Software Suite (MSS)
4.x

This is the version of MSS software that your
fleet is running. You may already have this soft-
ware. If not, obtain the desired version from
your local OMRON representative.

SetNetGo 4.10 Software Obtain this software from your local OMRON
representative

MobilePlanner 4.X Software This is the version of MSS software that your
fleet is running. You may already have this soft-
ware. If not, obtain the desired version from
your local OMRON representative.

OMRON Licenses

When upgrading, you will need to have active FLOW Core and MobilePlanner
licenses available to activate the software.

Part Number Product Name Purpose

20271-800 Primary FLOW Core License, 1Yr Equal to the num-
ber of Primary
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Part Number Product Name Purpose

Fleet Managers
being purchased.20271-806 Primary FLOW Core License, 5 Yr

20271-802 Secondary FLOW Core License, 1Yr Equal to the num-
ber of Secondary
Fleet Managers
being purchased.

20271-807 Secondary FLOW Core License, 5 Yr

OMRON Parts

If you are migrating your AMR fleet from a legacy fleet management system,
such as an EM1100, to a FLOW Core solution, we recommend that you pre-order
the following OMRON parts before starting the migration process.

Downgrading to a legacy solution does not require any hardware or software
license purchases unless you desire additional MobilePlanner licenses.

NOTE: Downgrading to a legacy solution does not require any
additional hardware unless your robot has only one dongle that
was converted to support FLOW Core.

Part
Number

Product Name Quantity

20271-
900

Primary Fleet Manager Equals the replaced number of
EM1100s acting as a Primary
Fleet Manager

20271-
901

Secondary Fleet Manager Equals the replaced number of
EM1100s acting as a Secondary
Fleet Manager

Migration Procedures

This section provides detailed instructions for migrating from a legacy MSS 4.X system to a
FLOW Core 1.3 operating system. The migration instructions also include a visual rep-
resentation of the migration process, with some important notes.

Please follow the basic steps for migration that are provided below and described in the fol-
lowing sections.

1. Replace an existing EM1100 with an EM2100

2. Remove the EM1100 from the rack and install the EM2100

3. If needed, migrate / upgrade the existing EM2100 from a legacy MSS 4.x To FLOW Core
2.2

4. License the Upgraded FLOW Core software
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Migrate an EM1100

If the existing legacy system is using EM1100 appliances for fleet management, you must
replace them with EM2100s. In that case, we recommend purchasing pre-configured EM2100
Fleet Manager units, which come with FLOW Core installed, and no appliance migration will
be required. You will have to perform the upgrades to your operating fleet of AMRs.

Upgrade from an EM1100 to an EM2100

The EM2100 appliance can run either the legacy Mobile Robot Software Suite or the current
FLOW Core software. Upgrading from an EM1100 to an EM2100 does not require a software
change, although one may be desired.

1. Power OFF the EM1100 appliance.

2. Disconnect the AC power cable from the EM1100 appliance.

3. Disconnect all other cables, and remove the dongle(s) from the EM1100 appliance.

4. Remove the EM1100 appliance from the rack. Refer to the Enterprise Manager 1100 User's
Guide (Cat. No. I615) for details.

5. Install the EM2100 appliance in the rack. Refer to the EM2100 Installation Guide (Cat. No.
I634) for details.

6. Connect the cables and dongle(s) that you removed from the EM1100 to the EM2100.

7. Connect the AC power cable to the EM2100 appliance.

8. Power ON the EM2100 appliance to complete this procedure.

Migrate an EM2100 from Legacy MSS 4.X to FLOW Core 2.2

This section shows the steps to migrate an existing EM2100 which is being used as a Fleet
Manager from the legacy software to FLOW Core 2.2.1.

You need to update your SetNetGo from existing 4.X to 4.10 to begin the migration path to
FLOW Core 2.2.

!
CAUTION: It is critical that you not attempt to migrate from SetNetGo 4.10 dir-
ectly to 5.1 or higher versions. You must migrate from SetNetGo 4.10 to
SetNetGo 5.0.0, and then update SetNetGo 5.0.0 to SetNetGo 5.1 or higher ver-
sions.

The following graphic visually depicts the correct SetNetGo migration path for the EM2100
appliance.
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Figure 14-3. EM2100 SetNetGo Migration Path

!
CAUTION: POSSIBLE SYSTEM CORRUPTION.
Do not attempt to use SetNetGo 5.0.0 to operate your fleet or system.
SetNetGo 5.0.0 is only a bridge between SetNetGo 4.10 and SetNetGo 5.1.

IMPORTANT: If you are using SetNetGo 4.9 or below, you must first update
SetNetGo 4.9 to SetNetGo 4.10.

To upgrade an existing EM2100 appliance running Mobile Software Suite (MSS) 4.X to the
FLOW Core solution, follow these steps.

NOTE: Do not reboot until after step 13 of the following series of steps.

Upgrade EM2100

Use the following steps to upgrade an existing EM2100 appliance running Mobile Software
Suite (MSS) 4.X to the FLOW Core solution. The first series of steps upgrades SetNetGo, the
second set is to upgrade FLOW Core. Once FLOW Core is upgraded, you then set the operating
mode, and finally install the license for the FLOW Core upgrade.

SetNetGo Upgrade

The following steps are used to upgrade SetNetGo on the EM2100.

1. Download the SetNetGo containing SetNetGo 4.1.1 software onto a PC that you will use
to access the FLOW Core EM2100 Primary Fleet Management appliance. Download the
SetNetGo Robot 6.1.1, which is used with the AMR.

2. Using the PC, launch a browser, open the SetNetGo Web interface, and connect to the
EM2100 appliance through the maintenance port, via its existing IP address.

3. Within SetNetGo, select the System Tab and select the Upload SetNetGo OS Page from
the left hand list. Please refer to Fleet Operations Workspace Core User's Manual (Cat. No.
I635) for further information.

4. Decide which Boot Image, A or B, you wish to replace with the new SetNetGo 4.1.0 soft-
ware.

5. Select Choose File for that boot image.

6. Navigate to the SetNetGo 4.1.0 software file and select it for upload.

7. The file name should appear next to the Choose File button within the SetNetGo Web
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interface.

8. Click on the Upload File Button and confirm the file is uploaded to the main partition,
not the backup or recovery partitions..

9. Ensure that the boot image you have selected is now configured as the Bootable version.

IMPORTANT: Do not reboot the system at this point, this is an upload
process for the boot image.

10. In the Backup Image section, select Choose File.

11. Navigate to the SetNetGo 4.10 Recovery software file and select it for upload.

12. Click on the Upload File Button.

13. Once the upload is complete, reboot the EM2100 appliance by either clicking on the
Reboot button in the SetNetGo System tab (if enabled), or by using the power switch on
the front of the EM2100 appliance.

14. Close the browser with SetNetGo opened.

15. Download SetNetGo 5.0.0 onto the operating PC.

16. Using the PC, launch a browser, open the SetNetGo Web interface, and connect to the
EM2100 appliance via its existing IP address.

17. Within SetNetGo, select the System Tab and select the Upload SetNetGo OS Page from
the left hand list.

18. Decide which Boot Image, A or B, you wish to replace with the new SetNetGo 5.0.0 soft-
ware.

19. Select Choose File for that boot image.

20. Navigate to the SetNetGo 5.0.0 software file and select it for upload.

21. The file name should appear next to the Choose File button within the SetNetGo Web
interface.

22. Click on the Upload File Button.

23. Once the upload is complete, reboot the EM2100 appliance by either clicking the Reboot
Button in the SetNetGo System tab. If the Reboot button is not enabled, use the power
switch on the front of the EM2100 appliance.

Install FLOW Core onto the EM2100

Once SetNetGo is upgraded, use the following steps to install FLOW Core.

1. Within the SetNetGo Web interface, select the Software Tab and select theManage
Installed Software page from the left hand list.

2. Click on the Choose File Button at the top of the page.

3. Navigate to the FLOW Core software file. When you select it for upload, the file name
should appear next to the Choose File button.
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4. Click the Choose File Button.

5. Click on the Upload File Button to finish the installation procedure.

Configure EM2100 Operating Mode

The FLOW Core software is now installed. You need to configure the operating mode of the
EM2100. If you experience a failure at this point, it is recommended that you contact your local
OMRON representative.

1. Select the System Tab and select theMode Page from the left hand column, as shown
in the following figure.

2. Choose the EM2100 appliance operational mode using the drop-down menu.

Figure 14-4. Operating Mode Screen
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Figure 14-5. Operating Mode Screen

3. If your system is using only one EM2100 appliance, select the Standalone Fleet Man-
ager option, click the Apply Button, then proceed to Install FLOW Core License on page
289.

4. If your system has a second EM2100 acting as a redundant unit, then make sure the sec-
ondary EM2100 is also migrated to FLOW Core software using the previous steps, and
then select the Paired Fleet Manager Option, and click the Apply Button and proceed to
the following steps.

NOTE: If you select the Paired Fleet Manager option, you must designate
one EM2100 as the Primary and the other as the Secondary (back-up) Fleet
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Manager.

Figure 14-6. Pairing Settings

5. Click the Pairing Button (left margin) to designate the role of the EM2100 Appliance.

6. Select the pairing role for this using the drop down menu.

l If this was previously used in a paired system, then the Secondary IP address will
already be entered.

l If this is a new installation, refer to the EM2100Installation Guide(Cat. No. I634) for
details on setting up the Primary and Secondary appliances in your system.

7. This completes the procedure for configuring the operating mode of the EM2100. You
must now request a FLOW Core license entitlement from OMRON.

Install FLOW Core License

Once FLOW Core is properly installed you need to obtain and install the operating license.
Obtaining a license requires you to download and submit an identification file from the
EM2100 Appliance to OMRON in order to receive a FLOW Core license.

1. Using SetNetGo web interface Licensing tab, choose the Download option, then click on
the Download Button to download the .C2V file.
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Figure 14-7. Download C2V

2. The downloaded .C2V file will have the format: 1234567890-MMM-DD-YYYY.C2V
(Example. 7769436109-MAY-21-2019)

NOTE: OMRON recommends that you establish a specific location and
folder to store these license key files, so you can easily access them in the
future.

!
CAUTION: Download only one file, any subsequent download inval-
idates the first download which may prevent you from submitting a
valid .C2V file.

3. Send the .C2V file to your local OMRON support and request the appropriate license for
the Fleet Management mode you have selected.

4. You will receive a .V2C file with a dongle ID and date that match the .C2V file which
you submitted. Confirm the file names match before proceeding. If the file names do not
match, then contact your local OMRON support to report and resolve the issue.

5. Reconnect your computer to the Fleet Management appliance using the SetNetGo Web
interface. Select the Licensing Tab and choose the Upload Page from the left-hand ban-
ner. Select the appropriate .V2C file and click on the Upload File Button.
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Figure 14-8. Licensing Upload

6. A confirmation pop-up will open once the process completes. Now that a valid license
is activated, SetNetGo will initiate the requested mode by starting the appropriate soft-
ware.

Your EM2100 appliance is now upgraded to the FLOW Core 2.2 solution and ready to be con-
nected to your autonomous AMR Fleet.

The next migration step is to upgrade your AMR fleet to the same FLOW Core software ver-
sion. The next section defines this process.

Migrate FLOW Core 1.0.1 or 2.0 to 2.1.X.

This section details the steps necessary to migrate an existing FLOW Core 1.0.1 or 2.0 install-
ation which is being used as a Fleet Manager to FLOW Core 2.1.X.

Before upgrading your fleet you should plan for any possible downgrades by identifying fleet
AMRs that are using separated configuration sections, since FLOW Core 2.1.X does not show
these separations in the configuration. You can find the separated configuration sections by
opening FLOW Core and navigating to Fleet > Fleet Manager Connection
> UseFleetManagerConfigSection.

FLOW 2.1.X Added Functionality

FLOW 2.1.X represents a significant change from earlier FLOW 1.1 or 2.0 versions. As with all
upgrades, we recommend saving Debug Info files before upgrading.

Configuration should be set from the highest functional level to the lowest, where the levels in
descending order are Fleet Manager, robot family, robot variant, individual robot.
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New FLOW 2.1.X parameters are correctly migrated when you first upgrade a fleet from FLOW
1.0.1 or 2.0 to 2.1.X. If you later downgrade the fleet, you must manually update the para-
meters in both the old and the new configuration sections.

FLOW 2.1.X introduces a new parameter; Fleet Features > Call Stations. This check box must be
turned on if you want to configure MobilePlanner Tablet Edition as a call button.

IMPORTANT: It is not possible to configure the MultiRobot path settings on a
per-robot basis, in FLOW 2.1.X. This will be changed in a future version.

Migration Procedure

1. Download and install FLOW Core 2.1.X.

2. Using FLOW Core 2.1.X, select an AMR to use as your first migration for the fleet.

3. Download and save the Debug Info from the 1.0.1 or 2.1.X Fleet Manager and the selec-
ted AMR.

4. Select the AMR with the FLOW 2.1.X. You will see the unit will fail to connect at this
point, indicating a configuration conflict between Fleet Manager and the AMR.

5. Confirm the migrated AMR's configuration and map are correct and error free.

6. Make a small, reversible change to the migrated AMR's configuration and save it.

7. Reconnect to the AMR and verify that the AMR is connected. When connected, change
the configuration to the original values, changed in Step 6, and then save it.

8. Confirm there are no errors.

9. Confirm the AMR successfully connect to the Fleet Manager.

10. Verify the configuration of the Fleet Manager.

This is the first AMR to be upgraded and is the example unit for the process to migrate the
other fleet AMRs. There should be minimal customizations at the AMR level for this unit.

l The Fleet > Fleet Manager Connection section is always expected to be set at the robot
level.

l Other optional AMR-specific sections may be included, such as Robot Physical > Offset
Correction, Acuity Camera Calibration or Vehicle Calibration.

l Any configuration sections that were added by an external program, such as ARCL, will
appear at the robot level.

Proceed with the fleet upgrade by downloading debuginfo for any other AMRs with special set-
tings such as different robot types and separated config sections.

Upgrade the remaining AMRs following the above steps 1 through 10 above.

IMPORTANT: Verify the configuration of each upgraded AMR on the Fleet Man-
ager.

l Remove any customizations at the robot level when each AMR is upgraded. Any para-
meter settings that differ between the initial AMR and the currently migrated AMR are
automatically added at the lower levels.
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Downgrade FLOW 2.1.X to FLOW 2.0 or 1.0.1

If downgrading from FLOW 2.1.X to FLOW 2.0 or lower, OMRON recommends to down-
grade the AMRs before downgrading the Fleet Manager. Once the AMR is downgraded,
navigate to Fleet and then Fleet Manager Connection. Confirm this section lists all of the
correct SpecifiedSectionsToSeparate parameter settings if the UseFleetMan-
agerConfigSettings is set to All except specified.

Migrate an AMR from Legacy MSS 4.X to the FLOW Core 1.0.1

This section defines the process for migrating your AMR fleet from a Legacy Mobile Software
Suite (MSS) solution to the Fleet Operations Workspace (FLOW) Core solution. Nearly all
OMRON AMRs may be upgraded using the software upgrade processes described in this sec-
tion. Those AMRs that require more than a software upgrade use the dongle replacement pro-
cedure at the end of this section.

You need to update SetNetGo from 4.X to 4.10 to begin the migration path.

!
CAUTION: After updating to SetNetGo 4.10, it is of critical importance that
you not attempt to migrate from 4.10 directly to 5.1. You must migrate from
SetNetGo 4.10 to SetNetGo 5.0.0, and then update SetNetGo 5.0.0 to SetNetGo
5.1 or higher.

The following graphic visually depicts the correct SetNetGo migration path for the EM2100
appliance.

Figure 14-9. SetNetGo Migration Path

!
CAUTION: POSSIBLE SYSTEM CORRUPTION.
Do not attempt to use SetNetGo 5.0.0 to operate your system. SetNetGo 5.0.0 is
only a bridge between SetNetGo 4.10 and SetNetGo 5.1.

Migration Procedure

IMPORTANT: If you are at SetNetGo 4.9 or below, you must first update
SetNetGo 4.9 to SetNetGo 4.10.

To upgrade an existing EM2100 appliance running Mobile Software Suite (MSS) 4.X to the
FLOW Core solution, please use the following steps.
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!
CAUTION: Do not reboot until step 11 of this series of steps.

SetNetGo Upgrade

The following steps are used to upgrade SetNetGo.

1. Download the FLOW Core1.1 software and the SetNetGo (SNG) Robot 5.0.0 and 5.1 soft-
ware onto the PC you will use to access the mobile robots.

2. On the PC, open the SetNetGo Web interface within a browser.

3. Select the System Tab and select the Upload SetNetGo OS page from the left hand list.

4. Decide which Boot Image, A or B, you wish to replace with the new SetNetGo 5.0.0 boot
image.

5. Select Choose File for that boot image.

6. Navigate to the SetNetGo 5.0.0 software file and select it for upload.

The file name should appear next to the Choose File Button.

7. Then click on the Upload File Button.

NOTE: If you receive the error message, “The uploaded file appears to be
invalid" follow the procedure in Upload File Invalid Errors on page 299
before proceeding.

8. Ensure that the Boot Image you have selected is now the Bootable version. It is iden-
tified next to the Default Boot Image line in Systems tab.

!
CAUTION: Do not reboot at this point. Rebooting may cause the AMR to
become non-operational.

9. In the Backup Image section, select Choose File.

10. Navigate to the SetNetGo 4.10 Recovery software file, select if for upload, then click on
the Upload File Button

11. Once the upload is complete, reboot the AMR by cycling power on the robot.

12. Next, repeat steps 2 through 11, but use SetNetGo 5.1 in place of SetNetGo 5.0.0.

After SetNetGo 5.1 is installed, proceed with the following steps to install the FLOW Core 1.1
software onto the AMR.

Install FLOW Core 1.1 onto the AMR

1. Within the SetNetGo Web interface select the Software Tab and click on theManage
Installed Software Option from the left hand banner list.

2. Click on the Choose File Button at the top of the page.

3. Navigate to and select the Fleet Operations Workspace Core 1.0 software file.
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The file name should appear next to the Choose File Button.

4. Then click on the Upload File Button.

The FLOW Core software is now fully installed, and the AMR will now run as a FLOW
Core unit.

5. Reconnect to the AMR using the SetNetGo Web interface.

6. Within the SetNetGo web interface, click on the Licensing Tab.

NOTE: If you receive the following error message when the AMR reboots;
“Invalid License Dongle. The Dongle cannot be converted to a FLOW Core Com-
patible Dongle.”, you cannot upgrade using this software process. These units
require you to replace a dongle on the AMR core. If you have an OMRON AMR
with one of these dongles, please refer to AMR Dongle Replacement. on page 1
for more information.

7. Check to see if the Convert sub-menu is displayed in the left hand banner. If it is, then
continue.

If there is no Convert sub-menu in the left hand banner, then proceed to step 8.

8. Proceed with the following instructions to convert your legacy dongle to a blank FLOW
Core compatible dongle.

a. Click on the Convert option in the left margin.

b. Because the conversion process is irreversible, you will receive a first warning:
"This device has licensing firmware only compatible with legacy software. It may
be upgraded to support Fleet Operations Workspace compatible software, but this
action is irreversible."
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c. Click on the Convert Button.

A second warning message will appear.

NOTE: This step requires you to enter a code before completing the
upgrade process. After entering the code, click OK.

NOTE: Entering an incorrect code will give an error message,
requiring you to restart the process from step a.

d. Enter the displayed number, and click OK to begin the conversion process.

When complete, a confirmation of success message displays.
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The security dongle has now been upgraded for compatibility with the FLOW Core soft-
ware. The next step is to obtain and apply a license for the AMR.

9. Within the Licensing tab, click on the Download option in the left-hand banner section.

10. On the download page, click the Download Button.

The downloaded .C2V file will have the format:

1234567890-MMM-DD-YYYY.C2V (example: 7765923100-JUN-21-2019.C2V)

NOTE: OMRON recommends that you establish a specific location and
folder to store these license key files so you can easily access them in the
future. We also recommend that you reference the .C2V ID number to the
particular AMR where it is loaded, to ensure that you can quickly identify
and upload the matching license activation file to that AMR.

11. Send the .C2V file to your local OMRON support or integration partner and request a
robot license.
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You will receive a .V2C file with a dongle ID and Date that matches the .C2V file sub-
mitted by you.

12. Confirm the file names match before proceeding.

If the file names do not match, then contact your OMRON support or integration part-
ner and report the issue.

13. Reconnect your computer to the AMR using the SetNetGo web interface.

14. Select the Licensing Tab and choose the Upload Option.

15. Click the Choose File Button and select the appropriate .V2C file.

16. Once the file is chosen, the SetNetGo Web interface shows the specific file name next,
click on Upload File.

Now that a valid license is activated, SetNetGo will start the FLOW Core Software on
your AMR.

17. Repeat this process for each AMR in the Fleet to complete the migration.

Once all the AMRs have been migrated to the solution, the Fleet Manager(s) and AMRs will
communicate and are ready to be configured with any changes which might accompany the
migration process.

Install MobilePlanner and Connect to Fleet Manager

Use the following steps to install MobilePlanner on the PC and connect to the Fleet Manager.

1. Open the current version of MobilePlanner 5.0.x, that was downloaded with
FLOW Core on your PC.

2. Confirm the connection to the Fleet Manager IP address.
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3. Once the connection is complete, you are directly connected to the Fleet Manager
(EM2100 appliance) and able to operate the AMR fleet.

Your AMR Fleet is now fully converted and is ready for operation.

Upload File Invalid Errors

The Upload File Invalid error indicates that this particular AMR requires an additional
SetNetGo installation sequence, which involves installing an interim version of SetNetGo (ver-
sion 4.10) and then installing SetNetGo 5.0.0.

To correctly install SetNetGo 5.0.0, follow the required process steps below.

1. Download the SetNetGo 4.10 software onto a PC which will be connecting to the AMRs.

2. Using the PC, open the SetNetGo Web interface within a browser.

3. Select the System Tab and click on the Upload SetNetGo OS page from the left hand
list.

4. Decide which Boot Image, A or B, you wish to replace with the new SetNetGo 4.10 boot
image.

5. Select Choose File for that boot image.

6. Navigate to the SetNetGo 4.10 software file and select it for upload.

The file name should appear next to the Choose File Button.

7. Then click on the Upload File button.

If no error message appears the upload was successful. Cycle the AMR power. Then, in the
SetNetGo Web interface, click the System Tab, at the top of the Upload SetNetGo OS page, and
confirm that version 4.10 is listed as the SetNetGo version. After confirming this, re-install the
SetNetGo 5.0.0 version using the following steps:

8. In the SetNetGo Web interface select the System Tab and click on the Upload SetNetGo
OS page from the left hand list.

9. Decide which Boot Image, A or B, you wish to replace with the new SetNetGo 5.0.0 boot
image.

10. Select Choose File for that boot image.

11. Navigate to the SetNetGo 5.0.0 software file and select it for upload.

The file name should appear next to the Choose File button.

12. Then click on the Upload File Button.

If no error message appears, the upload was successful. Cycle AMR power. Then, in the
SetNetGo Web interface, open the System Tab and confirm that version 5.0.0 is listed as
the SetNetGo version.

Return to Step 8 in Migrate an EM2100 from Legacy MSS 4.X to FLOW Core 2.2 on page
284, and resume the migration process.

If an error message persists, please contact your local OMRON representative for tech-
nical support.
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AMR Dongle Replacement

There are AMRs which may have a security license dongle which cannot be upgraded using
this software process. These units require you to replace a dongle on the AMR core. If you
have an OMRON AMR with one of these older dongles, you will receive the following error
message when the AMR reboots; “Invalid License Dongle. The Dongle cannot be converted to
a FLOW Compatible Dongle.” If this happens during your AMR upgrade, use the following
instructions for removing the AMR core and replacing the dongle before proceeding.

The following instructions detail how to remove the AMR core, confirm the dongle color, and
if necessary, replace it. Prior to opening the AMR and removing the core, please order blue
replacement dongle, OMRON part number 13131-100F. This dongle is pre-programmed with a
FLOW Core AMR license and it should replace the black dongle.

NOTE: If the dongle in the AMR core is not black, there may be some other
issue. Contact your local OMRON Representative for support in this case.

The LD Platform core is an enclosed unit, with internal fans as the only moving parts.

1. Power OFF the AMR in a secure location.

2. Move the payload structure , so you can access the payload bay.

3. Remove the battery door skin.

4. Unlatch and open the battery compartment door, at the rear of the AMR.

The battery compartment door can be locked. You may need to unlock it.

5. Disconnect the battery power and data cables from the rear of the battery.

6. Disconnect all of the cables attached to the top portion of the core.

7. Remove the core mounting bracket from around the core.

The bracket is two pieces; a front piece with two screws into the chassis, and a rear
piece with two screws into the chassis, and four more going sideways into the core.
Retain all of these screws for re-installing the core.

See the following figure:

Figure 14-10. Core Mounting Bracket

20569-020 Rev. E Fleet Operations Workspace Core User's Manual 300



301 Fleet Operations Workspace Core User's Manual 20569-020 Rev. E

A.2  FLOW Migration: Upgrades and Downgrades

NOTE: You might be able to reach the dongle(s) by only removing the
front piece of the bracket. If not, continue with step 8.

8. Remove all cables connected to the otp portion of the core.

Gently lift the core up, until you can access the dongle(s).

9. Remove the existing black dongle, and replace it with the blue dongle, P/N 13131-100F.

10. Install the core mounting brackets around the core.

Using the screws and washers you removed from the old core, put four screws into the
sides of the core, with four more going down into the platform chassis.

11. Reconnect all of the cables to the top portion of the core.

12. Reconnect the battery power and data cables to the battery.

13. Close and latch the battery compartment door.

14. Reinstall the inner rear skin.

15. Reinstall the payload structure.

16. Return to Migrate an EM2100 from Legacy MSS 4.X to FLOW Core 2.2 on page 284,
Step 18.

Downgrade AMRs and EM2100s to run with Legacy Solution Software

All OMRON AMRs and EM2100 appliances ship with Fleet Operations Workspace (FLOW)
Core software installed. In order to use newly purchased AMRs in fleets running Legacy
Mobile Software Suite (MSS) 4.X software, the legacy software may need to be installed and
enabled. New LD AMRs ship with legacy software preinstalled so that you need to change the
Boot image and configure the robot through MobilePlanner. Additionally, compatible versions
of SetNetGo (SNG) and MobilePlanner must be installed in your system to ensure the new and
existing AMRs interact as designed.

This chapter provides detailed instructions which will guide you through the Legacy software
installation process. Please follow these steps in the order provided in this chapter.

NOTE: No modification to any of the AMRs in the existing fleet is required.
Even though the new AMRs will be running a newer version of SetNetGo, the
existing AMRs can continue to run their installed versions of SetNetGo, MSS
and MobilePlanner.

Downgrade a New EM2100 appliance from Fleet Operations Workspace 1.0 to Mobile
Software Suite 4.9

This section defines the process for downgrading a newly purchased EM2100 appliance run-
ning the Fleet Operations Workspace Core software to the Legacy Mobile Software Suite (MSS)
solution.

1. Install the EM2100 following the EM2100 Installation Guide (Cat. No. I634 ), and Fleet
Operations Workspace Core Software Users Guide (Cat. No. I635). During installation, the
system will assign a new network IP address, which will be used during the down-
grade process.

2. Download the MSS 4.X software, which the mobile robot fleet is currently using, onto



Appendix

the PC which will be used to downgrade the EM2100.

You can obtain this software from your local OMRON representative.

NOTE: The SetNetGo 4.10 version which you will need is already
installed on the AMR.

3. Using the PC, open the SetNetGo Web interface within a browser and connect to the
EM2100 appliance via its existing IP address.

4. Within SetNetGo, select the System Tab and select the Upload SetNetGo OS page from
the left-hand list.

5. Select Boot Image B, which should be labeled as SetNetGo 4.10 on the screen.

6. Reboot the EM2100 appliance by either clicking on the Reboot Button in the SetNetGo
System tab, if enabled, or by using the power switch on the front of the EM2100 appli-
ance.

If the pre-installed version of MSS 4,x differs from the version presently operating the
fleet, , install the MSS 4.X software onto the EM2100 appliance. Otherwise you can use
the version that is operating the fleet.

7. Within the SetNetGo Web interface, select the Software Tab and select theManage
Installed Software page from the left-hand list.

8. Click the Choose File Button at the top of the page.

9. Navigate to the desired MSS 4.X software file and select it for upload.

The file name should appear next to the Choose File button.

10. Now click on the Upload File Button.

Once the upload is complete, the EM2100 appliance will be operating with the legacy
MSS 4.X software solution.

11. Confirm that the desired version of the MSS 4.X software is installed on the EM2100 by
selecting the Software Tab in the SetNetGo Web interface.

12. Choose whether EM2100 should run as Primary or as Secondary Fleet Manager.

l If the unit is configured as a Primary Fleet Manager, SetNetGo will automatically start
ARAMCentral and autosync.

l If the unit is configured as a Secondary Fleet Manager, only autosync will run.

This completes the procedure and the EM2100 is now ready to connect to the existing AMR
fleet for programming, using MobilePlanner.

Downgrade an AMR from Fleet Operations Workspace 1.0 to Mobile Software Suite 4.9

This section defines the process for downgrading a newly purchased AMR running the FLOW
Core software to the Legacy MSS solution. If the AMR was shipped with FLOW Core pre-
installed, you cannot downgrade the unit below SetNetGo 4.10. Additionally, if you have pre-
viously upgraded an AMR from MSS 4.x and are running SetNetGo 5.0.0 or higher and you
want to downgrade to SetNetGo 4.1.0 you must first install SetNetGo 4.1.0 before performing
the downgrade.

To downgrade your AMR, use the following steps.
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A.2  FLOW Migration: Upgrades and Downgrades

1. Download the Mobile Software Suite (MSS) 4.X software, which is currently used by all
other AMRs within the existing mobile robot fleet, onto the PC which will be used to
downgrade the AMR.

You can obtain this software from your local OMRON Representative.

2. Using the PC, open the SetNetGo Web interface within a browser.

3. Select the System Tab and select the Upload SetNetGo OS page from the left-hand list.

4. Select Boot Image B, which should be labeled as SetNetGo 4.10 on the screen.

5. Reboot the AMR by either clicking on the Reboot Button in the SetNetGo System tab, if
enabled, or by using the power switch on the AMR HMI Panel.

NOTE: A version of MSS 4.x is already installed. If this version doesn't
match the one you are downgrading to, you will need to install the
desired Legacy MSS 4.X onto the AMR.

6. Within the SetNetGo Web interface select the Software Tab and click on theManage
Installed Software page from the left hand banner list.

7. Click on the Choose File Button at the top of the page.

8. Navigate to the MSS 4.X software file and select it for upload.

The file name should appear next to the Choose File button.

9. Then click the Upload File Button.

Once the upload is complete, the AMR will run as an MSS 4.X unit.

10. Reconnect to the AMR using the SetNetGoWeb interface.

11. In the SetNetGo Software tab, confirm that the desired version of MSS software is
installed.

If no configuration error is displayed, the AMR is now ready to connect to the Fleet Manager
(EM2100 or EM1100), and for programming using MobilePlanner. If an error is displayed, per-
form the following steps.

1. Identify another existing fleet AMR in the fleet that is identical to the one you down-
graded, such as an identical LD-60.

2. Download the debuginfo from this second AMR to your PC.

3. Upload the debuginfo to System::Backup/Restore Options::Restore All Settings in the
AMR showing the configuration error.

4. Restart the AMR once the upload is complete and confirm the configuration error is
gone.

If you do not have an identical AMR to the one showing the configuration error, or if the error
persists after uploading the debuginfo file, please contact your local OMRON representative for
further assistance.
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